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บทท่ี 1 
บทน ำ 

 

1.1  ควำมเป็นมำและควำมส ำคัญ 
ในปัจจุบันมีกระบวนการสื่อสารมากมายหลากหลายรูปแบบที่สามารถเข้าถึงกลุ่มเป้าหมายและท าให้

เกิดการรับรู้ มีการพัฒนาตามการขยายตัวของสังคมและเทคโนโลยี โดยเฉพาะการสื่อสารภายในองค์กรซึ่ง
ผู้บริหารขององค์กรต้องมีวิสัยทัศน์และให้ความส าคัญต่อการสื่อสารภายในองค์กรอย่างยิ่ง กระบวนการ
ประชาสัมพันธ์จึงเป็นช่องทางการสื่อสารอีกรูปแบบหนึ่งเป็นการกระจายข้อมูลข่าวสาร เรื่องราว กิจกรรม
ความเคลื่อนไหวต่าง ๆ ตลอดจนความรู้ที่เป็นประโยชน์ขององค์กร โดยมีสื่อประชาสัมพันธ์เป็นตัวกลางในการ
สื่อสารให้เข้าถึงกลุ่มเป้าหมาย ตรงตามวัตถุประสงค์ ดังนั้นเพ่ือให้บุคลากรทั้งภายในและภายนอกองค์กรได้
รับทราบข้อมูลข่าวสาร กิจกรรมการด าเนินงาน รวมถึงการเผยแพร่ความรู้วิวัฒนาการต่างๆ เกี่ยวกับระบบ
เทคโนโลยีสารสนเทศ ซึ่งจะท าให้การบริหารหน่วยงานได้อย่างมีประสิทธิภาพและประสิทธิผลมากยิ่งขึ้น 
(ปราณปรียา สิมมา , 2556)  
 ส านักวิทยบริการและเทคโนโลยีสารสนเทศเป็นหน่วยงานที่ให้บริการด้านเทคโนโลยีสนับสนุนภารกิจ
หลักของมหาวิทยาลัย (ส านักวิทยบริการและเทคโนโลยีสารสนเทศ , 2563)  ในการให้บริการออกแบบและ
ผลิตสื่อกราฟิกประชาสัมพันธ์ ที่ใช้เผยแพร่การบริหารงานการศึกษา ตลอดจนความรู้ต่าง ๆ โดยใช้นวัตกรรม
ดิจิทัลระบบเทคโนโลยีสารสนเทศท่ีเป็นประโยชน์ต่อมหาวิทยาลัยและนักศึกษา เพ่ือให้บุคลากรทั้งภายในและ
ภายนอกองค์กรได้รับทราบข้อมูลข่าวสารกิจกรรมการด าเนินงานของส านักงานสภามหาวิทยาลัยเทคโนโลยี
ราชมงคลพระนคร ซึ่งได้จัดท าเอกสารเผยแพร่วาระและมติการประชุมสภามหาวิทยาลัยฯ เพ่ือให้บุคลากร ผู้ที่
เกี่ยวข้องกับงานบริหารและผู้ที่สนใจได้ทราบถึงผลการประชุมของคณะผู้บริหารมหาวิทยาลัย แต่เอกสาร
เผยแพร่ดังกล่าว เป็นเอกสารทางราชการบันทึกข้อความ ท าให้ไม่เกิดความน่าสนใจ และยากในการสร้างการ
รับรู้ข้อมูลข่าวสารการด าเนินงานของสภามหาวิทยาลัยฯ  
 ดังนั้น ส านักงานสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จึงมีการประสานงานมอบหมายให้
ส านักวิทยบริการและเทคโนโลยีสารสนเทศมีส่วนในการด าเนินงาน ซึ่งการ เลือกใช้สื่อประชาสัมพันธ์ให้
เหมาะสมกับงานจึงเป็นสิ่งส าคัญ สื่อประชาสัมพันธ์รูปแบบจดหมายข่าว เป็นการประชาสัมพันธ์กิจกรรมการ
ด าเนินงานของหน่วยงานภายในองค์กรที่เผยแพร่เป็นประจ าทุกเดือน ด้วยการใช้โปรแกรมคอมพิวเตอร์กราฟิก 
Adobe InDesign ในการท างานส าหรับการออกแบบจัดวางรูปเล่ม ซึ่งมีสิ่งที่ต้องก าหนดการวางแผนก่อนการ
ออกแบบจดหมายข่าว การรวบรวมข้อมูลเนื้อหา และการจัดวางองค์ประกอบในการออกแบบจดหมายข่าว 
เพ่ือให้ได้สื่อประชาสัมพันธ์ที่มีประสิทธิภาพมากตรงตามวัตถุประสงค์ของหน่วยงาน  
 จากความเป็นมาและความส าคัญดังกล่าว ผู้เขียนจึงมีความสนใจเขียนคู่มือการปฏิบัติงานเรื่องการ
จัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม คอมพิวเตอร์กราฟิก Adobe 
InDesign  
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1.2  วัตถุประสงค์  
1.2.1  เพื่อให้ผู้ปฏิบัติงานสามารถปฏิบัติงานแทนกันได้ 
1.2.2  เพื่อให้การปฏิบัติงานเป็นมาตรฐานเดียวกัน  
1.2.3 เพ่ือให้เป็นแนวทางในการพัฒนาการจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคล

พระนครให้เกิดความน่าสนใจ 
  

1.3  ประโยชน์ที่คำดว่ำจะได้รับ  
1.3.1  ผู้ปฏิบัติงานสามารถปฏิบัติงานแทนกันได้  

 1.3.2  การปฏิบัติงานเป็นมาตรฐานเดียวกัน 
 1.3.3 เป็นการพัฒนาการจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนครให้มีความ

น่าสนใจมากยิ่งขึ้น 
 

1.4  ขอบเขตของคู่มือ 
 การปฏิบัติงานนี้ ครอบคลุมขั้นตอนการจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคล             
พระนคร ตั้งแต่กระบวนการเริ่มต้นในขั้นตอนการก าหนดการวางแผนก่อนการออกแบบ การรวบรวมข้อมูล
เนื้อหา และการจัดวางองค์ประกอบในการจัดท าจดหมายข่าว จนถึงกระบวนการสิ้นสุดของการจัดท าจดหมาย
ข่าวในขั้นตอนส่งต่อเพ่ือน าจดหมายข่าวไปท าการเผยแพร่ประชาสัมพันธ์ ของเจ้าหน้าที่ผู้ปฏิบัติงานและ
ผู้ด าเนินการเผยแพร่สื่อประชาสัมพันธ์ ที่ปฏิบัติทุกเดือนเป็นประจ า  
 

1.5  ค ำจ ำกัดควำมเบื้องต้น 
กำรจัดท ำ หมายถึง การจัดหน้ารูปแบบจดหมายข่าวประชาสัมพันธ์ ที่มีก าหนดการวางแผนการ

ออกแบบแล้ว โดยการน าข้อมูลเนื้อหา และรูปภาพที่ได้จากการรวบรวมจากหน่วยงานที่ขอความอนุเคราะห์ 
มาท าการเรียบเรียง Sketch และจัดวางใหม่ด้วยโปรแกรมคอมพิวเตอร์กราฟิกที่ก าหนด เพ่ือให้เกิดความ
เหมาะสมสวยงามและเกิดความน่าสนใจ 

จดหมำยข่ำว หมายถึง สื่อประชาสัมพันธ์ที่รวบรวมมติการประชุมสภา วาระการประชุม และบทความ
เกี่ยวกับการด าเนินการของสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนครที่จัดท าขึ้น เพ่ือรายงานผลการ
ด าเนินงานและกิจกรรมของหน่วยงาน เพ่ือเป็นสื่อในการให้ความรู้ ความเข้าใจและความเคลื่อนไหวของ
องค์กรต่อกลุ่มเป้าหมายทั้งนักศึกษาและบุคคลภายนอกองค์กร 

สภำมหำวิทยำลัยเทคโนโลยีรำชมงคลพระนคร หมายถึง คณะกรรมการสภามหาวิทยาลัยฯ ที่มีการ
จัดการประชุมคณะกรรมการสภาเป็นประจ าทุกเดือน 
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โปรแกรม Adobe InDesign หมายถึง โปรแกรมคอมพิวเตอร์กราฟิกส าเร็จรูปที่ใช้ส าหรับการท างาน
จัดหน้าหนังสือ นิตยสาร วารสาร สื่อสิ่งพิมพ์ โดยมีจุดเด่นในการสามารถจัดรูปแบบหน้าได้หลากหลายตาม
ความต้องการของผู้ออกแบบ  
  
 



บทท่ี 2 
โครงสร้างและหน้าที่ความรับผิดชอบ 

 
2.1  โครงสร้างการบริหารจัดการ 

มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร สถาปนาขึ้นตามพระราชบัญญัติมหาวิทยาลัยเทคโนโลยีราช
มงคล เมื่อวันที่ 18 มกราคม พ.ศ. 2548 ประกอบด้วยวิทยาเขต 5 แห่ง ได้แก่ วิทยาเขตเทเวศร์, วิทยาเขตโชติ
เวช, วิทยาเขตพณิชยการพระนคร, วิทยาเขตชุมพรเขตรอุดมศักดิ์ และวิทยาเขตพระนครเหนือ ข้อมูลระบบ
เครือข่ายคอมพิวเตอร์เดิม แต่ละวิทยาเขตได้ใช้เทคโนโลยีของ Cisco System โดยใช้ Router เป็นอุปกรณ์
ค้นหาเส้นทาง เชื่อมต่อผ่าน Leased Line มี Bandwidth ขนาด 2 Mb เชื่อมต่อไปยังส านักเทคโนโลยี
สารสนเทศ ต่อมาได้ด าเนินการจดโดเมนใหม่เป็น rmutp.ac.th เมื่อวันที่ 8 กันยายน พ.ศ.2548 เพ่ือให้
สอดคล้องกับลักษณะขององค์กร (ส านักวิทยบริการและเทคโนโลยีสารสนเทศ , 2563) 

เมื่อวันที่ 14 พฤศจิกายน พ.ศ.2549 จึงได้มีกฎกระทรวง จัดตั้งส่วนราชการในมหาวิทยาลัยเทคโนโลยี
ราชมงคล ให้เป็นส านักวิทยบริการและเทคโนโลยีสารสนเทศ โดยมีส านักงานชั่วคราวตั้งอยู่ที่ อาคาร 1 ชั้น 4 
และในปัจจุบันตั้งอยู่ ณ อาคารอเนกประสงค์ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร วิทยาเขตเทเวศร์ มี
ศูนย์วิทยบริการและเทคโนโลยีสารสนเทศให้บริการ 4 แห่ง ได้แก่ สาขาโชติเวช สาขาพณิชยการพระนคร 
สาขาชุมพรเขตรอุดมศักดิ์ และสาขาพระนครเหนือ 

วิสัยทัศน์ พันธกิจ เป้าหมาย ยุทธศาสตร์ กลยุทธ์ ของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
 วิสัยทัศน์ 
 - พัฒนาองค์กรสู่การเป็นมหาวิทยาลัยดิจิตัล  
 
 ปณิธาน 

- มุ่งมั่นเป็นผู้น าการจัดการศึกษาด้านวิชาชีพด้วยวิทยาศาสตร์และเทคโนโลยีเชิงบูรณาการ พัฒนา
ก าลังคนให้มีคุณภาพ คู่คุณธรรม สู่มาตรฐานสากล 

 
 พันธกิจ 

- พัฒนานวัตกรรมด้านไอซีที  เ พ่ือสนับสนุนภารกิจหลักของมหาวิทยาลัยในการก้าวไปสู่ 
การเป็นมหาวิทยาลัยดิจิตัล 

-  ผลิตการบริการการศึกษาโดยใช้นวัตกรรมด้านไอซีที  เ พ่ือบูรณาการเข้ ากับการเรี ยน  
การสอนสมัยใหม่โดย ผ่านระบบบริการอิเล็กทรอนิกส์ 

- พัฒนาการบริหารจัดการองค์กรโดยใช้นวัตกรรมด้านไอซีที เ พ่ือเพ่ิมประสิทธิภาพและประสิทธิผล
การบริหารการศึกษาสมัยใหม่และเป็นกลไกในการสร้างหลักธรรมาภิบาล 

- พัฒนาทรัพยากรบุคคลให้มีสมรรถนะทางไอซีทีที่มีคุณภาพ สอดคล้องกับการพัฒนาประเทศ 
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- จัดหาทรัพยากร ICT โดยใช้เทคโนโลยีที่เหมาะสม สอดคล้องกับภารกิจของมหาวิทยาลัย 
 

 เป้าประสงค์ 
-  ยกระดับ เ พ่ิมขีดความสามารถของบุคลากรและนักศึกษาในการใช้นวัตกรรมดิ จิ ตั ล  
เพ่ือการศึกษา 

- พัฒนาสื่อและระบบสนับสนุนการเรียนรู้ ในรูปแบบดิจิตัลเ พ่ือบูรณาการเข้ากับการเรียน  
การสอนออนไลน์ 

- สร้างวัฒนธรรมการท างานขององค์กรให้เป็นสังคมดิจิตัลที่มีคุณภาพ 
- สร้างระบบนิเวศดิจิตัลส าหรับงานวิจัยอย่างครบวงจร เพ่ือบูรณาการเข้ากับการบริหารจัดการงานวิจัย
และบริการงานวิชาการ 

-  สร้างระบบบริหารจัดการเชิงกลยุทธ์  โดยใช้ เทคโนโลยีการประมวลผผลข้อมูลขนาดใหญ่   
เพ่ือเพ่ิมประสิทธิภาพและประสิทธิผลการบริหารจัดการและการพัฒนาองค์กร 

 - พัฒนาโครงสร้างพ้ืนฐานด้านไอซีทีท่ีมีมาตรฐานและทันสมัยด้วยเทคโนโลยีดิจิตัล 
 
กลยุทธ์ 
- พัฒนาคุณภาพนักศึกษา (Smart Student)  
- พัฒนาคุณภาพบุคลากรสายวิชาการ (Smart Lecturer) 
- พัฒนาคุณภาพบุคลากรสายสนับสนุน (Smart Personal)  
- พัฒนาคุณภาพระบบการจัดการความรู้ (Smart Knowledge  
- พัฒนาศูนย์ความเป็นเลิศทางวิชาการ (Center of Excellence) 
- พัฒนาคุณภาพหลักสูตรและการเรียนการสอน (Smart Learning)  
- พัฒนาทรัพยากรการเรียนรู้ดิจิทัล (Smart Library) 
- พัฒนาระบบงานการให้บริการอิเล็กทรอนิกส์(e-Services)  
- พัฒนาระบบบริหารและบริการงานวิจัย (e-Research)  
- .พัฒนาระบบบริหารจัดการเชิงกลยุทธ์ (e-Strategy)  
- พัฒนาระบบประมวลผลข้อมูลขนาดใหญ่ (Big Data) 
- พัฒนาระบบการประกันคุณภาพการศึกษา (Quality Assurance) 
- พัฒนาโครงสร้างพื้นฐานทางด้านเทคโนโลยีสารสนเทศและการสื่อสาร (e-Infrastructure) 
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2.1.1 โครงสร้างหน่วยงานของส านักวิทยบริการและเทคโนโลยีสารสนเทศ (Organization chart) 
 
 
 
 
 
 
 
 
  ผังงานที่ 2-1 แสดงโครงสร้างหน่วยงานของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 

 2.1.1.1. โครงสร้างการบริหารส านักวิทยบริการและเทคโนโลยีสารสนเทศ (Adminisstration 
chart) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  ผังงานที่ 2-2  แสดงโครงสร้างการบริหารส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
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2.1.2  โครงสร้างการปฏิบัติงาน (Activity chart) กลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา 
 2.1.2.1. รายช่ือผู้บริหาร 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

นายธนาวุฒิ นิลมณี 
 ผู้อ านวยการส านักวิทยบริการและเทคโนโลยีสารสนเทศ 

นายนพชัย ทิพย์ไกรลาศ 
นักวิชาการโสตทัศนศึกษา  

ช านาญการพิเศษ 
รองผู้อ านวยการส านัก 

กลุ่มพัฒนานวัตกรรมและ
เทคโนโลยีการศึกษา 

นางสาวเพชราภรณ์ เพ็ชรแก้ว 
นักวิชาการคอมพิวเตอร์ 

ช านาญการพิเศษ 
รองผู้อ านวยการส านัก 

กลุ่มเทคโนโลยีสารสนเทศ 

นายเชาวลิต สมบูรณ์พัฒนากิจ 
นักวิชาการคอมพิวเตอร์ 

ช านาญการ 
รองผู้อ านวยการส านัก 

กลุ่มเครือข่ายคอมพิวเตอร์ 
และการสื่อสาร 

นางสาวอ้อยจริยา พลับจีน 
ผู้บริหาร หัวหน้าส านักงานผู้อ านวยการ 

นายปาโมกข์ รัตนตรัยาภิบาล 
นักวิชาการคอมพิวเตอร์ช านาญการ 

ผู้ช่วยผู้อ านวยการส านัก 
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 2.1.2.2. งานวิจัยและพัฒนาสื่อการศึกษา 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 2.1.2.3. งานผลิตสื่อโสตทัศน์ 
 
 
 
 
 
 
 
 
 
 
 

นายปฐมพงศ์ จ านงค์ลาภ  
นักวิชาการโสตทัศนศึกษาช านาญการ 

หัวหน้างานวิจัยและพัฒนาสื่อการศึกษา 

นายศักดิ์เทพ จ านงค์ลาภ  
นักวิชาการโสตทัศนศึกษา 

นางสาวปัญญาพร แสงสมพร  
นักวิชาการโสตทัศนศึกษา 

นายกฤษณ์ จ านงนิตย์  
นักวิชาการโสตทัศนศึกษาปฏิบัติการ  

หัวหน้างานผลิตสื่อโสตทัศน์ 
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 2.1.2.4. งานผลิตสื่อคอมพิวเตอร์ 

 
 
 
 
 
 
 

นายกิตติ แย้มวิชา 
นักวิชาการโสตทัศนศึกษา 

ปฏิบัติการ 

นายอุเทน พรหมมิ 
นักวิชาการโสตทัศนศึกษา 

ปฏิบัติการ 

นายปิยะนนท์ ศุภจริยวิชัย 
นักวิชาการโสตทัศนศึกษา 

ปฏิบัติการ 

นางสาวมัณฑนา ตุลยนิษกะ  
นักวิชาการช่างศิลป์ปฏิบัติการ 

 

นางสาวดลวรรณ สุทธิวัฒนก าจร 
นักวิชาการช่างศิลป์ปฏิบัติการ 

 

นายนรินทร์ จิตต์มั่นการ 
นักวิชาการช่างศิลป์ปฏิบัติการ 

 

นางสาวจุติมา พูลสวัสดิ์ 
นักวิชาการช่างศิลป์ปฏิบัติการ 

 

นายกุลภัทร พลายพลอยรัตน์  
ช่างศิลป์ 

พงศกร โพธิ์งาม 
นักวิชาการโสตทัศนศึกษา 

นายครรชิต จิตตานุวัฒน์ 
นักวิชาการคอมพิวเตอร์ปฏิบัติการ 
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 2.1.2.5. งานบริหารทรัพยากรสื่ออิเลคทรอนิกส์ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.1.3  ภาระหน้าที่ของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 

ส านักวิทยบริการและเทคโนโลยีสารสนเทศ มีภารกิจมุ่งเน้นพัฒนามหาวิทยาลัยเทคโนโลยีราช
มงคล  พระนคร ให้เป็นสังคมแห่งการเรียนรู้ (Learning Society) โดยใช้ ICT เป็นฐานในการบริการการศึกษา
ได้อย่างเต็มศักยภาพ มีจริยธรรม และมีสมรรถนะทาง ICT ตามมาตรฐานสากล หมายถึง ผู้เรียน ผู้สอน 
บุคลากร ของมหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร และประชาชนทั่วไป สามารถใช้ประโยชน์จาก ICT ใน
การเข้าถึงบริการทางการศึกษาได้อย่างเต็มศักยภาพ มีจริยธรรม และมีสมรรถนะทาง ICT ตามมาตรฐานสากล 
ส านักวิทยบริการและเทคโนโลยีสารสนเทศ มีภาระหน้าที่ แบ่งตามงาน 1 งาน และกลุ่ม 4 กลุ่ม ประกอบด้วย 
ส านักงานผู้อ านวยการ กลุ่มเทคโนโลยีสารสนเทศ กลุ่มเครือข่ายคอมพิวเตอร์และการสื่อสาร กลุ่มวิทยบริการ 
และกลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา 

2.1.3.1. ส านักงานผู้อ านวยการ 
งานบริหารทั่วไป มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานธุรการและสารบรรณ 
2) งานบัญชีการเงิน 

น.ส.ณิชกานต์ พันธ์บัวหลวง 
นักเอกสารสนเทศ 

นางสาววราลักษณ์ มีชัยเจริญ 
นักเอกสารสนเทศ 
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3) งานบุคลากร 
4) งานนโยบายและแผน 
5) งานพัสดุและอาคารสถานที่ 
6) งานฝึกอบรม 
7) งานสถิติและประเมินผล 
8) งานประชาสัมพันธ์ 
9) งานประกันคุณภาพ 

2.1.3.2.กลุ่มเทคโนโลยีสารสนเทศ มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานวางแผนและพัฒนาระบบสารสนเทศเพ่ืองานการบริหารจัดการภายใน

มหาวิทยาลัยฯ 
2) งานดูแลเครื่องคอมพิวเตอร์แม่ข่าย (server)  
3) งานติดตั้งและพัฒนาระบบสารสนเทศเพ่ือการบริหารงานภายในมหาวิทยาลัยฯ 
4) งานก าหนดมาตรฐานด้านเทคโนโลยีสารสนเทศ 
5) งานดูแลระบบสารสนเทศเพ่ือการบริหาร 
6) งานดูแลลิขสิทธิ์ซอฟต์แวร์ในมหาวิทยาลัยฯ 
7) งานบริการระบบสารสนเทศเพ่ือการจัดการ 
8) งานระบบประกันคุณภาพ 
9) งานพัฒนาศูนย์ปฏิบัติการเพ่ือการตัดสินใจเชิงกลยุทธ์ 
10) ให้ค าปรึกษาด้านเทคโนโลยีสารสนเทศแก่หน่วยงานต่างๆ ภายในมหาวิทยาลัย 

2.1.3.3. กลุ่มเครือข่ายคอมพิวเตอร์และการสื่อสาร มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานวางแผนและพัฒนาระบบเครือข่ายหลักของมหาวิทยาลัยและการเชื่อมโยง 

เครือข่ายภายในมหาวิทยาลัย 
2) งานดูแลเครือข่ายคอมพิวเตอร์หลัก 
3) งานดูแลเครื่องคอมพิวเตอร์แม่ข่ายด้านเครือข่าย 
4) งานดูแลเว็บไซต์ของมหาวิทยาลัยด้านเทคนิค  
5) งานให้บริการระบบเครือข่ายภายในมหาวิทยาลัย 
6) ให้ค าปรึกษาการใช้งานระบบเครือข่ายแก่หน่วยงานภายในมหาวิทยาลัย 
7) งานดูแลและให้บริการศูนย์การเรียนรู้ด้วยตนเองทั้ง 4 แห่ง ได้แก่  

ศูนย์การเรียนรู้ด้วยตนเองเทเวศร์  
ศูนย์การเรียนรู้ด้วยตนเองพระนครเหนือ   
ศูนย์การเรียนรู้ด้วยตนเองพณิชยการพระนคร  
ศูนย์การเรียนรู้ด้วยตนเองโชติเวช 
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2.1.3.4. กลุ่มวิทยบริการ มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานพัฒนาทรัพยากรสารสนเทศ 
2) งานวิเคราะห์ทรัพยากรสารสนเทศ 
3) งานวารสารและเอกสาร 
4) งานเตรียมทรัพยากรสารสนเทศ 
5) งานเทคโนโลยีสารนิเทศ 
6) งานให้บริการสารสนเทศและห้องสมุด 4 แห่ง ได้แก่ 

งานห้องสมุดเทเวศร์ 
งานห้องสมุดโชติเวช 
งานห้องสมุดพณิชยการพระนคร 
งานห้องสมุดพระนครเหนือ 

2.1.3.5. กลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานวิจัยและพัฒนาสื่อการศึกษา 
2) งานผลิตสื่อโสตทัศน์ 
3) งานผลิตสื่อคอมพิวเตอร์ 
4) งานบริการทรัพยากรสื่ออิเล็กทรอนิกส์ 

 
2.2  บทบาทหน้าที่ความรับผิดชอบของต าแหน่ง 

2.2.1  บทบาทหน้าที่ความรับผิดชอบของต าแหน่งตามมารตราฐานก าหนดต าแหน่ง 
ตามมาตรฐานก าหนดต าแหน่ งสายง านนั กวิ ช าการช่ า งศิ ลป์ ที่  ก .พ .อ .  เมื่ อ วั นที่   

21 กันยายน 2553 ฉบับแก้ไขเพ่ิมเติมครั้งที่ 1 เมื่อวันที่ 1 กรกฏาคม พ.ศ. 2554 ระบุบทบาทหน้าที่ความ
รับผิดชอบของสายงานนักวิชาการช่างศิลป์ ระดับปฏิบัติการ ดังนี้ 
   ต าแหน่งประเภท  วิชาการ 
  ชื่อสายงาน   วิชาการช่างศิลป์ 
  ชื่อต าแหน่งในสายงาน นักวิชาการช่างศิลป์ 
  ระดับต าแหน่ง  ปฏิบัติการ 

หน้าที่ความรับผิดชอบหลัก 
ปฏิบัติงานในฐานะผู้ปฏิบัติงานระดับต้นที่ต้องใช้ความรู้ความสามารถทางวิชาการในการ

ปฏิบัติงานเกี่ยวกับงานด้านวิชาการช่างศิลป์ ภายใต้การก ากับ แนะน า ตรวจสอบและปฏิบัติงานอ่ืน ๆ ตามที่
ได้รับมอบหมาย โดยมีลักษณะงานที่ปฏิบัติในด้านต่าง ๆ ดังนี้ 
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2.2.1.1. ด้านการปฏิบัติการ 
1) ศึกษา ค้นคว้า รวบรวมข้อมูลที่เกี่ยวข้องทางด้านศิลปกรรม และงานช่างสิบหมู่ 

เพ่ือเป็นข้อมูลในการออกแบบ เขียนแบบ อนุรักษ์ สร้างสรรค์งานด้านศิลปกรรม และรวบรวมองค์ความรู้ใน
การจัดท าเอกสารทางวิชาการ 

2) ออกแบบ เขียนแบบ อนุรักษ์สร้างสรรค์งานศิลปกรรม และงานช่างสิบหมู่ เพ่ือการ
สืบทอด สร้างสรรค์ เผยแพร่ และประชาสัมพันธ์ 

3) ซ่อมงานศิลปกรรมและงานช่างสิบหมู่ เพ่ืออนุรักษ์ผลงานศิลปกรรมของไทยให้คง
อยู่ต่อไป 

4) ร่วมจัดท าสื่อประชาสัมพันธ์ เพ่ือเสริมสร้างความเข้าใจแก่ประชาชน และสืบทอด
ศิลปวัฒนธรรม 

5) ร่วมจัดนิทรรศการด้านศิลปกรรม เพ่ือเผยแพร่และประชาสัมพันธ์ 
 
   2.2.1.2. ด้านการวางแผน 
    วางแผนการท างานที่รับผิดชอบ ร่วมด าเนินการวางแผนการท างานของหน่วยงานหรือ
โครงการ เพ่ือให้การด าเนินงานเป็นไปตามเป้าหมายและผลสัมฤทธิ์ที่ก าหนด 
   2.2.1.3.  ด้านการประสานงาน 
   1)  ประสานการท างานร่วมกันทั้งภายในและภายนอกทีมงานหรือหน่วยงาน เพ่ือให้
เกิดความร่วมมือและผลสัมฤทธิ์ตามที่ก าหนด 
   2) ชี้แจงและให้รายละเอียดเกี่ยวกับข้อมูล ข้อเท็จจริง แก่บุคคลหรือหน่วยงานที่
เกี่ยวข้อง เพ่ือสร้างความเข้าใจหรือความร่วมมือในการด าเนินงานตามที่ได้รับมอบหมาย 
   2.2.1.4.  ด้านการบริการ 
    ให้ค าแนะน าความรู้ด้านศิลปกรรม แก่บุคคล หรือหน่วยงานที่เกี่ยวข้อง เพ่ือเผยแพร่
ความรู้ 
  2.2.1.5  คุณสมบัติเฉพาะส าหรับต าแหน่ง 
    มีคุณสมบัติอย่างใดอย่างหนึ่งดังต่อไปนี้ 

1) ได้รับปริญญาตรีหรือคุณวุฒิอย่างอ่ืนที่เทียบได้ในระดับเดียวกัน ในสาขาวิชาวิจิตร
ศิลป์และประยุกต์ศิลป์ หรือสาขาวิชาสถาปัตยกรรมศาสตร์ หรือสาขาวิชาใดสาขาวิชาหนึ่ง หรือหลาย
สาขาวิชาดังกล่าว ในทางท่ีส่วนราชการเจ้าสังกัดเห็นว่าเหมาะสมกับหน้าที่ความรับผิดชอบ และลักษณะงานที่
ปฏิบัติ หรือสาขาวิชาอ่ืนที่ ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะส าหรับต าแหน่งนี้ได้ 

2) ได้รับปริญญาโทหรือคุณวุฒิอย่างอ่ืนที่เทียบได้ในระดับเดียวกัน ในสาขาวิชาวิจิตร
ศิลป์และประยุกต์ศิลป์ หรือสาขาวิชาสถาปัตยกรรมศาสตร์ หรือสาขาวิชาใดสาขาวิชาหนึ่ง หรือหลาย
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สาขาวิชาดังกล่าว ในทางท่ีส่วนราชการเจ้าสังกัดเห็นว่าเหมาะสมกับหน้าที่ความรับผิดชอบ และลักษณะงานที่
ปฏิบัติ หรือสาขาวิชาอ่ืนที่ ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะส าหรับต าแหน่งนี้ได้ 

3) ได้รับปริญญาเอกหรือคุณวุฒิอย่างอ่ืนที่เทียบได้ในระดับเดียวกัน ในสาขาวิชา
วิจิตรศิลป์และประยุกต์ศิลป์ หรือสาขาวิชาสถาปัตยกรรมศาสตร์ หรือสาขาวิชาใดสาขาวิชาหนึ่ง หรือหลาย
สาขาวิชาดังกล่าว ในทางท่ีส่วนราชการเจ้าสังกัดเห็นว่าเหมาะสมกับหน้าที่ความรับผิดชอบ และลักษณะงานที่
ปฏิบัติ หรือสาขาวิชาอ่ืนที่ ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะส าหรับต าแหน่งนี้ได ้

4) ได้รับปริญญาในสาขาวิชาหรือทางอ่ืนที่ ก.พ.อ. กรม พิจารณาเห็นว่ามีความรู้ที่
เทียบได้ในระดับเดียวกันกับสาขาวิชาหรือทางตามข้อ 1 หรือ ข้อ 2 หรือ ข้อ 3 ซึ่งมีความเหมาะสมกับหน้าที่
ความรับผิดชอบและลักษณะงานที่ปฏิบัติ 

5) ได้รับปริญญาหรือคุณวุฒิอย่างอ่ืนที่  ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะ
ส าหรับต าแหน่งนี้ได้ 
  2.2.1.6  ความรู้ความสามารถ ทักษะ และสมรรถนะท่ีจ าเป็นส าหรับต าแหน่ง 

1. มีความรู้ความสามารถที่จ าเป็นส าหรับการปฏิบัติงานในต าแหน่ง 
2. มีทักษะที่จ าเป็นส าหรับการปฏิบัติงานในต าแหน่ง 
3. มีสรรถนะที่จ าเป็นส าหรับการปฏิบัติงานในต าแหน่ง 

2.2.2  บทบาทหน้าที่ความรับผิดชอบของต าแหน่งตามที่ได้รับมอบหมาย 
 บทบาทหน้าที่ความรับผิดชอบของนางสาวจุติมา พูลสวัสดิ์ ต าแหน่ง นักวิชาการช่างศิลป์ ระดับ
ปฏิบัติการ ตามที่ได้รับมอบหมาย มีดังนี้  

2.2.2.1 งานออกแบบสื่อกราฟิก 
- ประสานงานข้อมูลเนื้อหาที่ใช้ในการออกแบบสื่อกราฟิก 
- ร่วมวางแผนการออกแบบสื่อกราฟิก 
- ออกแบบและผลิตสื่อกราฟิก 
- ปรับปรุงแก้ไขข้อผิดพลาดการออกแบบและผลิตสื่อกราฟิก 
- สรุปผลการปฏิบัติงานประจ าเดือน 

2.2.2.2 งานออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- ประสานงานข้อมูลการออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์  
- ร่วมวางแผนการออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- ออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- ปรับปรุงแก้ไขข้อผิดพลาดการออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- สรุปผลการปฏิบัติงานประจ าเดือน 
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2.2.2.3 งานให้บริการจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
- ประสานงานข้อมูลในการจัดท าจดหมายข่าวสภามหาวิทยาลัย กับหน่วยงานภายใน

มหาวิทยาลัย 
- ร่วมวางแผนการจัดท าจดหมายข่าวสภามหาวิทยาลัย กับหน่วยงานภายใน

มหาวิทยาลัย 
- ปรับปรุงแก้ไขข้อผิดพลาด 
- บริการค าแนะน า ค าปรึกษาในด้านการออกแบบสื่อกราฟิก 

2.2.2.4 งานให้บริการด้านการออกแบบสื่อกราฟิกแก่หน่วยงานภายในและภายนอก ส านักวิทย    
บริการและเทคโนโลยีสารสนเทศ 
- ประสานงานข้อมูลในการออกแบบสื่อกราฟิก กับหน่วยงานภายในและภายนอก 
- วางแผนการออกแบบสื่อกราฟิก ให้กับหน่วยงานภายในและภายนอก  
- บริการค าแนะน า ค าปรึกษาในด้านการออกแบบสื่อกราฟิก 

2.2.2.5 จัดเก็บและบ ารุงรักษาวัสดุ อุปกรณ์ท่ีใช้ในการออกแบบและผลิตสื่อกราฟิก 
- ตรวจเช็คครุภัณฑ์อุปกรณ์ท่ีใช้ในการออกแบบให้พร้อมใช้งานอยู่เสมอ 
- ตรวจสอบปริมาณวัสดุ อุปกรณ์ให้พร้อมใช้ในการผลิตสื่อ 
- ตรวจสอบและท าการซ่อมแซมวัสดุ อุปกรณ์ที่ช ารุดเสียหายในเบื้องต้น หากช ารุด

เสียหายมาก ประสานงานด าเนินการซ่อมกับช่างผู้เชี่ยวชาญ หรือจัดหาวัสดุใหม่มา
ทดแทน 

2.2.2.6 ปฏิบัติงานอื่น ๆ ตามที่ได้รับมอบหมาย  
จากภาระหน้าที่ที่ได้รับมอบหมายดังกล่าวข้างต้นผู้เขียนได้เลือกเอาการจัดท าจดหมาย

ข่าวสรุปผลการด าเนินงานกลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา ส านักวิทยบริการและเทคโนโลยี
สารสนเทศ มาเขียนคู่มือการปฏิบัติงาน โดยมี Flow Chart ดังนี้  
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ผังงานที่ 2-3  แสดงกระบวนการจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 

ตรวจสอบ 

เริ่มต้น 

หน่วยงานขอความอนุเคราะห์ 

หัวหน้าส านักงานพิจารณาและส่งหนังสือ 

ผอ.ส านักพิจารณา 

ไม่อนุมัต ิ

อนุมัต ิ

หัวหน้าฝ่ายพิจารณา 

หน่วยงานร้องขอจัดเตรียมการประชุม/หารือแนวทางการด าเนินงาน 

ผู้ปฏิบัติงานของหน่วยงานร้องขอเตรียมเนื้อหาข้อมูล 

จัดส่งทาง Google Drive 
สอบถามรายละเอียด 

เพิ่มเตมิ 
ตรวจสอบ 

 ไม่ครบ 

ข้อมูลครบ 

ผู้ปฏิบัติงานด าเนินการจัดท ารูปเล่มจัดส่งทาง  
Google Drive 

ผู้ปฏิบัติงานของหน่วยงานร้องขอท าการเผยแพร่ประชาสัมพันธ์ 

ผ่าน 

ปรับปรุงแก้ไข 

ไม่ผา่น 

สิ้นสุดกระบวนการ 



บทท่ี 3 
หลักเกณฑ์วิธีการปฏิบัติงาน 

 
3.1  หลักเกณฑ์วิธีการปฏิบัติงาน 

การจัดท าคู่มือการปฏิบัติงานเรื่อง การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe InDesign ของกลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา 
ส านักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ผู้จัดท าคู่มือ             
มีหลักเกณฑว์ิธีการปฏิบัติงาน โดยมีทฤษฎี แนวคิดและงานวิจัยที่เก่ียวข้อง ดังนี้ 

3.1.1  หลักการออกแบบส่ือสิ่งพิมพ์ 
การออกแบบและจัดหน้าสิ่งพิมพ์มีวัตถุประสงค์ส าคัญด้วยกัน ประการ คือ 
1 เพื่อเพ่ิมความน่าสนใจให้สื่อสิ่งพิมพ์ 
2 เพื่อให้สื่อสิ่งพิมพ์ง่ายต่อการอ่านและการท าความเข้าใจ 
3 เพ่ือสร้างความประทับใจและความทรงจ าให้กับผู้อ่านระยะยาว 
 

3.1.2 ปัจจัยท่ีต้องค านึงถึงในการออกแบบและจัดหน้าสิ่งพิมพ์ 
3.1.2.1.  ประเภทและลักษณะเนื้อหาของสิ่งพิมพ์ สิ่งพิมพ์ที่ใช้ในปัจจุบันจ าแนก ตามวัตถุประสงค์

ในการจัดท า ลักษณะเนื้อหา ระยะเวลาในการเผยแพร่ รูปแบบ เป็นต้น สิ่งพิมพ์แต่ละประเภทมีลักษณะ
เนื้อหาและรูปแบบเฉพาะตัว ท าให้หลักการออกแบบและจัดหน้าแตกต่างกันไป โดยการออกแบบและการจัด
หน้าสิ่งพิมพ์ต้องจัดให้สอดคล้องและสัมพันธ์กับเนื้อหาที่น าเสนอ 

3.1.2.2. วัตถุประสงค์ในการจัดท า วัตถุประสงค์ขึ้นอยู่กับนโยบายของผู้จัดพิมพ์ และความ
ต้องการของหน่วยงาน ดังนั้นการจัดรูปแบบสิ่งพิมพ์จึงสนองต่อความต้องการและนโยบายของหน่วยงาน 

3.1.2.3.  เป้าหมาย หรือกลุ่มผู้อ่านที่แตกต่างกันไป เช่น กลุ่มเป้าหมายคือ นิสิต นักศึกษา รวมทั้ง
ผู้สนใจทั่วไป การออกแบบและการจัดหน้าสิ่งพิมพ์จ าเป็นต้องค านึงถึงจิตวิทยาในการรับรู้ข่าวสารของ
กลุ่มเป้าหมายเพ่ือให้สอดคล้องกับความต้องการและวัตถุประสงค์ของกลุ่มเป้าหมาย 

3.1.2.4.  ขนาดและรูปแบบมาตรฐานของสิ่งพิมพ์ เป็นการก าหนดขนาดและรูปแบบสิ่งพิมพ์ให้
สอดคล้องกับลักษณะของกระดาษมาตรฐาน โดยทั่วไปมีสอบประเภท คือ กระดาษแผ่นและกระดาษม้วน 
ผู้ออกแบบต้องศึกษาข้อมูลเกี่ยวกับขนาดและมาตรฐานของกระดาษ เพ่ือความประหยัดด้วยการให้เศษ
กระดาษเหลือจากการเจียนน้อยที่สุด เพราะกระดาษเป็นปัจจัยหลักในการก าหนดราคาและคุณภาพของสื่อ
สิ่งพิมพ์ ที่ส าคัญควรค านึงถึงลักษณะเฉพาะตัวของสิ่งพิมพ์ เพ่ือให้การออกแบบการจัดหน้าสอดคล้องกับ
ลักษณะ รูปแบบ และประโยชน์การใช้สอย 

3.1.2.5. ประเภทและคุณลักษณะของกระดาษพิมพ์ จ าแนกตามพ้ืนผิวหน้ามี 2 ประเภท คือ 
กระดาษเคลือบผิวและกระดาษไม่เคลือบผิว กระดาษเคลือบผิวสามารถดูดซึมหมึกน้อยกว่ากระดาษไม่เคลือบ
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ผิว ส่งผลให้หมึกแห้งช้าแต่ให้ความคมชัดของเม็ดสีสรีนบนกระดาษภาพจึงมีความคมชัด และมีราคาแพง    
(สมพิศ ไปเจอะ, 2563) 
 

3.1.3  การผลิตสื่อสิ่งพิมพ์ 
 สื่อสิ่งพิมพ์  ในอดีตจัดได้ว่าเป็นสื่อที่มีบทบาทส าคัญมากไม่ว่าจะเป็นหน่วยงานภาครัฐหรือเอกชน 

ตลอดจนสถาบันการศึกษาต่าง ๆ ที่น าสื่อสิ่งพิมพ์มาช่วยให้การท างานเผยแพร่ข้อมูล ข่าวสารและความรู้ให้กับ
ทุกคน เพ่ือให้เกิดประโยชน์มีการสื่อสารไปในทิศทางเดียวกัน  สื่อสิ่งพิมพ์ท าหน้าที่เป็นสื่อมวลชนชนิดหนึ่ง ซึ่ง
มีความส าคัญไม่แพ้สื่ออ่ืน ๆ (กองการพิมพ์, 2562) ถึงแม้ว่าในปัจจุบัน สื่อสิ่งพิมพ์ที่มีรูปแบบเป็นรูปเล่มจะลด
บทบาทการผลิตลง มีการติดตามข่าวสารทางสื่อโซเซียลเพ่ิมมากขึ้น แต่ในการน าเสนอข้อมูลข่าวสารต่าง  ๆ ก็
ยังคงรูปแบบการออกแบบแบบสื่อสิ่งพิมพ์ เพียงปรับเปลี่ยนวิธีการน าเสนอจากรูปแบบเป็นเล่มแบบแฮนด์
เอ้าท์จับต้องได้ มาในรูปแบบสื่อออนไลน์ตามกระแสนิยม เพ่ือให้เข้าถึงกลุ่มเป้าหมายที่ต้องการได้กว้างขวาง
และหลากหลาย บทบาทของสื่อสิ่งพิมพ์ในสถานศึกษา นอกจากถูกน าไปใช้ในการผลิตต ารา แบบเรียน 
เอกสารประกอบการเรียนแล้ว ยังสามารถพัฒนาเป็นเนื้อหาในระบบเครือข่ายอินเทอร์เน็ตได้อีกด้วย 

3.1.3.1 ประเภทของสื่อสิ่งพิมพ์  
สื่อสิ่งพมิพ์สามารถแบ่งออกได้เป็น 4 ประเภทใหญ่ๆ คือ (กองการพิมพ์, 2562) 
1) สื่อสิ่งพิมพ์ประเภท หนังสือพิมพ์ (Newspapers) 
2) สื่อสิ่งพิมพ์ประเภท นิตยสารและวารสาร (Magazines and Journals) 
3) สื่อสิ่งพิมพ์ประเภท หนังสือ (Book) 
4) สื่อสิ่งพิมพ์เฉพาะกิจต่าง เป็นสิ่งพิมพ์ทุกชนิดทุกประเภทที่ใช้ในกิจกรรมใดกิจกรรม

หนึ่ง เพ่ือใช้ในการโฆษณาประชาสัมพันธ์ หรือใช้เพ่ือการศึกษาพัฒนาสังคม ผู้ที่ใช้สื่อเหล่านี้ ได้แก่ 
หน่วยงานทั้งภาคราชการ ภาครัฐวิสาหกิจ ภาคธุรกิจ และภาคเอกชน (จินตนา  ถ้ าแก้ว, 2555) เช่น 
ใบปลิว (Leaflets), แผ่นพับ (Folders), เอกสารเล่มเล็กหรือจุลสาร (Booklets) หรือ (Pamphlets) และ 
จดหมายข่าว (News Letters)  

3.1.3.2 จดหมายข่าว News Letter 
 จดหมายข่าวเป็นสื่อที่เผยแพร่ภายในองค์กรมีเนื้อหาแตกต่างจากหนังสือพิมพ์ทั่วไป 

จัดท าขึ้นมีวัตถุประสงค์เพ่ือเสนอข่าวสารและเป็นสื่อกลางแลกเปลี่ยนความเห็นของผู้ปฏิบัติงาน เป็นสื่อในการ
ให้ความรู้ ความเข้าใจ ความเคลื่อนไหวขององค์กรต่อกลุ่มเป้ าหมายภายในและกลุ่มเป้าหมายภายนอก    
(ธเนศ หาญใจ, 2563) เป็นประจ าในกลุ่มคนที่มีความสนใจในเรื่องเดียวกัน หรือเป็นสมาชิกชมรมหรือองค์กร
เดียวกัน จดหมายข่าวเป็นสื่อที่มีลักษณะใกล้เคียงกับนิตยสาร (สหภพ กลีบล าเจียก, 2563) เป็นสื่อสิ่งพิมพ์เย็บ
หรือไม่เย็บเล่มก็ได้ มีขนาดไม่แน่นอนที่ตายตัว ซึ่งอยู่กับลักษณะความต้องการใช้งานและสาระของสิ่งพิมพ์          
นั้น ๆ โดยลักษณะของจดหมายข่าวจะเป็นเพ่ือการประชาสัมพันธ์ข่าวสารภายในหน่วยงาน หรือเพ่ือการ
เผยแพร่ความรู้ในแวดวงเดียวกัน จ านวนหน้าจะไม่เกิน 8 หน้า หรือ 16 หน้า รูปเล่มไม่เน้นความแข็งแรงและ



 
 

 

19 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

การเก็บรักษา เหมาะส าหรับใช้งานในระยะเวลาชั่วคราว ไม่จะเป็นต้องมีก าหนดเวลาในการตีพิมพ์ที่แน่นอน 
(จินตนา ถ้ าแก้ว, 2555) 

3.1.3.3  การจ าแนกประเภทจดหมายข่าว สามารถแยกออกเป็นประเภทได้ตามวัตถุประสงค์ 4 
ประเภท 

 1) จดหมายข่าวส่งเสริมการขาย (Promotional Newsletter) คือ จดหมายข่าวที่
เจ้าของสินค้าหรือบริการ ใช้น าเสนอสินค้าหรือบริการของตนให้แก่ผู้บริโภคที่เป็นกลุ่มเป้าหมาย แต่ไม่ใช่
วิธีการขายตรง เป็นการให้ข้อมูลของสินค้าและบริการมากกว่า 

 2) จดหมายข่าวมิตรสัมพันธ์ (Relationship Newsletter) คือ จดหมายข่าวที่องค์กรต่าง 
ๆ ใช้ติดต่อกับลูกจ้าง หรือสมาชิกของตน เช่น จดหมายข่าวของบริษัท จดหมายข่าวของสมาคมการกุศล 

 3) จดหมายข่าวสมาชิกตราสินค้า (Brand-member Newsletter) คือ จดหมายข่าวที่
เจ้าของสินค้าหรือบริการ ใช้ในการติดต่อกับสมาชิกตราสินค้าของตน เช่น จดหมายข่าวสมาชิกบัตรเครดิต 

 4) จดหมายข่าวผู้ เชี่ยวชาญเฉพาะด้าน (Expert Newsletter) คือ จดหมายข่าวที่
เผยแพร่เฉพาะในกลุ่มของผู้เชี่ยวชาญในด้านใดด้านหนึ่ง หรือเรื่องใดเรื่องหนึ่ง เช่น จดหมายข่าวกุมารแพทย์ 
จดหมายข่าวนักข่ีจักรยาน  

3.1.3.4  ส่วนประกอบของจดหมายข่าว สามารถแยกตามองค์ประกอบได้ 2 ส่วน ดังนี้ 
 1) หน้าแรก ประกอบด้วย 
  1.1) แถบชื่อและรายละเอียดของฉบับ 
  1.2) พาดหัว 
  1.3) ภาพประกอบหน้าปก 
  1.4) สารบัญ 
  1.5) เนื้อหา 
 2) หน้าใน ประกอบด้วย 
  2.1) พาดหัวรอง 
  2.2) หัวคอลัมน์ประจ า 
  2.3) เนื้อหา 
  2.4) ภาพในเนื้อใน 
  2.5) พิมพ์ลักษณ์ หรือพิมพ์ประกาศ 
      2.6) องค์ประกอบเรขศิลป์อื่น ๆ 
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3.1.4  หลักการออกแบบจดหมายข่าว 
 หลักการทั่วไปในการออกแบบจดหมายข่าวมี 2 เรื่องที่ส าคัญ คือ สิ่งที่ต้องก าหนดและวางแผน

ก่อนการออกแบบจดหมายข่าวและองค์ประกอบและการจัดวางองค์ประกอบในการออกแบบจดหมายข่าว 
  3.1.4.1. สิ่งที่ต้องก าหนดและวางแผนก่อนการออกแบบจดหมายข่าว ก่อนจะท าการออกแบบ
จดหมายข่าวนั้น มีเรื่องต้องก าหนดและวางแผนเฉพาะในส่วนที่เกี่ยวข้องกับการออกแบบ ดังนี้ 
  1) การก าหนดขนาดและรูปแบบของจดหมายข่าว สิ่งที่ต้องค านึงถึง คือ ลักษณะการ
น าส่งจดหมายข่าว เนื่องจากจดหมายข่าวส่วนใหญ่จะส่งให้ผู้ที่เป็นสมาชิกหรืออยู่ในกลุ่มขององค์กรนั้น ๆ ใน
อดีตการน าส่งมักใช้ไปรษณีย์หรือบริการรับส่ง ดังนั้นจดหมายข่าวจึงต้องมีขนาดที่สะดวกต่อการน าส่งโดยไม่
เสียหายง่าย แต่จดหมายข่าวในปัจจุบันมีการจัดท าในรูปแบบต่าง ๆ การน าเสนอผ่านสื่อออนไลน์ ขนาดที่เป็น
ที่นิยมมากขนาดหนึ่ง คือ ขนาด A4  
  2) รูปแบบของปกหน้าหรือหน้าแรกของจดหมายข่าว จดหมายข่าวมี 2 รูปแบบใหญ่ ๆ 
คือ รูปแบบที่ 1 เป็นการคัดข้อความย่อ ๆ ของเรื่องต่าง ๆ ในฉบับมาน าเสนอ และรูปแบบที่ 2 เป็นการ
น าเสนอเรื่อง ที่เด่นที่สุดในฉบับทั้งเรื่อง ดังนั้นก่อนการออกแบบรายละเอียดในส่วนนี้ต้องตัดสินใจเลือก
เสียก่อนว่าจะเลือกใช้รูปแบบใด 
  3) ในการออกแบบจดหมายข่าว ควรก าหนดรูปแบบหลัก ๆ ของตัวอักษร ส าหรับ
หน้าต่าง ๆ เพ่ือให้เกิดความสม่ าเสมอ และรวดเร็วในการจัดท าจดหมายข่าวฉบับต่อ ๆ ไป  นอกจากแบบแล้ว
ก็คววรก าหนดขนาดของตัวอักษรไว้ด้วยว่าควรใช้ขนาดเท่าใด โดยขนาดตัวอักษรที่ใช้เป็น ตัวพิมพ์เนื้อเรื่อง นั้น
ไม่ควรมีขนาดเล็กกว่า 12 พอยต์ ส่วนตัวอักษรที่ใช้เป็นตัวพิมพ์หัวเรื่อง หัวรอง ควรมีขนาดใหญ่ ตั้งแต่ 18 
พอยต์ขึ้นไป ขนาดตัวอักษรจึงควรเลือกให้เหมาะสม 
  4) การก าหนดภาพประกอบในจดหมายข่าวควรได้รับการก าหนดล่วงหน้าเช่นเดียวกัน
กับตัวอักษร เนื่องจากจดหมายข่าวมีหน้าต่าง ๆ หลายหน้า จึงควรก าหนดลักษณะภาพประกอบให้มีลักษณะ
เดียวกันเพ่ือให้เกิดเอกภาพร่วมกันทั้งฉบับ (ธเนศ หาญใจ, 2563)  
 3.1.4.2  องค์ประกอบและการจัดวางองค์ประกอบ มีรายละเอียดที่เป็นพิเศษ ดังนี้ 
  1) หน้าแรกของจดหมายข่าว มีความส าคัญเช่นเดียวกันกับปกหน้าของนิตยสาร เพราะ
เปรียบเสมือนหน้าตาของจดหมายข่าว ซึ่งจะก่อให้เกิดความประทับใจเมื่อแรกเห็น อีกทั้งยังเป็นโอกาสที่นัก
ออกแบบจะใช้ในการดึงดูดผู้ที่ได้รับจดหมายข่าวนั้นและหยิบขึ้นมาอ่าน แถบชื่อ หรือ หัวหนังสือ เป็ น
องค์ประกอบส าคัญสุดของจดหมายข่าว โดย 
   1.1) เมื่อได้ท าการออกแบบหัวหนังสือแล้วจะต้องยึดรูปแบบเดิมไว้ตลอด เพ่ือให้
ผู้อ่านสามารถรับรู้และจดจ าได้ในทันทีว่าเป็นจดหมายข่าวของหน่วยงานใด  
    1.2) สารบัญของจดหมายข่าวจะแตกต่างจากสารบัญของนิตยสารหรือหนังสือ 
สารบัญของจดหมายข่าวมีลักษณะเป็นพื้นที่สี่เหลี่ยมเล็ก ๆ (Box) วางอยู่ในหน้าแรก เพ่ือช่วยให้ผู้อ่านสามารถ
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ค้นหาเรื่องที่ต้องการได้อย่างรวดเร็ว ดังนั้นในการออกแบบควรเน้น ความเรียบง่าย และท าให้พ้ืนที่ส่วนนี้แยก
ออกมาอย่างชัดเจน 
  2) องค์ประกอบอื่น ๆ ที่มีอยู่ในหน้าแรกและหน้าใน นอกจากหัวหนังสือและสารบัญแล้ว 
องค์ประกอบอ่ืน ๆ ในหน้าแรกของจดหมายข่าว จะมีความคล้ายคลึงกับหน้าใน ซึ่งสามารถแยกเป็น
องค์ประกอบต่าง ๆ ได้ดังนี้ 
   2.1) พาดหัว ควรเน้นความสม่ าเสมอของทั้งรูปแบบและขนาดตัวอักษร ไม่ควร
เปลี่ยนรูปแบบและขนาดตัวอักษรบ่อยๆ พาดหัวนี้จะเป็นตัวอักษรในรูปแบบมีหัว หรือไม่มีก็ได้ แต่ต้องเป็นตัว
ที่อ่านไม่ยากจนเกินไป 
   2.2) ข้อความ เป็นข้อมูลมีปริมาณมาก ดังนั้นจึงควรค านึงถึงความสะดวกในการอ่าน 
นอกจากใช้ขนาดของอักษรแล้ว สีของตัวอักษรก็มีความส าคัญโดยควรใช้สีด า หรือสีเข้มเท่านั้น ตัวอักษรที่มีหัว
เป็นรูปแบบที่มีความเหมาะสมส าหรับการใช้เป็นข้อความเนื้อหามากกว่า ตัวอักษรที่ไม่มีหัว 
   2.3) ภาพประกอบ เป็นองค์ประกอบที่ต้องการความสม่ าเสมอในการน ามาใช้ หาก
เป็นภาพประกอบต้องพิจารณาเทคนิคที่เหมาะสมกับองค์กร เช่น การวาดภาพด้วยคอมพิวเตอร์กราฟิกจะดู
เหมาะสมกับจดหมายข่าวองค์กรที่เกี่ยวกับเทคโนโลยี การใช้ภาพต้องพิจารณาถึงความเหมาะสมให้สอดคล้อง
กับเนื้อหา  

3.1.4.3  การออกแบบและจัดหน้าสิ่งพิมพ์จดหมายข่าวประกอบด้วย 4 ขั้นตอน ดังนี้  
  1)  การก าหนดรูปแบบและขนาดของจดหมายข่าว  
  2)  การท าแบบร่างหยาบ โดยมีขนาดสัดส่วนรูปร่างและขนาดเสมือนจริง การท าร่าง

หยาบอาจท าหลายชิ้นเพื่อเลือกพิจารณา เป็นการก าหนดต าแหน่งอักษรแทนส่วนที่เป็นข้อความทั้งหมด 
  3) การท าแบบร่างสมบูรณ์หรือแบบร่างละเอียด เป็นการร่างให้มีลักษณะที่ละเอียดมาก

ขึ้น มีการก าหนดลักษณะ ขนาดและแบบตัวพิมพ์หรือแบบตัวอักษร ภาพประกอบที่ใช้สัญลักษณ์แทนขนาด
และช่วงบรรทัด ก าหนดช่องว่างระหว่างบรรทัดของตัวอักษร นอกจากนี้ยังก าหนดรายละเอียดเทคนิคพิเศษ 
อ่ืน ๆ ในการพิมพ์  

   4) การท าดัมม่ี เป็นการควบคมุการพับและการจัดท าในแต่ละขั้นตอน ซึ่งข้อมูลที่ก าหนด
ในดัมมี่ ได้แก่ ขนาดสิ่งพิมพ์ ล าดับเนื้อหา ล าดับเลขหน้า ขนาดรูแบบตัวอักษร รูปแบบคอลัมน์ การวาง
ตัวอักษร นอกจากนี้ควรก าหนดความยาวของบรรทัด ตารางภาพประกอบ ขนาดของภาพประกอบ การเน้น
หัวเรื่อง การวางย่อหน้า ลักษณะการพับ และการเก็บเล่ม  
 3.1.4.4  ขั้นตอนการผลิตจดหมายข่าว ขั้นตอนการผลิตทั้งหมดจะกระท าภายหลังการจัดเตรียม
ต้นฉบับเพื่อการพิมพ์ ดังนี้ 
  1) งานก่อนการพิมพ์ ประกอบด้วยขั้นตอนต่าง ๆ ได้แก่ การเรียงพิมพ์ การพิสูจน์อักษร 
การท าอาร์ตเวิร์ค  
  2) งานพิมพ์ เป็นขั้นตอนการถ่ายทอดภาพและข้อความโดยใช้เครื่องพิมพ์ 
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  3) งานท าส าเร็จ ได้แก่ การพับวัสดุพิมพ์ การเข้าเล่ม การเข้าปก การตัดเจียนและการ
แปรสภาพงานพิมพ์ ทั้งนี้การออกบสิ่งพิมพ์ควรค านึงถึงขั้นตอนการผลิตทั้งหมด เพ่ือให้การปฏิบัติงานในแต่ละ
ขั้นตอนสอดคล้องและด าเนินไปด้วยความถูกต้อง  
 3.1.4.5  หลักการออกแบบและจัดวางองค์ประกอบในจดหมายข่าว 
  สิ่งพิมพ์ประกอบด้วยองค์ประกอบส าคัญหลายอย่าง ได้แก่ ตัวอักษรหรือข้อความ 
ภาพประกอบ การออกแบบ จัดหน้าต้องค านึงถึงการจัดวางองค์ประกอบต่าง ๆ ดังกล่าว โดยใช้หลักการดังนี้ 

1)  เอกภาพ ในการจัดวางองค์ประกอบ เป็นการจัดวางองค์ประกอบทั้งหมดของรูปแบบ
ตั้งแต่ข้อความ ภาพ สัญลักษณ์และอ่ืน ๆ ให้มีความสัมพันธ์ซึ่งกันและกัน สอดคล้องกับวัตถุประสงค์และความ
ต้องการของเจ้าของงานและผู้ออกแบบ ในการจัดวางองค์ประกอบให้มีเอกภาพสามารถท าได้ด้วยการใช้แบบ
ตัวพิมพ์หรือแบบอักษรที่ไม่มากเกินไปในหนึ่งหน้า เพ่ือไม่ให้เกิดความหลากหลายหรือท าให้ส่วนประกอบ    
ต่าง ๆ ของเล่มแยกจากกันเกินไป การใช้รูปแบบตัวอักษรหลาย ๆ แบบในหนึ่งหน้า ส่งผลให้ดึงดูดความสนใจ
จากผู้อ่านได้ แต่ผลเสียคือ ท าให้ผู้อ่านเข้าใจความหมายช้าและต้องใช้ความพยายามในการอ่านมากเกินไป 

2)  สมดุล การจัดวางองค์ประกอบให้เกิดความสมดุล ให้มีรูปแบบที่สมดุลกันในแต่ละ
ด้าน ไม่เน้นหนักในเรื่องใดเรื่องหนึ่ง ความสมดุลในการจัดวางรูปแบบมีสอบประเภท คือ ความสมดุลแท้หรือ
ความสมดุลที่องค์ประกอบทางซ้ายและขวา หรือบนและล่างมีน้ าหนักเท่ากัน อีกประการหนึ่ง คือ ความสมดุล
เทียมหรือความสมดุลที่องค์ประกอบด้านซ้ายด้านขวา หรือด้านบนและด้านล่างมีน้ าหนักไม่เท่าเทียมกัน 

3)  สัดส่วน ในการจัดวางองค์ประกอบ โดยเน้นความสัมพันธ์ของขนาดและรูปร่าง 
ความสัมพันธ์ระหว่างด้านกว้างและด้านยาวของสิ่งพิมพ์ ความเหมาะสมของขนาดรูปแบบ และรูปเล่มของ
สิ่งพิมพ์ การก าหนดสัดส่วนของสิ่งพิมพ์โดยทั่วไปนิยมให้ด้านกว้างและด้านยาวสอดคล้องกับสัดส่วนของ
กระดาษมาตรฐาน ดังนั้นผู้ออกแบบต้องค านึงถึงสัดส่วนที่เหมาะสม  

4)  การเน้นหรือย้ าจุดสนใจ เป็นการวางจุดสนใจที่ส าคัญหรือเด่นชัดขึ้น แตกต่างจากสี
พ้ืนและส่วนประกอบอ่ืน เป็นการเพ่ิมความน่าสนใจให้สื่อสิ่งพิมพ์ ด้วยการใช้โทนสีตัดกัน ใช้สีขาว-ด า ใช้
ตัวอักษรขาวในพื้นที่ทึบ หรือใช้เนื้อที่ว่างแทรกระหว่างหน้าที่มีเนื้อหามาก 

5)  การใช้รูปแบบซ้ ากัน เป็นการจัดวางองค์ประกอบรูปแบบที่ดูเป็นกลุ่มก้อน โดยใช้
รูปแบบที่คล้ายคลึงกัน เพ่ือเพ่ิมความแปลกใหม่ ความประหลาดและความน่าสนใจให้กับสื่อสิ่งพิมพ์ อีกทั้งยัง
เป็นการเน้นข้อความหรือจุดส าคัญที่ต้องการสื่อความหมายด้วย 

6)  การใช้เส้นน าสายตาให้เกิดลีลาเคลื่อนไหว เป็นการใช้เส้นน าสายตาผู้อ่านไปสู่
จุดส าคัญท่ีต้องการสื่อความหมาย ท าให้ส่วนประกอบต่าง ๆ มีการเคลื่อนไหวจากส่วนหนึ่งไปอีกส่วนหนึ่ง ภาพ
จะดูไม่นิ่งเกินไปและช่วยป้องกันความสับสนจากการอ่านด้วยการใช้ลูกศรหรือเส้น อาจเป็นเส้นตรงหรือเส้น
โค้งหรือเส้นลักษณะอ่ืนที่สามารถน าจุดสนใจได้ 
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7)  การใช้กรอบหรือพ้ืนที่เป็นลวดลายเป็นส่วนประกอบ เสริมความน่าสนใจ ความงาม 
ความโดดเด่น หรือสร้างอารมณ์ให้เกิดกับภาพ ข้อความและรูปแบบสิ่งพิมพ์ด้วยการตกแต่งกรอบ แต่ควรใช้
ลวดลายที่กลมกลืนกันกับตัวพิมพ์ ตัวอักษร ภาพ และต้องเข้ากับความหมายและลักษณะของเนื้อหาด้วย  

 ดังนั้นหลักการออกแบบและจัดวางองค์ประกอบของสิ่งพิมพ์ ควรมีเอกภาพ มีการจัด
วางองค์ประกอบให้เกิดความสมดุล การจัดหน้ามีสัดส่วนที่เหมาะสมกับขนาดของสิ่งพิมพ์ และจัดวางจุดสนใจ 
จุดส าคัญหรือจุดเด่นให้ชัดไม่ว่าจะเป็นการใช้สี ขนาด รูปภาพหรือวางองค์ประกอบซ้ าซ้อนกัน การใช้กรอบ
หรือพ้ืนที่ เป็นลวดลาย การใช้ เส้นน าสายตาจะส่งผลให้จุดสนใจของสิ่ ง พิมพ์มีความเด่นมากขึ้น                             
(สมพิศ ไปเจอะ, 2563) 
 3.1.4.6  การเลือกใช้ตัวอักษร 
  ตัวอักษรมีความส าคัญมากต่อการผลิตวัสดุกราฟิก เพราะตัวอักษรจะท าหน้าที่เป็นส่วน
แจกแจงรายละเอียดของข้อมูล การน าเสนอด้วยรูปแบบและการจัดวางต าแหน่งตัวอักษรที่สวยงาม ชัดเจน
อ่านงาน น่าสนใจ สวยงาม ลักษณะของตัวอักษรจึงถูกก าหนดตามการน าไปใช้ การเลือกตัวอักษรให้เหมาะสม 
มีหลักการดังนี้  

1) รูปแบบตัวอักษร ในการเลือกตัวอักษรที่เหมาะสมจะช่วยให้งานออกแบบกราฟิกนั้น 
สามารถสื่อความหมายได้อย่างเต็มที่ ในปัจจุบันมีรูปแบบตัวอักษรมากมาย แบ่งได้ดังนี้  

1.1) ตัวอักษรแบบมีเชิง เป็นอักษรที่มีเส้นยื่นของฐานและปลายตัวอักษรในทางราบ 
ลักษณะตัวอักษรจะมีเส้นตัวอักษรเป็นแบบหนาบางไม่เท่ากัน ตัวอักษรแบบนี้บราวเซอร์หลายชนิดจะใช้
ตัวอักษรแบบนี้เป็นหลัก ตัวอักษรประเภทนี้เหมาะจะใช้เป็นรายละเอียดเนื้อหา แต่ตัวอักษรประเภทนี้ไม่ค่อย
เหมาะจะใช้กับตัวหนา 

1.2) ตัวอักษรแบบไม่มีเชิง เป็นลักษณะของตัวอักษรอีกแบบหนึ่งที่มีรูปแบบเรียบ
ง่าย เป็นทางการ ไม่มีเชิง หมายถึงไม่มีเส้นยื่นออกมาจากฐาน และปลายของตัวอักษรในทางราบ ตัวอักษร
ประเภทนี้เหมาะที่จะใช้กับหัวข้อหรือ ตัวอักษรขนาดใหญ่ แต่ไม่เหมาะสมกับลักษณะเอียง 

1.3) ตัวอักษรแบบตัวเขียน ตัวอักษรแบบนี้เน้นให้ตัวอักษรมีลักษณะคล้ายกับการ
เขียนด้วยลายมือ ไม่มีหางโยงต่อเนื่องระหว่างตัวอักษร มีขนาดเส้นอักษรหนาบางแตกต่างกัน นิยมท าให้เอียง
เล็กน้อย 

1.4) ตัวอักษรแบบอาลักษณ์ เป็นตัวอักษรแบบโรมันแบบตัวเขียนอักลักษณะหนึ่ง มี
ลักษณะเป็นแบบประดิษฐ์มีเส้นตั้งด าหนา ภายในตัวอักษรมีเส้นหนาบางคล้ายกับการเขียนด้วยพู่กัน หรือ 
ปากกาปลายตัด 

1.5) ตัวอักษรแบบประดิษฐ์ หรือ ตัวอักษรตัวพิมพ์ขนาดใหญ่ มีลักษณะเด่น คือ การ
ออกแบบตกแต่งตัวอักษรให้สวยงามเพ่ือดึงดูดสายตา มีขนาดความหนาของเส้นอักษรหนากว่าแบบอ่ืน ๆ จึง
นิยมใช้เป็นหัวเรื่อง 

1.6) ตัวอักษรแบบสมัยใหม่ เป็นตัวอักษรที่ประดิษฐ์ขึ้น มีลักษณะเรียบง่าย 
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2) ลักษณะและขนาดตัวอักษร 
 2.1) ลักษณะของตัวอักษร จากรูปแบบตัวอักษรที่หลากหลาย การสร้างแบบอักษรก็

ยังมีความแตกต่างที่หลายรูปแบบ ท าให้มีลักษณะเฉพาะของตัวอักษรเปลี่ยนแปลงไป เช่น ตัวเอน ตัวหนา ตัว
ธรรมดา ตัวเส้นขอบ ตัวบางพิเศษ ตัวหนาพิเศษ ตัวแคบ ตัวด า ตัวบาง 

 2.2) ขนาดของตัวอักษร ขนาดของตัวอักษรเป็นการก าหนดขนาดที่เป็นสัดส่วนความ
กว้าง และสูงและรูปร่างของตัวอักษร โดยเอาความสูงเป็นหลักในการจัดขนาดเรียกว่า พอยต์ (Point) ขนาด
ตัวอักษรหัวเรื่องมักใช้ขนาดตั้งแต่ 16 พอยต์ ขึ้นไป ส่วนขนาดของเนื้อหาจะใช้ขนาดประมาณ 6 พอยต์ ถึง 16 
พอยต์ แล้วแต่ลักษณะของงานนั้น ๆ  

  12 พอยต์ = 1 ไพก้า 
  6 ไพก้า = 1 นิ้ว (2.5 ซ.ม.) 
  75 พอยต์ = 1 นิ้ว 
  ขนาดทางราบหรือทางกว้างของตัวอักษร เมื่อเรียงกันไปเป็นค าหรือความยาวใน 

1 บรรทัด หรือเรียกว่า เป็น “ความยาวคอลัมน์” จะก าหนดเป็นไพก้า (Pica) 
3) ระยะช่องไฟและการจัดวางอักษร การจัดระยะช่องไฟตัวอักษรมีความส าคัญมาก 

เนื่องจากถ้ามีการออกแบบที่เหมาะสม และสวยงามแล้วจะท าให้ผู้ดูอ่านง่าย สบายตา ชวนอ่าน การจัดช่องไฟ
มีหลักการใช้อยู่ 3 ข้อดังนี้ 

 3.1) ระยะช่องไฟระหว่างอักษร (Letter Spacing) เป็นการก าหนดช่องไฟระหว่าง
ตัวอักษรแต่ละตัวที่จะต้องมีระยะห่างกันพองาม ไม่ติดหรือห่างกันเกินไป ควรจัดช่องไฟโดยค านึงถึงปริมาตรที่
มีความสมดุล โดยประมาณในระหว่างตัวอักษร หรือเรียกว่า ปริมาตรความสมดุลทางสายตา 

 3.2) แบบการจัดตัวอักษร ในการจัดเนื้อหาของตัวอักษรมีการจัดด้วยกันหลายวิธี 
เช่น 

  - จัดชิดซ้าย จะมีลายด้านขวาไม่สม่ าเสมอ เนื่องจากตัวอักษรในแต่ละบรรทัด มี
ความยาวไม่เท่ากัน แต่ผู้อ่านก็ไม่สามารถหาจุดเริ่มต้นของแต่ละบรรทัดได้ง่าย 

  - จัดชิดขวา ถึงแม้รูปแบบการจัดตัวอักษรแบบนี้จะน่าสนใจ แต่จุดเริ่มต้นในแต่
ละบรรทัดที่ไม่สม่ าเสมอ ท าให้อ่านยาก ผู้อ่านต้องหยุดชะงัก เพ่ือหาจุดเริ่มต้นของแต่ละบรรทัด 

  - จัดกึ่งกลาง จะใช้ได้ดีกับข้อความที่ไม่มีปริมาณมากนัก และเหมาะกับรูปแบบ
ที่เป็นทางการ เช่น ค าประกาศหรือค าเชื้อเชิญ  

  - จัดชิดขอบซ้ายและขวา เมื่อจัดตัวอักษรแบบ justify จะมีพ้ืนที่ว่างเกิดขึ้น
ระหว่างค า สิ่งที่ควรระวังคือ เกิดช่องว่าง ซึ่งจะรบกวนความสะดวกในการอ่าน แต่เป็นสิ่งยากที่จะหลีกเลี่ยง 
ในคอลัมน์ที่มีขนาดแคบ (สถาบันเทคโนโลยีพระจอมเกล้าพระนครเหนือ, 2563) 
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3.1.5 ทฤษฏีส ี
 สี หรือ Color หมายถึง ลักษณะของแสงที่ปรากฏและกระทบต่อสายตาให้เห็นเป็นสีมีผลถึง
จิตวิทยา มีอ านาจให้เกิดความเข้มของแสงที่อารมณ์และความรู้สึกได้ ส่งความรู้สึกไปยังสมองท าให้เกิด
ความรู้สึกต่าง ๆ ตามอิทธิพลของสี ซึ่งสีมีความหมายอย่างมากเพราะการใช้สีเป็นสื่อสร้างความประทับใจให้
บังเกิดแก่ผู้ดู สีเป็นสิ่งที่ควรศึกษาเพ่ือประโยชน์และเป็นสิ่งที่มีหลักวิชาเป็นวิทยาศาสตร์จึงควรท าความเข้าใจ 
ถ้าไม่สามารถเข้าใจเรื่องสีดีพอสมควรจะท าให้การออกแบบมีความสมบูรณ์มากยิ่งขึ้น 
 การรับรู้สีเกิดจากการที่แสงตกกระทบวัตถุสีที่รับรู้ได้จะเกิดจากคุณลักษณ์ 3 ประการ  คือ 
ลักษณะทางกายภาพและทางเคมีขององค์ประกอบของวัตถุ 
 3.1.5.1 ค าจ ากัดความของสี 
  1) แสงที่มีความถ่ีของคลื่นในขนาดที่ตามนุษย์สามารถรับสัมผัสได้ 
  2) แม่สีที่เป็นวัตถุ (PIGMENTARY PRIMARY)  
  3) สีที่เกิดจากการผสมของแม่สี 
 3.1.5.2 สี องค์ประกอบแห่งอารมณ์ 
  สีมีอิทธิพลในเรื่องของอารมณ์การสื่อความหมายที่เด่นชัด และกระตุ้นต่อการรับรู้ของ
คนเราแบ่งออกได้ 3 ประการ 

1) เนื้อสี (hue) หรือที่เรียกว่า “สี” ของวัตถุ 
2) ความสว่าง หรือ น้ าหนักสี (lightness) หรือที่เรียกว่า brightness 
3) ความบริสุทธิ์ของสี หรือความสดของสี  
 

1.1) เนื้อสี (hue) คือ ความแตกต่างของสีบริสุทธิ์แต่ละสี ซึ่งเราจะเรียกเป็นชื่อสี เช่น 
สีแดง สีน้ าตาล สีม่วง เป็นต้น โดยแบ่งเนื้อสีออกเป็น 2 ชนิด 

- สีของแสง (Colored Light) คือ ความแตกต่างสั้นยาวของคลื่นแสงที่เรา
มองเห็น เริ่มจากสีม่วงไปสีแดง (เหมือนรุ่งกินน้ าที่เรามองเห็นหลังฝนตก) 
 
 
 
 
 
 
 

ภาพที่ 3-1 แสดงแถบสีของแสง (Colored Light)  
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- สีของสาร (Colored Pigment) คือสีที่เรามองเห็นบนวัตถุต่าง ๆ ซึ่งเกิดจาก
การดูดซึมและสะท้อนของความยาวคลื่นแสง จากการที่เรามองเห็นสีของสารต่าง ๆ นี่เองจึงค้นพบว่ามีสีอยู่ 3 
สี ที่เป็นต้นก าเนิดของสีอ่ืน ๆ ที่ไม่สามารถสร้างหรือผสมให้เกิดจากสีอ่ืนได้ หรือที่เรียกกันว่า “แม่สี” ได้แก่ 
แดง,เหลือง,น้ าเงิน 
 
 
 
 
 

ภาพที่ 3-2 แสดงแถบสีของสาร (Colored Pigment) 
   

1.2) การผสมสี สีที่เรามองเห็นเกิดจากการผสมสี ใน 2 รูปแบบ คือ 
- การผสมสีแบบบวก (Additive Color Mixing) เป็นการผสมสีของ “แสง” ซ่ึง

อาจเข้าใจยากสักหน่อย เพราะแตกต่างจากความคุ้นเคยที่เราเคยรู้กันมา แสงสีขาวที่เห็นทั่วไปนั่น
ประกอบด้วยแสงที่มีความยาวคลื่นต่าง ๆ ซ้อนทับกันเกิดเป็นสีสัน จึงเรียกว่า “สีแบบบวก” โดยมีแม่สีพ้ืนฐ
นคือ สีแดง สีเขียว และสีน้ าเงิน เมื่อน าสามสีมาผสมกันจะได้สีขาว หลักการนี้น าไปใช้กับการมองเห็นสีที่เกิด
จากการผสมกันของแสง เรียกว่า RGB Mode 
 
 
 
 
 
 
 
 

ภาพที่ 3-3 แสดงการผสมกันของสีแบบบวก หรือเรียกว่า RGB Mode 
 

- การผสมสีแบบลบ (Subtractive Color Mixing) เป็นสีที่เกิดจากการดูดกลืน
แสงสะท้อนจากวัตถุ คือเมื่อมีล าแสงสีขาวตกกระทบวัตถุสีต่าง ๆ คลื่นแสงบางส่วนจะถูกดูดกลืนไว้ และ
สะท้อนเพียงบางสีออกมา จึงเรียกว่า “สีแบบลบ” มีแม่สีคือ สีฟ้าแกมเขียว (Cyan)  สีม่วงแดง (Magenta) 
และสีเหลือง (Yellow) เมื่อน าสามสีมาผสมกันจะเป็นสีด า เพราะแสงถูกดูดกลืนไว้หมด ไม่มีแสงสะท้อนเข้าตา 
จึงเห็นเป็นสีด า หลักการนี้ได้น าไปใช้กับการผสมสี เพ่ือใช้ในการพิมพ์ โดยใช้แม่สี แต่เพ่ิมสีด าขึ้นมาอีกสีหนึ่ง 



 
 

 

27 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

ผสมกันเป็นโทนสีต่าง ๆ ท าให้ได้ภาพสีสันสมจริง ดังนั้น หากต้องการท างานเกี่ยวกับสิ่งพิมพ์ ต้องเตรียมภาพ
ด้วยระบบสีนี้ ในโปรแกรมเรียกว่า CMYK Mode 
 
 
 
 
 
 
 

ภาพที่ 3-4 แสดงการผสมกันของสีแบบลบ หรือเรียกว่า CMYK Mode 
 
 3.1.5.3 วรรณของสี  
  สีที่ให้ความรู้สึกร้อน-เย็น ในวงจรสีจะมีสีร้อน 7 สี และสีเย็น 7 สี ซึ่งแบ่งที่สีม่วงกับสี
เหลือง ซึ่งเป็นได้ท้ังสองวรรณ แบ่งออกเป็น 2 วรรณะ 
  วรรณะสีร้อน (Warm tone) ประกอบด้วยสีเหลือง สีส้มเหลือง สีส้ม สีส้มแดง สีม่วงแดง
และสีม่วง สีในวรรณะร้อนนี้จะไม่ใช่สีสด ๆ ดังที่เห็นในวงจรสีเสมอไป เพราะสีในธรรมชาติย่อมมีสีแตกต่างไป
กว่าสีในวงจรสีธรรมชาติอีกมากถ้าหากว่าสีใดค่อนข้างไปทางสีแดงหรือสีส้ม ก็ถือว่าเป็นสีวรรณะร้อน 
  วรรณะสีเย็น (Cool Tone) ประกอบด้วยสีเหลือง สีเขียวเหลือง สีเขียว สีเขียวน้ าเงิน สี
น้ าเงิน สีม่วงน้ าเงิน และสีม่วง ส่วนสีอ่ืน ๆ ถ้าหนักไปทางสีน้ าเงินและสีเขียวก็เป็นสีวรรณะเย็นดังเช่น สีเทา สี
ด า สีเขียวแก่ เป็นต้น จะสังเกตได้ว่าสีเหลืองและสีม่วงอยู่ทั้งวรรณะร้อนและวรรณะเย็น ถ้าอยู่ในกลุ่มสีวรรณะ
ร้อนก็ให้ความรู้สึกร้อนและถ้า อยู่ในกลุ่มสีวรรณะเย็นก็ให้ความรู้สึกเย็นไปด้วย สีเหลืองและสีม่วงจึงเป็นได้ทั้ง 
2 วรรณะ 
 3.1.5.4 น  าหนักของสี 
  ความสว่างของสี หรือการเพิ่มขาว เติมด าลงในเนื้อสีที่เรามีอยู่และการปรับเปลี่ยนน้ าหนัก
สีนี่เองที่ท าให้ภาพดูมีมิติ ดูมีความลึก หรือที่เรียกว่า โทน (Tone) ซึ่งบางครั้งสามารถสร้างความน่าสนใจ 
ดึงดูดและความสมจริงให้กับงานออกแบบได้ 
 
 
 
 
 

ภาพที่ 3-5 แสดงค่าน้ าหนักความสว่างของสี 

ค่าความสว่างสีต่ า ค่าความสว่างสีปาน ค่าความสว่างสี



 
 

 

28 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 3.1.5.5 การเลือกสีมาใช้งาน Color for Design 
  1) การเลือกเนื้อสี Choose hue ในการเลือกเนื้อสีมาใช้งานโดยเลือกจาก 
   - ความหมายของเนื้อสีแต่ละสี เช่น สีน้ าเงิน จะนึกถึงสิ่งใหม่ ๆ ความทันสมัย 
   - เลือกเนื้อสีที่อยู่ด้วยกันแล้วดูดีเหมาะสม และค านึงถึงผู้ใช้งาน เช่น ถ้าออกแบบงาน
ที่ใช้กับเด็ก ควรเลือกใช้แม่สี เพ่ือให้เด็กสังเกตเห็นได้ชัดและรับรู้ได้ง่าย 
  2) การเลือกน้ าหนักสี Choose Value ในการเลือกน้ าหนักสีจะเป็นขั้นตอนต่อจากที่เรา
ได้เลือกสีแล้ว น้ าหนักของสีมีอิทธิพลต่อความมืดสว่างในภาพ ซึ่งให้อารมณ์ของภาพที่แตกต่างกันไป เช่น ใน
งานออกแบบนี้เลือกใช้สีฟ้าบ่งบอกถึงความโล่ง ความสบาย  
  3) การเลือกความสดของสี Choose Saturation การเลือกความสดของสีเป็นเรื่องสุดท้าย
ในการเลือกสี การออกแบบงานสีที่มีความสดสูงจะให้ความรู้สึกรุนแรง ตื่นตัวสะดุดตา ในขณะที่สีที่มีความสด
น้อยหรือสีหม่น จะให้ความรู้สึกสงบ ไม่โดดเด่น ถ้าสีที่มีความสดอยู่ในระดับกลางจะให้ความรู้สึกผ่อนคลาย 

3.1.5.6 ความหมายของส ี
1) สีแดง อ้างอิงมาจากไฟ ให้คามรู้สึกอารมณ์ของความร้อน พลัง ความแรงและเป็น

ความมงคลตามความเชื่อของชาวจีน 
2) สีเหลือง ให้ความรู้สึกถึงความสดใส ปลอดโปร่ง ดึงดูดสายตา 
3) สีน้ าเงิน ให้ความรู้สึกสงบเรียบ สุขุม มีราคา หรูหรา บางครั้งสื่อถึงความสุภาพ หนัก

แน่น 
4) สีส้ม ให้ความรู้สึกดึงดูด ทันสมัย สดใส กระฉับกระเฉง มีพลัง 
5) สีม่วง ให้อารมณ์หนักแน่น มีเสน่ห์ ความลับ สิ่งที่ปกปิด 
6) สีเขียว ให้ความรู้สึกสดชื่น ธรรมชาติ เย็นสบาย 
7) สีชมพู ให้ความรู้สึกอ่อนหวาน นุ่มนวล ความรัก วัยรุ่น 
8) สีน้ าตาล ให้ความรู้สึกสงบ ความเรียบ ความเป็นผู้ใหญ่ ความเก่าแก่โบราณ  
9) สีฟ้า ให้ความรู้สึกโปร่งโล่งสบายตา นุ่มนวล สุขสบาย 
10) สีเงิน ให้ความรู้สึกถึงสิ่งใหม่ ๆ ทันสมัย มีคุณค่า มีราคา 
11) สีทอง ให้ความรู้สึกเป็นตัวแทนของความมีคุณค่า ความหรูหรา ราคาแพง 
12) สีขาว ให้ความรู้สึกถึงความบริสุทธิ์ สะอาดเรียบง่าย ความโล่ง ความว่างเปล่า 
13) สีเทา ให้ความรู้สึกเศร้า หม่นหมองไร้ชีวิตชีวา บางครั้งสื่อถึงความเป็นกลาง 
14) สีด า ให้ความรู้สึกน่ากลัว บางครั้ง อาจใช้สีด าหรือสีเข้ม เพ่ือเน้นขับสิ่งทีอยู่ภายในให้

เด่นชัด มักนิยมใช้เป็นสีพ้ืน (อิมรอน แวมง, 2563) 
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3.1.6  โปรแกรมคอมพิวเตอร์ที่ใช้ในการจัดท าจดหมายข่าว 
  ในการจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ได้มีการน าโปรแกรม
คอมพิวเตอร์ส าเร็จรูปมาช่วยในการจัดหน้าสิ่งพิมพ์เพ่ือใช้เป็นต้นฉบับ ตามที่ได้ก าหนดและวางแผนการ
ออกแบบจดหมายข่าว ดังนี้ 
  3.1.6.1 โปรแกรม Microsoft Office Word         เป็นโปรแกรมพ้ืนฐานที่นักเขียนนิยมใช้ ใน
การจัดท าจดหมายข่าวสภามหาวิทยาลัยฯ มักนิยมใช้โปรแกรม  Microsoft Office Word ในการเตรียม
ต้นฉบับในส่วนที่เป็นข้อมูลตัวหนังสือ ก่อนที่จะน าไปประกอบหน้าในโปรแกรมส าหรับการจัดหน้า ซึ่ง
โปรแกรมไมโครซอฟต์เวิร์ดมีความสามารถหลากหลายในการท างานดังนี้ จัดรูปแบบอักษรได้โดยอัตโนมัติ 
สามารถตรวจหาค าผิดและแก้ไขค าผิดได้โดยอัตโนมัติ สามารถประดิษฐ์ตกแต่งตัวอักษรได้หลายรูปแบบโดย
การใช้เวิร์ดอาร์ต (WordArt) การแก้ไขรูปภาพและน ามาประกอบในข้อความได้ สามารถใช้โปรแกรมค านวน
และสูตรทางคณิศาสตร์ได้ 
 3.1.6.2 โปรแกรม Adobe Photoshop        เป็นโปรแกรมส าหรับในการตกแต่งภาพที่เป็นที่
นิยมใช้มากที่สุดสามารถแก้ไขตกแต่งภาพที่มาจากการสแกน จากการถ่ายด้วยกล้องดิจิตอล และสามารถเปิด
ไฟล์และเก็บบันทึกข้อมูลไฟล์ได้หลายหลายรูปแบบ เช่น PICT, TIFF, BMP, JPG, GIF ซึ่งไฟล์ต่าง ๆ เหล่านี้
สามารถดึงเข้าสู่โปรแกรมจัดหน้าได้โดยง่าย นอกจากนั้นโปรแกรม Adobe Photoshop ยังสามารถแก้ไขสี
ของภาพ ความคมชัด และสามารถสร้างภาพและตัวอักษรได้หลากหลายรูปแบบ หรือที่เรียกว่าการใส่เอฟ
เฟ็กต์ (Effect) ให้ภาพ ในการสร้างภาพ หรือภาพพ้ืนหลังโดยการใช้โปรแกรม Adobe Photoshop แล้วน าไป
ประกอบการจัดหน้าในโปรแกรมส าหรับจัดหน้า สุดท้ายหลังจากท่ีได้ท าการออกแบบไฟล์ภาพต้นฉบับแล้ว ยัง
สามารถส่งไฟล์ภาพที่เป็น .PSD  (ไฟล์ภาพเฉพาะของ Photoshop) หรือ ไฟล์ .TIFF ไปให้โรงพิมพ์ได้ด้วยการ
บันทึก (save) แบบรวมเลเยอร์ไปเพื่อเป็นการป้องกันผู้อื่นน าผลงานของเราไปดัดแปลงได้อีกด้วย 
 3.1.6.3 โปรแกรม Adobe InDesign          เป็นโปรแกรมที่เหมาะกับงานประเภทจัดหน้า
หนังสือหรืองานสิ่งพิมพ์บางชนิด การท างานคล้ายกับโปรแกรม PageMaker และ Illustrator มารวมกัน 
ส าหรับข้อดีของโปรแกรม Adobe InDesign คือมีการพัฒนาให้รองรับการวาดภาพและเทคโนโลยีใหม่ ๆ ได้
ดีกว่า และในการออกแบบสิ่งพิมพ์ดิจิตอลในปัจจุบันนิยมใช้  InDesign ในการออกแบบมากเพราะมีค าสั่งและ
เครื่องมือที่รองรับการออกแบบสิ่งพิมพ์ดิจิตอลได้อย่างดี  โดยเฉพาะวิธีการส่งไฟล์ต้นฉบับของโปรแกรมนี้  
สะดวกมากเพราะมีค าสั่ง Package  ส าหรับการรวบรวมไฟล์ทีเกี่ยวข้องกับงานชิ้นที่ต้องการ ตั้งแต่ไฟล์ภาพ
และตัวอักษรที่ต้องมารวมในไฟล์ตัวเดียวกัน  และท าการบันทึกข้อมูลต้นฉบับและส่งโรงพิมพ์ได้ทันที โดยไม่
ต้องกังวลว่าจะลืมไฟล์ที่จ าเป็น (จินตนา ถ้ าแก้ว, 2555) 
 1) การใช้โปรแกรม Adobe Indesign ขั้นตอนนี้เป็นการด าเนินงานในการจัดท า
จดหมายข่าวสภามหาวิทยาลัยฯ ตามที่ได้รับการก าหนดรูปแบบจากการร่าง (Sketch) แบบดัมมี่ไว้เป็นที่
เรียบร้อยแล้วในขั้นตอนที่ 4.2.3  ซึ่งในขั้นตอนนี้จะเป็นการแนะน าการใช้ค าสั่งและเครื่องมือต่างๆ ที่ใช้จัดท า
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รูปเล่มของจดหมายข่าวสภามหาวิทยาลัยฯ ในโปรแกรม Adobe InDesign เบื้องต้น ซึ่งมีขั้นตอนการ
ปฏิบัติงานดังนี้ 
   1.1) ส่วนประกอบของโปรแกรม Adobe InDesign  มีการจัดวางแถบเครื่องมือที่
ช่วยอ านวยความสะดวกในการท างานด้านการออกแบบ ดังนี้ (กชพร นวส าเภาเงิน, 2559) 
 

 
 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 3-6 แสดงหน้าต่างการท างานของโปรแกรม Adobe InDesign 
    
    Menu Bar : แถบเมนูค าสั่งหลัก 
    Option Bar : แถบแสดงรายละเอียดค าสั่งเสริม 
    Tool Box : กล่องเครื่องมือ 
    Pasteboard : พ้ืนทีก่ารท างาน 
    Status Bar : แถบแสดงสถานะการท างาน 
    Panels : หน้าต่างแสดงรายละเอียดค าสั่งต่าง ๆ 
 
   1.2) Menu Bar แถบเมนูค าสั่งหลัก เป็นเมนูที่รวบรวมค าสั่งหลักในการท างาน
ทั้งหมดของโปรแกรม โดยแต่ละเมนูจะมีค าสั่งที่แตกต่างกันออกไป  ดังนี้ 
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           Restore : ใช้ปรับขนาหน้าต่างของโปรแกรม 
    Move  : ใช้ส าหรับเคลื่อนย้ายโปรแกรม ใช้เมื่อโปรแกรมถูกย่อส่วน 
    Size : ใช้ส าหรับปรับขนาดหน้าต่างโปรแกรม 
    Minize  : ใช้ส าหรับย่อหน้าต่างโปรแกรมลงไปที่ไอคอนของโปรแกรม 
    Close : ใช้ส าหรับค าสั่งให้ปิดโปรแกรม 
 
 
 File   : เมนูค าสั่งส าหรับจัดการไฟล์เอกสาร เช่น การสร้างไฟล์งานใหม่ การบันทึกไฟล์ การตั้งค่า    

หน้ากระดาษ เป็นต้น 
 Edit   : เมนูค าสั่งส าหรับการแก้ไข คัดลอกส าเนางาน รวมถึงค าสั่งที่มีผลกับทุกๆ ไฟล์ 
 Layout  : เมนูค าสั่งที่ใช้ในการจัดไฟล์งาน 
 Type   : เมนูค าสั่งที่ใช้จัดการกับตัวอักษร 
 Object  : เมนูค าสั่งที่ใช้จัดการกับวัตถุ 
 Table   : เมนูค าสั่งที่ใช้ในการสร้างและปรับแต่งตาราง 
 View   : เมนูค าสั่งที่ใช้ในการปรับเปลี่ยน และย่อ-ขยายมุมมอง 
 Window : เมนูค าสั่งที่ใช้ในการจัดการหน้าต่างและพาเนล (Panels) ของโปรแกรม 
 Help   : เมนูค าสั่งที่ใช้ในการแนะน าและช่วยเหลือเกี่ยวกับการใช้โปรแกรม 
 

 
   Adobe Bridge : เป็นศูนย์กลางจัดการไฟล์ที่ใช้ในโปรแกรมกราฟิก 3 โปรแกรม คือ 

Photoshop, Illustrator และ InDesign และสามารถปรับแต่งรูปภาพ
ให้สมบูรณ์ก่อนน าไปใช้ด้วย Camera Raw ทั้งนี้ยังมีลูกเล่น อีก
มากมายให้ได้ลองใช้กัน 

  Zoom Level : ปุ่มแสดงระดับมุมมองของหน้าจอ 

  View Option : ปุ่มแสดงมุมมองการท างานของ Frame Edges, Rulers, Guides,  
    Smart  Guides, Baseline Grid และ Hiden Characters 

  Screen Mode : ปุ่มเปลี่ยนโหมดการแสดงผลหน้าจอการท างานของ narmal,  
    preview,    bleed, slug และ presentation 

  Arrange Documents  : ปุ่มที่ใช้ในการจัดเรียงไฟล์งานที่เปิดใช้ 
  Workspace : ปุ่มจัดแถบเครื่องมือเพ่ือให้เหมาะสมกับพ้ืนที่การท างาน 
  Help Menu  : ปุ่มแนะน าและช่วยเหลือการใช้งานโปรแกรม 
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    1.3)  Toolbox กล่องเครื่องมือ เป็นเครื่องมือต่างๆ ที่ถูกใช้งานบ่อย โดยมี
สัญลักษณ์ของเครื่องมือที่สื่อความหมายในการใช้งาน และเพ่ือให้ใช้งานง่าย โดย Toolbox ยังแบ่งกลุ่ม
เครื่องมือการท างานประเภทเดียวกันไว้เป็นชุด ซึ่งแต่ละเครื่องมือจะมีคีย์ลัด (Shotcuts) ท าให้สะดวกและ
รวดเร็วในการเรียกใช้งาน 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    ในกล่องเครื่องมือ Toolbox นั้นประกอบไปด้วยเครื่องมือต่าง ๆ และเครื่องมือ
บางชนิดนั้นยังมีค าสั่งซ่อนอยู่อีก ดังนี้ 
   กลุ่มเครื่องมือ Selection Tools ใช้เลือกวัตถุ ประกอบด้วย 

Selection Tool (คีย์ลัด V) ส าหรับเลือกวัตถุทั้งหมด 
 Direct Selection Tool (คีย์ลัด  A) ส าหรับเลือกจุดบนเส้น Path 
 Page Tool (คีย์ลัด Shift+P) ส าหรับสร้างขนาดหน้าเอกสาร 
 Gap Tools (คีย์ลัด U) ส าหรับปรับช่องว่างระหว่างวัตถุ 
 Content Collector Tool (คีย์ลัด B) ส าหรับเลือกเก็บชิ้นส่วนของเนื้อหา

ไว้ใช้ในงานต่อไป 
  Content placer Tool (คีย์ลัด B) ส าหรับวางชิ้นส่วนของเนื้อหาที่เก็บไว้ 

1. กลุ่ม Selection Tool ส าหรับเลือกวัตถุ 

2. กลุ่มDrawing Tool & 
Type Tools ส าหรับสร้าง
ตัวอักษร วาดภาพ และสร้าง

3. กลุ่ม Tranformation Tools 
ส าหรับปรับแต่งวัตถุและไล่โทนส ี

4. กลุ่ม Modification & 
Navigation Tools ส าหรับ
ปรับเปลี่ยนวัตถุและปรับ
มุมมอง 

5. กลุ่ม Fill & Stroke Color 
Tools ส าหรับปรับแต่งสีวัตถุหรือ
ข้อความ 

6.  กลุ่ม View Mode 
Tools ส าหรับปรับมุมมอง
หน้าต่างโปรแกรม 
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   กลุ่มเครื่องมือ Drawing Tools & Type Tools ใช้สร้างตัวอักษร วาดภาพ และ
สร้างรูปทรง 

 Type Tool (คีย์ลัด T) ส าหรับใช้สร้างตัวอักษร 
   Type on a Path Tool (คีย์ลัด Shift+T) ใช้สร้าง 
    ตัวอักษรให้วิ่งตามวัตถุที่ก าหนด 
  
 Line Tool (คีย์ลัด \) ใช้สร้างเส้นตรง 
Pan Tool (คีย์ลัด P) ใช้ส าหรับวาดรูปทรงของเส้น Path ที่ก าหนดการวาด
ด้วยจุด Anchor 
  Add Anchor Point Tool (คีย์ลัด =) ใช้เพิ่มจุด 
  Delete Anchor Point Tool (คีย์ลัด -) ใช้ลบจุด 
  Convert Direct Point Tool (คีย์ลัดshift+C) ใช้

ปรับแนวเส้นจุด   
Pencil  Tool (คีย์ลัด N) ใช้วาดรูปแบบอิสระ      
 Smooth Tool (คีย์ลัด N) ใช้แต่งเส้น Path ให้โค้งเนียนเรียบ 
 Erase Tool (คีย์ลัด N) ใช้ลบเส้น Path ให้เป็นเส้นเปิด 
Rectangle Frame Tool (คีย์ลัด F) ใช้สร้างเฟรมสี่เหลี่ยมไว้ใส่ภาพหรือ
ตัวอักษร 

Ellipase Frame Tool (คีย์ลัด F) ใช้สร้างเฟรมวงกลมไว้ใส่
ภาพหรือตัวอักษร 

  Polygon Frame Tool (คีย์ลัด F) ใช้สร้างเฟรมหรือกรอบที่
ไม่มีเหลี่ยม 

Rectangle Tool (คีย์ลัด M) ใช้สร้างรูปทรงสี่เหลี่ยม 
  Ellipse Tool (คีย์ลัด L) ใช้สร้างรูปทรงวงกลม 
   Polygon Tool ใช้สร้างรูปทรงที่มีเหลี่ยมตามที่ก าหนด 
 

  กลุ่ม Tranformation Tools ใช้ปรับแต่งวัตถุและไล่โทนสี 
Scissors Tool (คีย์ลัด S) ใชต้ัดเส้น Path ที่จุด Anchor ให้แยกจากกัน 
Free Transform Tool (คีย์ลัด E) ใช้คลิกเลือกวัตถุให้ ย้าย หมุน เอียง 

Rotate Tool  (คีย์ลัด R)  ใช้หมุนวัตถุ โดยยึดต าแหน่งเดิม 
 Scale Tool (คีย์ลัด S) ใช้ย่อและขยายวัตถุ  
 Shear Tool (คีย์ลัด O) ใช้บิดเอียงวัตถุ 
Gradient Swatch Tool  (คีย์ลัด G)  ใช้ไล่โทนส ี
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Gradient Feather Tool (คีย์ลัดShift + G) ใช้ Fade วัตถุให้จางหาย 
 

     กลุ่ม Modification & Navigation Tools ใช้ปรับเปลี่ยนวตัถุและปรับมุมมอง  
 Note Tool ใช้บันทึกข้อความไว้ดู 
 Eyedropper Tool (คีย์ลัด I) ใช้เก็บค่าสีจากวัตถุอ่ืนมาใส่ในวัตถุท่ีต้องการ 
 Measure Tool (คีย์ลัด K) ใช้วัดขนาดวัตถุ 
 Hand Tool (คีย์ลัด H) ใช้ย้ายมุมมองตามต าแหน่งต้องการ หรือแสดงให้  
เห็นหน้างานทั้งหมด 
 Zoom Tool (คีย์ลัด Z) ใช้ย่อและขยาย มุมมอง 
 

     กลุ่ม Fill & Stroke Color Tools ใช้ปรับแต่งสีวัตถุหรือข้อความ 
 Fill Box Tool (คีย์ลัด X) ใช้ใส่สีพื้น 
  Stoke Box Tool (คีย์ลัด X) ใช้ใส่สีเส้นขอบ 
  Swap Fill & Stoke Tool (คีย์ลัด Shift+X) ใช้สลับโทนสีระหว่าง 

Fill กับ Stoke 
  Default Fill & Stoke Tool (คีย์ลัด D) ใช้ตั้งค่าสีให้กลับสู่ค่าปกติ 
Formatting affects Container Tool (คีย์ลัด J) ใช้จัดรูปแบบการใส่สีที่มี
ผลต่อเฟรมของข้อความ 
Formatting affects Text Tool (คีย์ลัด J)  ใช้จัดรูปแบบการใส่สีที่มีผลต่อ
ข้อความในเฟรม 
Apply Color Tool (คีย์ลัด ,) ใช้เลือกใส่สีที่เลือกในวัตถุครั้งแรก 
  Apply Gradient Tool ใช้เลือกใส่สี Gradient ในวัตถุครั้งแรก 
  Apply None Tool (คีย์ลัด Num/, /) ใช้ยกเลิกการใช้งานสี 
 

      กลุ่ม View Mode Tools ใช้ปรับมุมมองหน้าต่าง 
Normal Tool (คีย์ลัด W) เป็นโหมดแสดงหน้าต่างการท างานแบบปกติ ซึ่ง
จะแสดงเส้นกริด,เส้นไกด์, และพ้ืนที่การใช้งานทั้งหมด 
Preview Tool (คีย์ลัด W) เป็นโหมดแสดงหน้าต่างการท างานที่แสดง
เหมือนจริงก่อนพิมพ์ 
Bleed Tool (คีย์ลัด W) เป็นโหมดแสดงหน้าต่างการท างานที่เหมือนจริง
ก่อนพิมพ์ โดยจะแสดงเส้นขอบกระดาษที่ใช้ส าหรับตัดตกด้วย 



 
 

 

35 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

Slug Tool (คีย์ลัด W) เป็นโหมดแสดงหน้าต่างการท างานที่เหมือนจริงก่อน
พิมพ์ 
Presentation Tool (คีย์ลัด Shift+W) เป็นโหมดน าเสนองานบนหน้าจอ 
Monitor 

     1.4) Pasteboard พ้ืนที่การท างาน เป็นพ้ืนที่ในการท างานทั้งหมด ประกอบไปด้วย
พ้ืนที่ว่างรอบกระดาษ (Spread) และหน้ากระดาษ (Page) ดังแสดงภาพที่ 3-7 
 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 3-7  แสดงพ้ืนที่การท างานของโปรแกรม Adobe InDesign 

   1.5) Statue Bar  แถบแสดงสถานะการท างาน เป็นแถบส าหรับแสดงสถานะการ
ท างานของไฟล์งานที่ท าอยู่ เช่น บอกหน้าที่ก าลังท างานอยู่ การเลือกเปิดไปยังหน้าที่ต้องการ การแสดง
ข้อผิดพลาดของไฟล์ในการท างาน เป็นต้น ดังแสดงภาพที่ 3-8 
 
 
 
 
 
 
 

 
ภาพที่ 3-8 แสดงตัวอย่างสถานะการท างาน Status Bar 

   พ้ืนที่ว่างรอบกระดาษ 

(Spread) ใช้วางงานที่ยัง

ไม่ได้ใช้วัตถุท่ีอยู่ใน

บริเวณนี้จะไม่ถูก

น าออกไปทันที 

หนา้กระดาษ (Page) ใชส้  าหรบัสรา้งงาน 

แสดงเลขหน้าที่ท าในปัจจุบัน และสามารถเลือกหน้าที่ต้องการ 
หรือเลือกไปที่หน้า Master Page ที่ท าไว้ 

Open แสดงการเก็บไฟลง์าน 

Preflight แสดงขอ้ผิดพลาดของไฟล ์(Error)  
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   1.6)  Panels  หน้าต่างแสดงรายละเอียดค าสั่งต่าง ๆ เป็นกลุ่มค าสั่งที่ใช้ปรับแต่ง
คุณสมบัติเพิ่มเติมให้กับค าสั่งที่ได้ใช้ในการสร้างชิ้นงานขึ้น เช่น ค าสั่งการเพ่ิมหน้า หรือ ลดหน้า ค าสั่งการเติม
สีและปรับขนาดเส้น ค าสั่งการจัดล าดับเลเยอร์ เป็นต้น 
        โดยสามารถปรับแต่งชุดค าสั่ง Panels แถบเครื่องมือ เพ่ือให้เหมาะสมกับ
พ้ืนที่การท างาน เข้าไปที่เมนู Window > Workspace หรือเข้าไปที่ Menu Bar > Workspace มีรายละเอียด
ดังนี้ 

 Advanced เป็นการแสดงรูปแบบการท างานส าหรับมืออาชีพ ดังแสดงภาพที่ 
3-9 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-9  แสดงค าสั่งรูปแบบส าหรับมืออาชีพ 
   Book  เป็นการแสดงรูปแบบการท างานส าหรับงานจัดหนังสือ ดังแสดงภาพที่ 3-10 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-10  แสดงรูปแบบการท างานส าหรับงานจัดหนังสือ 
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Digital Publishing  เป็นการแสดงรูปแบบการท างานส าหรับงานเอกสารดิจิตอล 
ดังแสดงภาพที่ 3-11 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 3-11  แสดงรูปแบบการท างานส าหรับงานเอกสารดิจิตอล 

 
Essentials เป็นการแสดงรูปแบบการท างานแบบพ้ืนฐาน ดังแสดงภาพที่ 3-12 

 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 3-12  การแสดงรูปแบบการท างานแบบพ้ืนฐาน 

 
Interactive for PDF เป็นการแสดงรูปแบบการท างานส าหรับ PDF ดังแสดงภาพที่ 

3-13 
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ภาพที่ 3-13  แสดงรูปแบบการท างานส าหรับ PDF 
 

Printing and Proofing เป็นการแสดงรูปแบบการท างานส าหรับงานโรงพิมพ์ ดัง
แสดงภาพที่ 3-14 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 3-14  แสดงรูปแบบการท างานส าหรับงานโรงพิมพ์ 

 
Typography เป็นการแสดงรูปแบบการท างานส าหรับงานเอกสารที่ใช้ตัวหนังสือ 

ดังแสดงภาพที่ 3-15 
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ภาพที่ 3-15  แสดงรูปแบบการท างานส าหรับเอกสารที่ใช้ตัวหนังสือ 
    
   1.7) เครื่องมือส าหรับ Undo/Redo ในโปรแกรม InDesign มีจุดเด่นที่ส าคัญในการ
ใช้งานเหมือนกับโปรแกรม Microsoft Office Word ซึ่งหากเกิดข้อผิดพลาดขึ้นสามารถย้อนกลับการท างาน
ไป Undo หรือ ท าซ้ าอีกครั้ง Redo ได้จนถึงขั้นตอนก่อนการผิดพลาดที่เกิดขึ้นกับไฟล์งานนั้น ๆ   
    คลิกเลือกค าสั่ง Edit > Undo คีย์ลัด Ctrl + Z เพ่ือให้โปรแกรมย้อนกลับไปยัง
ไฟล์ที่เคยท าไว้ก่อนหน้านี้ ดังภาพแสดงที่ 3-16  
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-16  แสดงค าสั่ง Undo ในโปรแกรม Adobe InDesign 
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    คลิกเลือกค าสั่ง Edit > Redo คีย์ลัด Ctrl + Shift + Z เพ่ือให้โปรแกรมท าซ้ า
ไฟล์ที่เคยท ามาก่อนที่จะมีการแก้ไขด้วยค าสั่ง Undo ซึ่งค าสั่ง Redo จะปรากฎเมื่อมีการใช้ค าสั่ง Undo ก่อน 
ดังภาพแสดงที่ 3-17 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-17  แสดงค าสั่ง Redo ในโปรแกรม Adobe InDesign  
 

   1.8) เครื่องมือ Paste Tool เป็นเครื่องมือที่ใช้ในการวางภาพ หรือข้อความที่
ต้องการ ซึ่งค าสั่ง Paste นั้นจะใช้งานร่วมกับค าสั่ง Copy หรือ Cut โดยมีรูปแบบการท างานอยู่ 4 รูปแบบ 
ดังนี้ 
    Paste เป็นค าสั่งที่ใช้วางสิ่งที่ Copy หรือ Cut มาแบบธรรมดา เมื่อท าการวาง
ภาพ หรือข้อความจะถูกวางไว้ที่กลางหน้าจอ โดยคลิกเลือกค าสั่ง Edit > Paste (Ctrl + V) เพ่ือวางสิ่งที่ 
Copy หรือ Cut มา ดังภาพแสดงที่ 3-18 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-18  แสดงค าสั่ง Paste ในโปรแกรม Adobe InDesign 
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    Paste Without Formatting เป็นค าสั่ งที่ ใช้ ในการวางข้อความ เ พ่ือให้
ข้อความที่ได้ใช้รูปแบบเหมือนตัวอักษรที่น าไปวาง  และจะต้องใช้เครื่องมือ (Type Tool) ในการวางเท่านั้น 
โดยคลิกเมาส์ขวา เพ่ือ Copy ข้อความที่ต้องการ จากนั้นเลือกต าแหน่งที่ต้องการวางข้อความ และคลิกเมาส์
ขวา เลือกค าสั่ง Paste without Formatting (คีย์ลัด Shift + Ctrl + V) ซึ่งข้อความที่ได้เลือกมาจะถูกเปลี่ยน
รูปแบบ Font ให้เหมือนกับข้อความที่อยู่ด้านหน้า ดังแสดงภาพที่ 3-19 
 
 
 
 
 
 
 

 
ภาพที่ 3-19  แสดงการใช้ค าสั่ง Paste without Formatting ในโปรแกรม Adobe InDesign 

    Paste Into เป็นค าสั่งที่ใช้กับรูปภาพเท่านั้น เพ่ือให้รูปที่ Copy หรือ Cut มา
นั้นอยู่ใน Frame ที่ต้องการ โดยการสร้างรูปแบบ Frame ที่ต้องการ น าภาพวางบน Frame เพ่ือหาต าแหน่งที่
ต้องการ จากนั้นคลิกเมาส์ขวา เลือกค าสั่ง Cut หรือ Copy ก็ได้ แล้วคลิกเมาส์ขวาเลือกค าสั่ง Paste Into 
(Ctrl + Alt + V)  ภาพจะถูกวางลงใน Frame ที่ต้องการ ดังแสดงภาพที่ 3-20 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-20  แสดงการใช้ค าสั่ง Paste Into ในโปรแกรม Adobe InDesign 
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   1.9)  เครื่องมือตั้งค่าหน่วยวัดและระยะ  
    Ruler  Tool เป็นเครื่องมือที่ใช้ในการจัดวางต าแหน่ง หรือวัดระยะของวัตถุ 
ซึ่งสามารถเลือกประเภทของหน่วยวัดให้เหมาะสมกับงานได้ โดยใช้ค าสั่งคีย์ลัด (Ctrl + R)  
    ประเภทของหน่วยวัด 
    Points  หน่วยวัดขนาดตัวอักษรที่ใช้ในการพิมพ์ 
    Picas   หน่วยวัดความกว้าง/ยาว นิยมใช้วัดขนาดตัวอักษร 
    Inches  หน่วยวัดความกว้าง/ยาว แบบเศษส่วน 
    Inches Decimal หน่วยวัดความกว้าง/ะยาว แบบทศนิยม 
    Millimeters หน่วยวัดความกว้าง/ยาว ตัวย่อคือ mm. 
    Centimeters หน่วยวัดความกว้าง/ยาว ตัวย่อคือ cm. นิยมใช้ในประเทศไทย 
    Ciceros  หน่วยวัดความกว้าง/ยาว นิยมใช้ในแถบทวีปยุโรป 
    Agates  หน่วยวัดการพิมพ์ นิยมใช้ในวงการหนังสือพิมพ์ 
    Pixels   หน่วยวัดค่าความละเอียดของ Raster Graphic 
    Custom  เลือกก าหนดขนาดหน่วยวัดเองได้ 
      เครื่องมือบอกพิกัดเริ่มต้น เป็นเครื่องมือที่ใช้บอกพิกัดเริ่มต้นของไม้บรรทัดที่
จุดศูนย์ ทั้งแนวตั้งและแนวนอน สามารถย้ายและล๊อคต าแหน่งได้ ซึ่งการก าหนดต าแหน่งพิกัดได้ดังนี้ 
       Ruler Per Page พิกัดเริ่มต้นที่มุมบนด้านซ้าย และสิ้นสุดที่มุมบนด้านขวา
ของทุก Page Size 
      Ruler Per Spread พิกัดเริ่มต้นที่มุมบนด้านซ้ายของ Page Size และสิ้นสุด
ที่มุมบนด้านขวาของ Spread 
      Ruler On Spine พิกัดเริ่มต้นท่ีแกนกลางของ Page Size และสิ้นสุดที่มุมบน
ด้านซ้ายและขวาของ Spread ดังแสดงภาพที่ 3-21 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-21  แสดงการท างานเครื่องมือ Ruler Tool ในโปรแกรม Adobe InDesign 

คลิกเมาส์ขวาบน

แถบไม่บรรทัด เพื่อ

เลือกหน่วยวัด 

ประเภทของหนว่ยวดั 

เครื่องมือบอกพิกัดเริ่มต้น 
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   1.10)  เครื่องมือ Guides Tool เป็นเครื่องมือที่ใช้วัดต าแหน่งหรือระยะการจัดวาง
วัตถุ ตามแนวเส้นทั้งแนวตั้งและแนวนอน ซึ่งเส้นที่ใช้งานนี้จะไม่ปรากฎบนหน้างานพิมพ์ มีรูปแบบการใช้งาน 
ดังนี้     
    Margin Guide เส้นไกด์ก าหนดระยะห่างขอบด้านบน ด้านล่าง ด้านซ้าย 
ด้านขวา 
 
 
 
 
 
 
 
    Colum Guide เส้นไกด์ ใช้ส าหรับแบ่ งช่องคอลัมน์  โดยการคลิกเลือก 
Layout > Margins and Columns ปรากฎค าสั่งในการก าหนด จ านวนเส้นคอลัมน์  
 
 
 
 
 
 
   1.11)  Smart Guide เส้นไกด์อัจฉริยะ ใช้ในการบอกระยะการจัดวางต าแหน่งวัตถุ 
ซึ่งจะปรากฎเมื่อมีการคลิกเมาส์ลากวัตถุ โดยคลิกเลือก View > Grids & Guide > Smart Guide ซึ่งเมื่อมี
การคลิกเมาส์ลากวัตถุ จะปรากฎเส้นบอกระยะ ดังแสดงภาพที่ 3-22 
 
 
 
 
 
 

 
 

ภาพที่ 3-22  แสดงการท างานของค าสั่ง Smart Guide 

คลกิเลอืก Layout> Margins and Columns 
ก าหนดระยะหา่งของขอบหนา้งาน 

ก าหนดจ านวนเสน้คอลมัน ์
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   1.12)  ก าหนดคอลัมน์ลงในหน้ากระดาษ  
    คอลัมน์ (Columns) คือ การแบ่งสัดส่วนการจัดหน้ากระดาษมีขั้นตอน
ดังต่อไปนี้ โดยเลือกหน้ากระดาษที่ต้องการแบ่งคอลัมน์ให้เข้าไปที่เมนู Layout > Margins and Columns 
จะปรากฎหน้าต่างค าสั่งขึ้นมา ดังภาพแสดงที่ 3-23 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-23 แสดงค าสั่งการก าหนดคอลัมน์ในหน้ากระดาษ 
 
     การแก้ ไขจ านวนคอลั มน์  ให้ เ ข้ า ไปที่ เ มนู  Layout > Margins and 
Columns หากมีการเคลื่อนย้ายเส้นไกด์ ในช่อง Number จะขึ้นข้อความว่า “Custom” ซึ่งเมื่อต้องการ
ยกเลิกการแบ่งคอลัมน์ให้ใส่จ านวนตัวเลขในช่อง Number = 1 
     การเพ่ิมคอลัมน์และแถวพร้อมกัน ทั้งแนวตั้งและแนวนอน ซึ่งการก าหนด
จ านวนและระยะห่างระหว่างช่องคอลัมน์พร้อมกันสามารถก าหนดได้ โดยเข้าไปที่เมนู Layout > Margins 
and Columns ท าการก าหนดจ านวนระยะระหว่างคอลัมน์  และก าหนดจ านวนระยะระหว่างแถว  ดังแสดง
ภาพที่ 3-24 
 
 
 
 
 
 
 
 

ภาพที่ 3-24  แสดงค าสั่งการเพ่ิมคอลัมน์และแถวพร้อมกัน 

คลิกปุ่ม 

ก าหนดจ านวนคอลัมน์ ก าหนดระยะห่างระหว่าง

ก าหนดจ านวน
และระยะ
ระหว่างคอลัมน์ 

ก าหนดจ านวน
และระยะ
ระหว่างแถว 

คลิกปุ่ม OK 
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     ส าหรับเส้นไกด์ที่แบ่งระยะของคอลัมน์ และแถวสามารถแก้ไขด้วยการย้าย 
หรือลากเมาส์ครอบทั้งหมดเพ่ือลบทิ้งได้ 
     การล็อคและปลดล็อคเส้นแบ่งคอลัมน์ เมื่อต้องการจะเคลื่อนย้ายเส้นแบ่ง
คอลัมน์ที่ล็อคไว้ สามารถท าได้ 2 วิธี คือ 1. คลิกเมาส์ขวาบนพ้ืนที่ท างาน โดยเลือก Guide & Guide > Lock 
Column Guide หรือ 2. เข้าไปที่เมนู View > Grids & Guides > Lock Column Guides 
   1.13)  การลบเส้นไกด์ ที่ลากเพ่ิมเข้ามาในพ้ืนที่ท างาน หากมีมากเกินไปอาจท าให้
เกะกะสายตา ซึ่งสามารถท าการลบเส้นไกด์ได้ 3 รูปแบบ ดังนี้ 
     การลบเส้นไกด์ครั้งละ 1 เส้น สามารถท าได้โดยใช้เครื่องมือ        Selection 
Tool คลิกเมาส์ซ้ายเลือกเส้นไกด์ ซึ่งเส้นไกด์ที่ถูกคลิกเลือกจะเปลี่ยนเป็นสีเข้มขึ้น จากนั้นกดปุ่ม Delete หรือ
ใช้เครื่องมือ Selection Tool ลากค้างกลับไปท่ีไม้บรรทัดก็ได้เช่นกัน 
     การลบเส้นไกด์ครั้งละหลายเส้น ตามจ านวนที่ต้องการสามารถท าได้โดยใช้
เครื่องมือ        Selection Tool คลิกเมาส์ซ้ายลากครอบเส้นไกด์ที่จะลบ เส้นไกด์ที่ถูกเลือกจะเปลี่ยนเป็นสี
เข้ม จากนั้นกดปุ่ม Delete เพ่ือลบเส้นไกด์ 
     การลบเส้นไกด์ทั้งหมด ในหน้ากระดาษที่ใช้งาน ซึ่งหน้ากระดาษอ่ืนๆ จะไม่
ถูกลบไปด้วย สามารถท าได้ โดยคลิกเมาส์ขวาบนพ้ืนที่ว่างที่ท างาน จากนั้นเลือกค าสั่ง Grids & Guides > 
Delete All Guides on Spread หรือ เลือกเมนู View > Grids & Guides > Delete All Guides on Spread 
   1.14)  การซ่อนเส้นไกด์ เหมาะส าหรับงานที่มีเส้นไกด์เป็นจ านวนหลายเส้น แต่ไม่
อยากลบเส้นไกด์ทิ้ง เป็นการปิดไม่ให้แสดงเส้นไกด์ทั้งหมดในพื้นที่ท างานชั่วคราว สามารถท าได้โดยคลิกเมาส์
ขวาบนพื้นที่ท างานจากนั้นเลือกค าสั่ง Grids & Guides > Hide Guides (คีย์ลัด Ctrl + :)  
   1.15)  การล็อคเส้นไกด์ เป็นการท าให้เส้นไกด์ที่เลือกไม่สามารถเลื่อนไปไหนได้ 
สามารถท าได้ โดยใช้เครื่องมือ        Selection Tool คลิกเมาส์ขวาบนพ้ืนที่ท างานเลือก Lock Guides (Alt 
+ Ctrl + ;) หรือ เลือกเมนู View > Grids & Guides > Lock Guides (Alt + Ctrl + ;)  ซึ่งถ้าใช้ค าสั่งเดิมอีก
ครั้ง หรือน าเครื่องหมายถูกออก ก็จะเป็นการปลดล็อคเส้นไกด์ 
   1.16) การสร้างไฟล์ New Document ต้องมีการก าหนดรูปแบบไฟล์งานให้
เหมาะสมกับลักษณะงาน ซึ่งเมื่อก าหนดรูปแบบเรียบร้อยแล้วยังสามารถน าไฟล์ที่ท าไปใช้ในงานครั้งต่อ ๆ ไป 
โดยมีขั้นตอนในการสร้างไฟล์งานใหม่ดังนี้ 
      การก าหนดรูปแบบ และตั้งค่าไฟล์เอกสาร  
    Document Preset เลือกแบบ Default ตามที่โปรแกรมก าหนดให้ หรือ

เลือกแบบ Custom ก าหนดเอง 
     Intent  ก าหนดรูปแบบการท างานให้เหมาะกับงาน 
      Print ส าหรับงานสิ่งพิมพ์ 
        Web ส าหรับงานเว็บไซด์ 
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        Digital Publishing ส าหรับงนดิจิตอล สมาร์ทโฟน /
แท็บเล็ต 

      Number of Pages จ านวนหน้า Preset สามารถเพ่ิม / ลดได้ 
     Start Page เลขหน้าเริ่มต้นของไฟล์งาน สามารถก าหนดที่หลังได้ 
     Facing Pages คลิกถูกแสดงหน้าคู่ ถ้าไม่คลิกถูกแสดงหน้าเดี่ยว 
     Primary Text Frame คลิกเพ่ือสร้างกล่องข้อความบน Master Pages 
     Pages Size ก าหนดขนาดกระดาษตามท่ีโปรแกรมก าหนดให้ ดังนี้ 
        Letter  ขนาดกระดาษมาตรฐานจดหมาย 
        Legal  ขนาดกระดาษมาตรฐาน  North America 

11X14 นิ้ว นิยมใช้ทที่อเมริกาและแคนาดา 
        Tabloid ขนาดกระดาษส าหรับหนังสือพิมพ์ขนาดเล็ก 

11X17 นิ้ว 
        Letter – Half ขนาดครึ่งกระดาษมาตรฐานจดหมาย 

5.5 X 8.5 นิ้ว 
         Legal – Half  ขนาดครึ่งกระดาษมาตรฐาน North 

America 7X8.5 นิ้ว 
         A5 ขนาดกระดาษมาตรฐาน A5 
         A4 ขนาดกระดาษมาตรฐาน A4 
         A3 ขนาดกระดาษมาตรฐาน B5 
       US Business Card  ขนาดมาตรฐาน US ส าหรับสร้าง

นามบัตร  
       Compact Disc  ขนาดกระดาษมาตรฐานใช้สร้าง 

CD 
    Custom  ก าหนดขนาดด้วยตนเอง 
        Width ก าหนดความกว้างของกระดาษ 
        Height ก าหนดความสูงของกระดาษ 
  Orientation  คลิกเลือก        เพื่อก าหนดเป็นแนวตั้ง 
    คลิกเลือก        เพื่อก าหนดเป็นแนวนอน 
  Columns ช่องส าหรับก าหนดคอลัมน์ให้ไฟล์งาน 
    ช่อง Number ก าหนดจ านวนคอลัมน์ 
    ช่อง Gutter ก าหนดระยะห่างระหว่างคอลัมน์ 
  Margins  ก าหนดระยะกั้นหน้าเอกสาร โดยก าหนดจาก 



 
 

 

47 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

    ช่อง Top (ด้านบน)  
    ช่อง Inside (ด้านในที่อยู่ใกล้กับสันหนังสือ) 
    ช่อง Bottom (ด้านล่าง)  
    ช่อง Outside (ด้านนอก) 
  Bleed  ขอบเขตที่อยู่ด้านนอกของไฟล์งาน หรือเรียกว่า ขอบ

ตัดตก เป็นการก าหนดไว้เผื่อให้โรงพิมพ์ไว้ใช้ตัดขอบ 
เวลาออกแบบควรท าให้เกินมาที่ขอบ Bleed เพ่ือ
ป้องกันการตัดกระดาษท่ีผิดพลาด 

  Slug  ขอบเขตที่ใช้ส าหรับการวางข้อมูลการพิมพ์ ในส่วนนี้
จะถูกตัดท้ิง 

  เมื่อท าการก าหนดรูปแบบและตั้งค่าไฟล์เอกสารเรียบร้อยแล้ว ให้คลิกปุ่ม 
Save Preset เพ่ือเก็บรูปแบบไว้ใช้งานในครั้งต่อไป ท าการตั้งชื่อ Document Preset แล้วคลิก OK 
  ทั้งหมดนี้เป็นเครื่องมือที่จ าเป็นต้องใช้งานในหน้าต่างการท างานในโปรแกรม 
Adobe InDesign ซึ่งเทคนิคในการปฏิบัติงานโดยการใช้โปรแกรม Adobe InDesign และขั้นตอนการจัดท า
จดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร จะกล่าวในบทต่อไป 
 

3.1.7  แนวคิดและงานวิจัยท่ีเกี่ยวข้อง 
กนกวรรณ เขม้นงาน (2556) ศึกษาเรื่องการวิเคราะห์ การพัฒนา และการประเมินผลการ

ออกแบบสื่อสิ่งพิมพ์เพ่ือการประชาสัมพันธ์การท่องเที่ยวจังหวัดนครศรีธรรมราช ซึ่งผลการวิจัยในส่วนที่ 1 
พบว่า การวิเคราะห์การออกแบบสื่อสิ่งพิมพ์เพ่ือการประชาสัมพันธ์การท่องเที่ยวของจังหวัดนครศรีธรรมราช
ตั้งแต่ปี พ.ศ.2545-2555 โดยได้วิเคราะห์จากหลักการออกแบบ พบว่า สื่อสิ่งพิมพ์ที่ท าการออกแบบใหม่ ควร
เน้นสถานที่ท่องเที่ยวที่ส าคัญโดยเฉพาะวัดพระมหาธาตุวรมหาวิหาร ขนาดของสื่อสิ่งพิมพ์ควรมีขนาดกะทัดรัด
และสามารถพกพาได้สะดวก โดยมีขนาดประมาณ ความยาว 14.8 เซนติเมตร ความกว้าง 10.5 เซนติเมตร 
เรื่องการจัดวางองค์ประกอบของหน้าปกควรใช้ภาพถ่ายวัดพระมหาธาตุวรมหาวิหารเป็นองค์ประกอบ ขนาด
ของตัวอักษรควรมีขนาดประมาณ 14-16 พ้อยท์ (Point) รูปแบบของตัวอักษรในส่วนของหัวข้อและเนื้อหา
ควรมีความแตกต่างกัน การจัดวางภาพถ่ายควรมีการจัดวางให้แปลกใหม่และเปลี่ยนมุมมองของภาพถ่ายให้ดู
แปลกตา และสุดท้ายการเลือกใช้สี ควรใช้สีที่มีความสดใสและมีความหลากหลายเพ่ือสร้างความน่าสนใจแก่
ผู้อ่าน 

ผลการวิจัยในส่วนที่ 2 การประเมินผลการออกแบบสื่อสิ่งพิมพ์เพ่ือการประชาสัมพันธ์การ
ท่องเที่ยวจังหวัดนครศรีธรรมราชที่ออกแบบขึ้นมาใหม่ โดยประเมินผลจากประสิทธิผลของการออกแบบและ
แบบจ าลองกระบวนการตอบสนองต่อสื่อ (AIDA Model) พบว่า ประสิทธิผลของการออกแบบ ด้านที่ 1 การ
ตอบสนองประโยชน์ใช้สอย ขนาดของรูปปเล่มกะทัดรัดและสามารถพกพาได้สะดวก ขนาดและรูปแบบ



 
 

 

48 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

ตัวอักษรมีความชัดเจน การจัดวางภาพถ่ายมีความเหมาะสมและมีเอกลักษณ์ ด้านความสวยงามพึงพอใจ การ
ออกแบบและการจัดองค์ประกอบมีความเหมาะสมสามารถอ่านได้ทุกเพศทุกวัย ด้านการสื่อความหมาย การ
จัดแบ่งข้อมูลมีความน่าสนใจและเหมาะสมกับการประชาสัมพันธ์ดี มีการแบ่งเป็นหมวดหมู่ประเภทของ
สถานที่ท่องเที่ยวและมีภาพถ่ายครบถ้วน ภาพถ่ายสามารถสื่อความหมายถึงสถานที่ท่องเที่ยวได้ชัดเจน ในส่วน
ของผลการวิจัยแบบจ าลองกระบวนการตอบสนองต่อสื่อ (AIDA Model) ด้านการดึงดูดความสนใจ หน้าปกมี
การออกแบบที่ทันสมัย ขนาดของรูปเล่มมีความกะทัดรัด การจัดวางรูปร่าง (Layout) และการเลือกใช้โทนสีที่
สดใสท าให้มีความแตกต่างจากหนังสือท่องเที่ยวทั่วไป ด้านการสนใจติอตาม มีการออกแบบที่แปลกใหม่และมี
เอกลักษณ์เฉพาะตัว ภายในเล่มมีการรวบรวมข้อมูลของสถานที่ท่องเที่ยวและภาพถ่ายไว้อย่างชัดเจน ด้านการ
กระตุ้นให้เกิดความต้องการ การแบ่งประเภทของสถานที่ท่องเที่ยวมีความชัดเจนสามารถท าให้รู้จักจังหวัด
นครศรีธรรมราชได้มากขึ้น โดยรวมมีความพึงพอใจ และด้านสุดท้ายการก่อให้เกิดการกระท า สามารถช่วย
กระตุ้นให้เกิดความต้องการอยากเดินท่องเที่ยวได้ค่อนข้างมาก ท าให้อยากรู้จักจังหวัดนครศรีธรรมราชว่ามีที่
ท่องเที่ยวหลากหลายและครบทุกรูปแบบ 

อนุสรา ขันนารันต์ (2561) ได้ท าการศึกษาเรื่องแนวทางการพัฒนาเอกสารข่าวทหารบก เพ่ือการ
เป็นสื่อประชาสัมพันธ์ภายในองค์กร โดยมีผลการวิจัยพบว่า เอกสารข่าวทหารบก เป็นสื่อประชาสัมพันธ์ที่ผลิต
ขึ้นเพ่ือกระจายข่าวสารจากผู้บังคับบัญชาไปยังผู้ใต้บังคับบัญชา เพ่ือให้ได้ทราบนโยบาย ตลอดจนความ
เคลื่อนไหวที่เกิดขึ้นภายในกองทัพบก ซึ่งเป็นประโยชน์ต่อการปฏิบัติงาน โดยมีกลุ่มเป้าหมาย คือ ก าลังพลใน
กองทัพบกท่ัวประเทศ ครอบครัวของก าลังพล สื่อมวลชนและส่วนราชการอ่ืนๆ มีเนื้อหาของข่าวสารที่เก่ียวกับ
นโยบายของผู้บังคับบัญชาค าสั่งกองทัพบก ระเบียบปฏิบัติงาน กิจกรรม ความเคลื่อนไหวในกองทัพบก การฝึก
ผลการปฏิบัติงานและเกร็ดความรู้ต่างๆ ยังขาดความต่อเนื่องท าให้ได้ข้อมูลที่ไม่ทันสมัย ล่าช้า และท าให้ข้อมูล
ที่ได้รับจากหน่วยงาน ไม่ตรงตามความต้องการประกอบกับพ้ืนที่การประชาสัมพันธ์ที่มีอยู่อย่างจ ากัดและเรื่อง
ที่น าเสนอ ไม่สอดคล้องกับวัตถุประสงค์ เนื่องจากการน าเสนอโดยยึดตามค าสั่งของผู้บังคับบัญชาเป็นหลัก  

ความคิดเห็นของก าลังพบกองทัพบกท้ังจากส่วนกลางและส่วนภูมิภาค พบว่า เนื้อหาของข่าวสาร
มีความเหมาะสมทั้งประเภทของ และการน าเสนอ นอกจากนี้ก าลังพลบางส่วนอยากให้พัฒนาภาพประกอบใน
เอกสารข่าวทหารบกให้มีความหมากหลาย เน้นภาพที่มีก าลังพลปฏิบัติภารกิจ ส่วนรูปแบบการน าเสนอของ
เอกสาร พบว่ามีความเหมาะสม ทั้งภาพปก การจัดวางภายในเล่มขนาดของรูปเล่ม ขนาดตัวอักษรภายในเล่ม
การออกแบบ (Design) ตัวอักษรในแต่ละคอลัมน์และสีสันภายในเล่ม 

แนวทางการพัฒนาเอกสารข่าวทหารบก ในด้านเนื้อหาของข่าวสารมีการแบ่งประเภทเนื้อหาให้มี
ความหลากหลาย ต้องแทรกความบันเทิงเพ่ือให้ผู้อ่านผ่อนคลาย ภาษาที่ใช้อาจต้องปรับให้น่าติดตามส่วน
รูปแบบการน าเสนอต้องใช้เทคนิคการน าเสนอเข้าช่วยจัดแบ่ง ใช้ภาพสลับกับข้อความให้มีจัดพักสายตา ใช้
กราฟิกดีไซน์เข้ามาช่วย 
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ปราณปรียา สิมมา (2555) ศึกษาการพัฒนารูปแบบจดหมายข่าวไฮไลท์ทูเดย์ ของมหาวิทยาลัย
ราชภัฎหมู่บ้านจอมบึง ผลการวิจัยพบว่า สภาพปัญหาและความต้องการทีมีต่อจดหมมายข่าวไฮไลท์ทูเดย์ 
เนื้อหาของจดหมายข่าวไม่ครอบคลุมทุกคณะ/หน่วยงานในมหาวิทยาลัย ภาพข่าวน้อยเกินไป บอร์ด
ประชาสัมพันธ์จดหมายข่าวมีจ านวนน้อยมาก ปัจจัยที่ส่งผลต่อความต้องการรับสื่อในมหาวิทยาลัย คือ 
ต้องการทราบกิจกรรมภายในมหาวิทยาลัย เนื้อหาข่าวสารที่ต้องการให้มีในจดหมายข่าวมากที่สุด คือ 
ทุนการศึกษา ช่องทางในความต้องการอ่านจดหมายข่าวที่ต้องการมากที่สุด คือ บอร์ดประชาสัมพันธ์ใน
มหาวิทยาลัย และต้องการอ่านจดหมายข่าวทุกวัน เนื้อหารายละเอียดที่ควรเพ่ิมเติมในหัวกระดาษจดหมาย
ข่าว คือ วิสัยทัศน์ของมหาวิทยาลัย 

รูปแบบของจดหมายข่าวไฮไลท์ทูเดย์ที่พัฒนาขึ้น มีขนาดกระดาษ A4 จ านวน 2 หน้า สีของ
กระดาษจดหมายข่าวไฮไลท์ทูเดย์มีหลากสี ใช้ภาพกราฟิกทั่วเป็นหัวจดหมายข่าวไฮไลท์ทูเดย์ ตัวอักษรที่เป็น
เนื้อหาในจดหมายข่าวใช้ตัวอักษรที่เป็นทางการขนาด 18 พอยต์และ 20 พอยต์ ขนาดตัวอักษรของเนื้อหา
จดหมายข่าว คือ 16 พอยต์ ภาพประกอบที่ใช้ในจดหมายข่าว คือ ภาพถ่าย จัดหน้ากระดาษแบบสมดุล และท่ี
ส าคัญรูปแบบจดหมายข่าวจะต้องแสดงถึงเอกลักษณ์ของมหาวิทยาลัย ซึ่งผลการประเมินรูปแบบของจดหมาย
ข่าวไฮไลท์ทูเดย์จากผู้เชี่ยวชาญด้านเนื้อหา และด้านสื่ออยู่ในระดับมาก เป็นรูปแบบที่จะน าไปประยุกต์ใช้ได้
จริง และผู้รับสารมีความพึงพอใจด้านเนื้อหาคอลัมน์ ด้านการออกแบบ และด้านช่องทางการสื่อสารของ
จดหมายข่าวไฮไลท์ทูเดย์ ของมหาวิทยาลัยราชภภัฎหมู่บ้านจอมบึงในระดับมาก 

จากการศึกษาดังกล่าว สรุปได้ว่า การจัดท าจดหมายข่าวของหน่วยงานจะต้องให้ความส าคัญกับ
ด้านการออกแบบรูปแบบสื่อให้มีความเหมาะสม โดยการก าหนดขนาดของสื่อสิ่งพิมพ์ให้มีขนาดที่เหมาะสม
กะทัดรัด โดยทั่วไปนิยมให้มีขนาด A4  

รูปแบบและขนาดของตัวอักษร ในส่วนของหัวข้อหลักควรมีขนาด 18-20 พอยต์ (Point) ในส่วน
ของเนื้อหาควรมีขนาด 16 พอยต์ (Point) และควรมีความแตกต่างกัน ภาษาท่ีใช้ในการสื่อสารควรเป็นภาษาที่
เข้าใจได้ง่ายและชวนให้น่าติดตาม  

นอกจากในส่วนของเนื้อหา ภาพประกอบควรมีการพัฒนาภาพประกอบให้มีความหลากหลาย มี
ความเหมาะสมสื่อความหมายได้ตามเนื้อหา สีสันที่ใช้ในการออกแบบควรมีความสดใสมีความหลากหลาย เพ่ือ
สร้างความน่าสนใจ การจัดหน้าควรมีความสมดุลและที่ส าคัญรูปแบบจดหมายข่าวควรแสดงถึงเอกลักษณ์ของ
หน่วยงาน 

 
3.2  ข้อควรระวังในการปฏิบัติงาน  
  3.2.1 ในการเลือกใช้รูปแบบตัวอักษร ไม่ควรมีความหลากหลายมากเกินไป อย่างมากไม่ควรเกิน 3 แบบ
ในหนึ่งหน้ากระดาษ เพราะจะท าให้ไม่เป็นเอกภาพและยากต่อการอ่านของผู้อ่าน 
  3.2.2 ข้อมูลเนื้อหาของข่าวที่หน่วยงานที่ขอความอนุเคราะห์จัดท ามา จะต้องมีความกระชับ ไม่เยิ้นเย้อ 
สรุปแต่ใจความส าคัญ  



 
 

 

50 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

  3.2.3 รูปภาพประกอบ จะต้องมีคุณภาพของภาพที่ชัดเจนโดยมีความละเอียดของภาพ ไม่ต่ ากว่า 300 
dpi และมีความเหมาะสม สอดคล้องกับเนื้อหาหรือบทความ 
  3.2.4 การจัดส่งไฟล์รูปภาพของหน่วยงานที่ขอความอนุเคราะห์ จะต้องท าการแยกเป็นโฟลเดอร์แต่ละ
เรื่องพร้อมระบุชื่อเรื่องให้ตรงกับข้อมูลด้านเนื้อหา เพ่ือความสะดวกในการค้นหาภาพประกอบในเนื้อหาให้
สอดคล้องตรงกัน 
  3.2.5 ในการจัดส่งไฟล์งานต้นฉบับกลับไปยังหน่วยงานที่ขอความอนุเคราะห์ ควรท าการตรวจสอบความ
ถูกต้องของข้อมูลให้ครบถ้วน รวมถึงคุณภาพความละเอียดของไฟล์ภาพ อาจบันทึกไฟล์งานในสกุล .pdf 
หรือ .JPG หรือ .PNG เพ่ือให้หน่วยงานที่ขอความอนุเคราะห์สามารถน าไปเผยแพร่ในช่องทางท่ีก าหนดไว้ได้ 
 



บทท่ี 4 
เทคนิคการปฏิบัติงาน 

 
 ในการจัดท าคู่มือการปฏิบัติงานเรื่อง การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคล          
พระนคร ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe InDesign  เพ่ือเป็นแนวทางให้ผู้ปฏิบัติงานสามารถ
ปฏิบัติงานแทนกันได้ และเพ่ือให้การปฏิบัติงานเป็นไปในมาตรฐานเดียวกัน โดยมีรายละเอียดในการ
ด าเนินงานในแต่ละขั้นตอนดังนี้  
 4.1  กิจกรรม/แผนการปฏิบัติงาน 
 4.2  ขั้นตอนและเทคนิคการปฏิบัติงาน 
 4.3  การติดตามประเมินผลการปฏิบัติงาน 
 

4.1  กิจกรรมแผนปฏิบัติงาน 
ผู้จัดท าคู่มือการปฏิบัติงานการจัดท าจดหมายสภามหาวิทยาลัยฯ ได้ด าเนินการตามแผนปฏิบัติงานแต่ละ

ฉบับ โดยมีล าดับเวลาในการด าเนินงานแต่ละกิจกรรมเป็นรายสัปดาห์ ดังแสดงตารางที ่4-1  
 

กิจกรรม 
เวลาในการด าเนินงาน 

(สัปดาห์) หมายเหตุ 
1 2 3 4 5 

1. หน่วยงานที่รับผิดชอบด าเนินการจัดการ
ประชุมสภามหาวิทยาลัยฯ 

     ก าหนดจัดการประชุมทุกวันพุธ
สุดท้ายของทุกเดือน 

2. หน่วยงานที่ขอความอนุเคราะห์ท าการ
สรุปและรับรองรายงานการประชุม 

     การรับรองรายงานการประชุม ใน
การประชุมครั้งถัดไป 

3. หน่วยงานที่ขอความอนุเคราะห์ 
จัดเตรียมข้อมูลเนื้อหา รูปภาพประกอบ 

     จัดส่งข้อมูลทางออนไลน์ Google 
Drive  

4. ด าเนินการจัดท าจดหมายข่าวสภาฯ       
5. ส่งไฟล์งานที่จัดท าแล้ว ให้หน่วยงานขอ
ความอนุเคราะห์ตรวจสอบ 

     จัดส่งข้อมูลในระบบ Google 
Drive 

6. ด าเนินการปรับปรุงแก้ไข(ถ้ามี)      แก้ไขตามค าแนะน า 

7. หน่วยงานขอความอนุเคราะห์ด าเนินการ
เผยแพร่ 

     จัดส่งข้อมูลในระบบ Google 
Drive พร้อมแจ้งผู้รับผิดชอบ 

 
ตารางที่ 4-1  แผนการปฏิบัติงานจัดท าจดหมายข่าวสภามหาวิทยาลัยฯ 
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4.2  ขั้นตอนและเทคนิคการปฏิบัติงาน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
  
 
ผังงานที ่4-1  ขั้นตอนและเทคนิคการปฏิบัติงานในการด าเนินการจัดท าจดหมายข่าวสภามหาวิทยาลัยฯ 

(4.2.1) 

(4.2.2) 

(4.2.3) 

(4.2.4) 

(4.2.5) 

 

หน่วยงานที่ขอใช้บริการท าหนังสือ 

ขอความอนุเคราะห์และจัดเตรียมข้อมูล 

เริ่ม 

จัดส่งข้อมูลทางออนไลน์ Google Drive 
 

ตรวจสอบข้อมูล ปรับปรุง 
ไม่เหมาะสม 

ส่งไฟล์ตัวอย่างให้หน่วยงานที่ขอความอนุเคราะห ์

เหมาะสม 

ส่งไฟล์ต้นฉบับให้หน่วยงานที่ขอความอนุเคราะห์ 

สิ้นสุดกระบวนการ 

ตรวจสอบข้อมูล ปรับปรุง 

ข้อมูลไมส่มบรูณ ์

ท าการก าหนดและวางแผนการออกแบบ 

จดหมายข่าวสภามหาวิทยาลัยฯ (ดัมมี่) 

ข้อมูลสมบูรณ ์

ด าเนินการจัดหน้ารูปเล่มจดหมายข่าวตามที่ก าหนด 

ด้วยโปรแกรม Adobe InDesign 
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 4.2.1  หน่วยงานที่ขอใช้บริการท าหนังสือขอความอนุเคราะห์และจัดเตรียมข้อมูล 
 งานจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร เป็นงานให้บริการ
หน่วยงานภายใน สนับสนุนการเผยแพร่การด าเนินงานของสภามหาวิทยาลัยฯ โดยผู้ปฏิบัติงานได้รับหนังสือ
ขอความอนุเคราะห์ (ภาพท่ี 4-1) และแต่งตั้งให้เป็นหนึ่งในคณะกรรมการประชาสัมพันธ์และสร้างความเข้าใจ
งานกิจการสภามหาวิทยาลัย (ภาพที่ 4-2) ผ่านมายังหน่วยงานส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
มอบหมายให้ฝ่ายพัฒนานวัตกรรมและเทคโนโลยีการศึกษา เพ่ือให้ผู้ปฏิบัติงานได้รับทราบ เตรียมความพร้อม  
 
 

 
 

ภาพที่ 4-1  ตัวอย่างหนังสือขอความอนุเคราะห์ 
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ภาพที่ 4-2  ตัวอย่างค าสั่งแต่งตั้งคณะกรรมการ 
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ภาพที่ 4-2  ตัวอย่างค าสั่งแต่งตั้งคณะกรรมการ (ต่อ) 
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ภาพที่ 4-2  ตัวอย่างค าสั่งแต่งตั้งคณะกรรมการ (ต่อ) 
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 4.2.2  การจัดส่งข้อมูลทางออนไลน์ ระบบ Google Drive  
 เมื่อหน่วยงานที่ขอความอนุเคราะห์ได้จัดท าบันทึกข้อความและแต่ งตั้งผู้ปฏิบัติงานเป็น
คณะกรรมการแล้ว ขั้นตอนต่อมาเป็นการจัดเตรียมข้อมูลที่ใช้ส าหรับในการจัดท าจดหมายข่าวสภา
มหาวิทยาลัยฯ โดยผู้ปฏิบัติงานได้สร้างระบบการส่งมอบข้อมูลบนเครือข่ายอินเตอร์เน็ต ตามล าดับขั้นตอน 
ดังนี้ 
 4.2.2.1 เข้าสู่ระบบอินเตอร์เน็ต www.google.com ดังแสดงภาพที่ 4-3 ลงชื่อเข้าสู่ระบบด้วย                    
User และ Password  E-mail ของมหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ********@rmutp.ac.th  ดัง
แสดงภาพที่ 4-4 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-3  แสดงการลงชื่อเข้าใช้หน้าเพจ www.google.com 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-4  แสดงการเข้าระบบด้วย E-mail มหาวิทยาลัยฯ *******@rmutp.ac.th 
 
 4.2.2.2  เลือกระบบบริการ Google Drive ดังแสดงภาพที่ 4-5 ในหน้าแรกด้านซ้ายของหน้าเพจ
ท าการเลือกรายการ แชร์กับฉัน จะพบกับโฟลเดอร์ที่ชื่อว่า ข่าวสภามหาวิทยาลัยฯ ดังแสดงภาพที่ 4-6 

 

เลือกลงชื่อเข้าสู่ ระบบ
เพ่ือเข้าใช้บริการ 

 เข้าสู่ระบบด้วย 
E-mail มหาวิทยาลัยฯ 

http://www.google.com/
http://www.google.com/
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ภาพที่ 4-5  แสดงวิธีการเข้าบริการ google drive 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-6  แสดงการเข้าถึงโฟลเดอร์งาน ข่าวสภามหาวิทยาลัยฯ 

 
 
 
 
 
 
 
 

  
ภาพที่ 4-6  แสดงการเข้าถึงโฟลเดอร์งาน ข่าวสภามหาวิทยาลัยฯ (ต่อ) 

เลือกรายการ แชร์กับฉัน ทางด้าน

ซ้ายมือ 

เลือกบริการ google drive 
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 เมื่อเข้าถึงโฟลเดอร์ข่าวสภามหาวิทยาลัยฯ ในระบบ Google Drive แล้วจะพบ
โฟลเดอร์ข้อมูลรายเดือน ท าการตรวจสอบข้อมูลที่หน่วยงานที่ขอความอนุเคราะห์ได้ท าการจัดส่งมา ซึ่งเนื้อหา
และรูปภาพประกอบจะต้องมีความสอดคล้องกัน โดยการเปิดไฟล์เนื้อหาเพ่ือเช็คจ านวนข่าวทั้งหมด และ
รูปภาพประกอบจะต้องมีความสอดคล้องไปในทิศทางเดียวกัน เช่น เนื้อหาเป็นข่าวการประชุมคณะกรรมการ
สภามหาวิทยาลัยฯ ภาพประกอบข่าวต้องเป็นภาพเกี่ยวกับการประชุมคณะกรรมการ ภาพผู้เข้าร่วมประชุม 
เป็นต้น ซึ่งคุณภาพของภาพควรมีความคมชัด องค์ประกอบภาพมีความเหมาะสม เมื่อท าการตรวจสอบข้อมูล
ทั้งหมดแล้ว ถ้าขาดข้อมูลใด หรือข้อมูล หรือรูปภาพไม่ครบ เช่น จ านวนข่าวมี 10 ข่าว แต่โฟลเดอร์รูปภาพ
ประกอบมีจ านวน 9 โฟลเดอร์ แสดงว่าจะมีข่าว 1 ข่าวที่ไม่มีรูปภาพประกอบ ซึ่งต้องท าการแจ้งไปยัง
หน่วยงานที่ขอความอนุเคราะห์ให้ด าเนินการตรวจสอบ เพ่ือท าการยืนยันข้อมูล หรือจัดส่งใหม่เพ่ิมเติมอีกครั้ง  
 จากนั้นท าการดาวน์โหลดข้อมูลเนื้อหาและรูปภาพประกอบมาเก็บไว้ในเครื่อง
คอมพิวเตอร์ที่ใช้ปฏิบัติงาน โดยการสร้างโฟลเดอร์งานให้ตรงกับชื่องานที่ต้องจัดท า เช่น ควรสร้างโฟลเดอร์ 
จดหมายข่าวสภามหาวิทยาลัยฯ ด้านในโฟลเดอร์ควรแบ่งออกเป็นรายเดือนตามปีงบประมาณ ดังแสดงภาพที่ 
4-7 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-7  แสดงโฟลเดอร์จดหมายข่าวสภามหาวิทยาลัยฯ 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-7  แสดงโฟลเดอร์จดหมายข่าวสภามหาวิทยาลัยฯ (ต่อ) 
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 4.2.3  การก าหนดและวางแผนการออกแบบรูปแบบจดหมายข่าวสภามหาวิทยาลัย ฯ  
 หลักในการออกแบบจดหมายข่าว มี 2 เรื่องที่ส าคัญ คือ ส่วนที่ 1 การก าหนดและวางแผนก่อน
การออกแบบรูปแบบจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ส่วนที่ 2 องค์ประกอบ และ
การจัดวางองค์ประกอบในการออกแบบจดหมายข่าว ในทั้ง 2 ส่วนนี้ เป็นเรื่องที่ต้องอาศัยประสบการณ์ 
ความสามารถ ทักษะและความช านาญ โดยสิ่งที่ต้องก าหนดและวางแผนก่อนการออกแบบจดหมายข่าวมีดังนี้ 

4.2.3.1  การก าหนดขนาดและรูปแบบของจดหมายข่าว 
4.2.3.2  รูปแบบของปกหน้าหรือหน้าแรกของจดหมายข่าว 
4.2.3.3  รูปแบบและขนาดอักษร 
4.2.3.4  การก าหนดจ านวนคอลัมน์เนื้อหาและรูปภาพประกอบที่ใช้ในจดหมายข่าว 
ซึ่งในส่วนนี้เป็นหน้าที่รับผิดชอบของต าแหน่งนักวิชาการช่างศิลป์ ระดับช านาญการ เป็นผู้

ก าหนดและวางแผนก่อนการออกแบบจดหมายข่าว โดยนักวิชาการช่างศิลป์ ระดับปฏิบัติการ ซึ่งผู้ปฏิบัติงาน
น าข้อมูลเนื้อหาที่ได้รับมอบให้นักวิชาการช่างศิลป์ ระดับช านาญการ ท าการตรวจสอบก าหนดและวางแผน
ออกแบบจดหมายข่าว โดยการออกแบบก าหนดดัมมี่ และก าหนดการจัดวางข้อมูลรูปภาพ หรือร่าง Sketch 
Lay-Out เพ่ือให้ผู้ปฏิบัติงานสามารถด าเนินการได้เหมาะสมและรวดเร็ว ดังแสดงตารางที่ 4-2 
 
หน้า ชื่อคอลัมน์ รูปแบบ ผู้รับผิดชอบเนื้อหา 

1 ปกหน้า ประเด็นสรุปข่าว และใช้ภาพถ่ายเป็นหลัก 
มีข้อความโปรยตัวอย่างคอลัมน์บทความ
พิเศษ 

กองสื่อสารองค์กร 
2-3 เรื่องพิจารณา และเรื่องอ่ืนๆ ภาพข่าวหัวข้อและมติการประชุมสภาตาม

วาระ 
4 บทความพิเศษ เนื้อหาเก่ียวเนื่องจากปกหน้า 

  
ตารางที่ 4-2  แสดงรูปแบบก าหนดคอลัมน์ในจดหมายข่าว (กองเกษตรสารนิเทศ, 2557) 

 
โดยเมื่อนักวิชาการช่างศิลป์ ระดับช านาญการ ได้ท าการก าหนดเลขหน้าและชื่อคอลัมน์เพ่ือ

เป็นดัมมี่เรียบร้อยแล้ว จากนั้นจะท าการออกแบบ Sketch Lay-Out การจัดวางข้อมูลและรูปภาพลงใน
กระดาษขนาด A4 ซึ่งต้องใช้ความรู้ทักษะความสามารถในการออกแบบ เพ่ือเป็นตัวอย่างแนวทางให้
ผู้ปฏิบัติงานในระดับปฏิบัติการ สามารถท างานได้อย่างถูกต้องและเหมาะสม ดังแสดงภาพที่ 4-8 
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ภาพที่ 4-8  แสดงตัวอย่างการ Sketch Lay-Out 
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ภาพที่ 4-8  แสดงตัวอย่างการ Sketch Lay-Out (ต่อ) 
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ภาพที่ 4-8  แสดงตัวอย่างการ Sketch Lay-Out (ต่อ) 
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ภาพที่ 4-8  แสดงตัวอย่างการ Sketch Lay-Out (ต่อ) 
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 4.2.4  ด าเนินการจัดหน้ารูปเล่มจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร โดย 
 4.2.4.1  ขั้นตอนการจัดหน้ารูปเล่มจดหมายข่าวสภามหาวิทยาลัย ฯ  
 ในการจัดหน้าจดหมายข่าวสภามหาวิทยาลัย หลังจากที่เตรียมข้อมูลโดยการโหลด
เนื้อหามติการประชุมสภามหาวิทยาลัยฯ และเรียนรู้เรื่องการใช้โปรแกรม Adobe InDesign เบื้องต้นเป็นที่
เรียบร้อยแล้ว ขั้นตอนต่อมาเป็นขั้นตอนการเริ่มจัดหน้าจดหมายข่าว โดยมีล าดับขั้นตอนดังนี้ 

1) ขั้นตอนที่ 1  การตั้งค่าชื่อเริ่มต้นไฟล์งาน  
 โดยเริ่มจากเปิดโปรแกรม Adobe InDesign จากนั้นจะปรากฎ
หน้าต่างเริ่มโปรแกรม ในส่วน Create New > Document จากนั้นท าการตั้งค่าไฟล์เอกสาร ดังแสดงภาพที่ 
4-9 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-9  แสดงการตั้งค่าเริ่มไฟล์เอกสารการจัดหน้าจดหมายข่าวสภามหาวิทยาลัยฯ 
 
   การตั้งค่าเริ่มต้นไฟล์งาน เริ่มจากการก าหนดจ านวนหน้า ในช่องที่ 1 
จ านวน 4 หน้า ในส่วนของช่องที่ 2 คลิกในช่องสี่เหลี่ยมให้เกิดเครื่องหมายถูก หน้าช่อง Facing Page เพ่ือให้
แสดงหน้าคู่ ถัดมาในช่องที่ 3 การก าหนดขนาดกระดาษของจดหมายข่าวสภามหาวิทยาลัยฯ ให้ก าหนดขนาด
เป็นขนาด A4 และในส่วนสุดท้าย ช่องที่ 4 การก าหนดขอบตัดตกของกระดาษ ให้ท ากรอกขนาด 3 mm       
ดังแสดงภาพที่ 4-10 
 
 

คลิกเลือก Create New > Document 
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ภาพที่ 4-10  แสดงการตั้งค่าไฟล์เอกสารการจัดหน้าจดหมายข่าวสภามหาวิทยาลัยฯ 
    
  เมื่อท าการก าหนดค่าเริ่มต้นของไฟล์งานได้เรียบร้อยแล้ว จะปรากฎ
หน้าต่างการท างาน จากนั้นท าการเซฟไฟล์โดยการคลิกเลือกเมนู File > Save as บันทึกชื่อไฟล์งานเป็น 
“จดหมายข่าวสภามหาวิทยาลัยเดือน...” ดังแสดงภาพที่ 4-11 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-11  แสดงการตั้งชื่อไฟล์งาน ในโปรแกรม Adobe InDesign 
 

2) ขั้นตอนที่ 2  การสร้างหน้ามาตรฐาน หรือ Master Page  
  Master Page เป็นตัวก าหนดต้นแบบในการท า Layout เพ่ือให้งานที่
ท ามีลักษณะ เดียวกัน นิยมใช้ในการท าพ้ืนหลัง และท าเลขหน้า ซึ่งจะไม่ปรากฎในหน้า Page ที่เลือกทุกหน้า 

ช่องที่ 1. ก าหนดจ านวนหน้า ช่องที่ 2. ก าหนดแสดงหน้าคู่ 

ช่องที่ 3.ก าหนดขนาดกระดาษ 

ช่องที่ 4.ก าหนดขอบตัดตก 
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โดยไม่ต้องท าซ้ าขึ้นมาใหม่ และสิ่งที่ถูกออกแบบไว้ในหน้า Master Page จะไม่สามารถแก้ไขบนหน้า Page ได้ 
หาก ต้องการแก้ไขจะต้องกลับไปที่หน้า Master Page เท่านั้น ซึ่งทุกหน้า Page ที่ถูกใช้งานจะถูกปรับแก้ไขให้
แบบอัตโนมัติทุกหน้า การออกแบบหน้า Master Page นั้นสามารถท าได้โดยคลิกเลือกที่หน้า Master Page 
จะ ปรากฎหน้าต่างการท างานดังแสดงภาพที่ 4-12 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-12 แสดงการเข้าถึงหน้า Master Page ในโปรแกรม Adobe InDesign 
 
  จากนั้นท าการเพ่ิมหน้า Master Page โดยคลิกเลือกที่หน้า Master 
Page A จากนั้นคลิกที่ปุ่ม          Create New Page ดังแสดงภาพที่ 4-13 โปรแกรมจะท าการเพ่ิมหน้า 
Master Page B และ Master Page C ให้โดยอัตโนมัติ 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-13 แสดงการเพ่ิมหน้า Master Page 

 

คลิกเลือกหน้า Master Page A 

คลิกปุ่ม Create New Page 

การสร้างหน้า Master Page 

พ้ืนที่การสร้างหน้า Master Page 
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  เมื่อเข้าถึงพ้ืนที่การท างานในหน้า Master Page แล้ว ผู้ปฏิบัติงาน
ต้องท าการออกแบบตามที่ได้ก าหนดไว้ในดัมมี่ คือ การออกแบบลวดลายพ้ืนหลัง การก าหนดเลขหน้า ซึ่งจะ
เป็นต้นแบบให้ส าหรับทุกหน้าในจดหมายข่าว ตามล าดับขั้นตอน ดังนี้  

2.1) การออกแบบลวดลายพ้ืนหลังของหน้า Master Page A , 
หน้าปก หรือ หน้าที่ 1 จดหมายข่าวสภามหาวิทยาลัยฯ โดยผู้ปฏิบัติงานจะต้องท าการออกแบบลวดลายพ้ืน
หลัง โลโก้ และสัญลักษณ์ของมหาวิทยาลัย ในรูปแบบไฟล์ภาพสกุล .jpg ส าหรับภาพพ้ืนหลัง และไฟล์
สกุล .psd ส าหรับโลโก้และสัญลักษณ์มหาวิทยาลัยฯ  มีความละเอียดไม่ต่ ากว่า 300 dpi เตรียมไว้ แล้วคลิก
ไปทีห่น้า Master Page เพ่ือให้เปลี่ยนหน้าเป็นพื้นที่ท างานของหน้า Master Page A ดังแสดงภาพที่ 4-14  
 
 
 
 
 
 
 
 
 

ภาพที่ 4-14  แสดงหน้าการท างานที่เลือกใช้ในหน้า Master Page 
จากนั้นเลือกพ้ืนที่ท างานหน้า Master Page A ด้านขวา ใช้

ก าหนดสีที่ต้องการใช้ซึ่งเป็นสีประจ ามหาวิทยาลัยฯ ใส่รหัสโค๊ดสีโดย ดับเบิ้ลคลิกที่เครื่องมือกลุ่ม Fill Box 
Tool      ส าหรับใส่สีพ้ืนจะปรากฎหน้าต่างให้ระบุโค๊ดสี ดังนี้ C = 70 M = 100 Y = 0 K = 0 แล้วคลิกปุ่ม 
OK ดังแสดงภาพที่ 4-15 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-15 แสดงการใส่สีพื้นใช้วาดรูปทรง 

หน้าการท างานที่เลือก คือ หน้า Master Page A 

ใส่โค๊ดสี 

แสดงสีที่ถูกระบุ คลิกปุ่ม OK 
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 เมื่อก าหนดสีได้ตามที่ต้องการแล้ว จากนั้นใช้เครื่องมือ         
Pen Tool (P) ใช้ส าหรับวาดรูปทรงตามที่ได้ออกแบบไว้ในดัมม่ี ดังแสดงภาพที่ 4-16  
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-16  แสดงการใช้เครื่องมือ Pen Tool ภาพวาดรูปทรง 
 
 จากนั้นใช้ค าสั่ง เมนู File > Place เลือกไฟล์โลโก้ท่ีได้เตรียม
ไว้ จัดวางตามท่ีได้ก าหนดไว้ในดัมมี่ ดังแสดงภาพที่ 4-17 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-17  แสดงค าสั่งการเรียกภาพโลโก้เข้ามาใช้งาน 
 

รูปทรงที่ใช้เครื่องมือ Pen Tool สร้างข้ึน 
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ภาพที่ 4-17  แสดงค าสั่งการเรียกภาพโลโก้เข้ามาใช้งาน (ต่อ) 
 
 การจัดวางตัว อักษรหัว เรื่ องหนั งสือจดหมายข่าวสภา
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร โดยการเลือกค าสั่ง Window > Type & Table > character หรือ
ใช้คีย์ลัด Ctrl + T   ดังแสดงภาพที่ 4-18 จากนั้นใช้เครื่องมือ Type Tool (T) คลิกในพ้ืนที่ท างาน ลากเม้าส์
ให้ขึ้นกรอบสี่เหลี่ยมจะขึ้นเคอร์เซอร์ใช้ส าหรับพิมพ์ จึงท าการพิมพ์ข้อความตามที่ก าหนดไว้ “ข่าวสารสภา มท
ร.พระนครสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร RMUTP COUNCIL NEWSLETTER” จัดวางตาม
รปูแบบดัมมี่ ดังแสดงภาพที่ 4-19 
 
  
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-18  แสดงการเรียกค าสั่งส าหรับพิมพ์ข้อความ 

คลิกเมนู Window > Type & Table > Character (Ctrl + T) 

หน้าต่างส าหรับเลือกรูปแบบและขนาดอักษร 
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ภาพที่ 4-19 แสดงตัวอย่างการพิมพ์ข้อความหน้าปกจดหมายข่าว 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-20  แสดงตัวอย่างหัวจดหมายข่าวสภามหาวิทยาลัยฯ ในหน้า Master Page A 
 
 เมื่อได้หัวกระดาษจดหมายข่าวสภาฯ ตามที่ได้ออกแบบไว้
แล้ว ล าดับถัดไปเป็นการจัดวางลวดลายพ้ืนหลัง  
 2.2)  การใส่ลวดลายพ้ืนหลัง โดยใช้พ้ืนหลังที่ได้ท าการออกแบบ
เตรียมไว้ โดยใช้ค าสั่งคลิกเมนู File > Place >  เข้าพ้ืนที่เก็บข้อมูลที่เตรียมไว้ จากนั้นเลือกพ้ืนหลังที่เตรียมไว้ 
เมื่อเรียกภาพได้แล้ว บนเคอร์เซอร์เม้าส์จะมีรูปเล็ก ๆ ติดอยู่ที่ปลายเคอร์เซอร์เม้าส์ ให้ท าการคลิกที่พ้ืนที่
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ท างานในหน้า Master ภาพเล็กๆ บนเคอร์เซอร์จะขยายขึ้น น ารูปภาพที่ได้มาวางเป็นหลังของหน้า Master 
Page A ดังแสดงภาพที่ 4-21 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-21 แสดงขั้นตอนต่อไปกลับไปที่หน้า Page ที่ใช้ในการจัดหน้า เริ่มต้นที่หน้าแรกหน้าที่ 1 
    
 2.3)  การใส่เลขหน้าในหน้า Master Page เมื่อวางพ้ืนหลังเสร็จ
เรียบร้อยแล้ว ขั้นตอนสุดท้ายของการสร้างหน้า Master Page A เป็นการสร้างเลขหน้า ซึ่งเลขหน้าที่สร้างขึ้น
ในหน้า Master Page นี้ จะปรากฎทุกหน้าที่เรียกใช้ Master Page แต่ตัวเลขจะเปลี่ยนไปตามจ านวนหน้านั้น 
ๆ โดยคลิกเครื่องมือ Type Tool (T) ท าการลากเม้าส์ให้ขึ้นเคอร์เซอร์ส าหรับพิมพ์ข้อความ กดแป้นพิมพ์โดย
ใส่โค๊ด Ctrl + Alt + shift + N ในช่องพิมพ์ข้อความจะปรากฎตัวอักษร A  ซึ่งแสดงว่าหน้าที่ท า Master คือ
หน้า Master Page A ดังแสดงภาพที่ 4-22 แล้วจัดวางตามท่ีได้ออกแบบไว้ 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-22  แสดงการใส่เลขหน้าในหน้า Master Page  A 
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 หน้า Master Page A ที่ได้ท าการออกแบบเสร็จเรียบร้อย
แล้ว จะปรากฎอยู่ในหน้าเนื้อหาในหน้าที่เรียกใช้ Master Page A  ดังแสดงภาพที่ 4-24 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-23  แสดงการเรียกใช้หน้า Master Page A 
 2.4)  การออกแบบหน้าลวดลายพ้ืนหลังของหน้า Master Page B 
และ Master Page  C  ซึ่งมีวิธีการคล้ายกับการออกแบบลวดลายพ้ืนหลังหน้า Master Page A โดยเริ่มจาก
หน้า Master B ด้วยการคลิกที่เมนู Page > เลือกหน้า Master Page B จะปรากฎหน้าต่างพ้ืนที่การท างาน
ของหน้า Master Page B ดังแสดงภาพที่ 4-24 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-24  แสดงการเลือกหน้า Master Page B 

คลิกหน้าที่1เพ่ือตรวจดูการเรียกใช้ 
Master Page A 

รูปแบบหน้าที่ 1 ที่ใช้หน้า Master Page A 

คลิกท่ี B Master 

พ้ืนที่การท างานหน้า Master Page  B 
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 จากนั้นท าการจัดวางรูปแบบตามที่ได้ออกแบบไว้ โดยใช้
ขั้นตอนเดียวกับการออกแบบลวดลายพื้นหลังของหน้า Master Page A โดยจัดวางในหน้าซ้ายมือ ด้านบนหัว
กระดาษใส่โลโก้ RMUTP ด้านล่างวางข้อความ “RMUTP COUNCIL NEWSLETTER”  ใส่โค๊ดส าหรับใส่เลข
หน้า โดยใช้เม้าส์คลิก เครื่องมือ Pen Tool แล้วลากเพ่ือสร้างกรอบพิมพ์ข้อความ แล้วใช้โค๊ด (Ctrl +Alt + 
Shift + N)  อักษรแสดงเลขหน้าจะแสดงให้รู้ว่าเป็นหน้า Master Page B ดังแสดงภาพที่ 4-25 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-25  แสดงการใส่เลขหน้าในหน้า Master Page B 
 
 ต่อมาท าการจัดวางรูปแบบพ้ืนหลังในหน้า Master Page C 
ด้านบนและด้านล่างของหน้ากระดาษวางลายเส้นและใส่เลขหน้าตามที่ได้รับการออกแบบไว้ ซึ่งมีข้อสังเกตุที่
แตกต่างกันคือ เลขหน้าที่ปรากฎในหน้า Master Page ในแต่ละหน้าจะแสดงตัวอักษรที่แตกต่างกัน เช่น ใน
หน้า Master A ต าแหน่งที่ระบุเลขหน้าก็จะเป็นตัวอักษร A ในหน้าที่เป็น Master B และหน้า Master C 
ต าแหน่งที่ระบุเลขหน้าก็จะเป็นตัวอักษร B และ C ตามล าดับ ดังแสดงภาพที่ 4-26  
 
 
 
 
 
 
 
 
 

ภาพที่ 4-26  แสดงการใส่เลขหน้าในหน้า Master Page B และ Master Page C 

หน้า Master B 

แสดงเลขหน้าของ Master Page 

B 

หน้า Master Page B หน้า Master C 

เลขหน้าที่แสดงใน Master C เลขหน้าที่แสดงใน Master B 
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 เมื่อได้พ้ืนหลังในหน้า Master Page A, B และ C ทั้ง 3 ที่ได้
ออกแบบเตรียมไว้แล้ว ให้คลิกที่ Master Page B แล้วลากมาไว้ที่หน้าที่ต้องการด้านซ้าย และลาก Master 
Page C ไปไว้ที่หน้าที่ต้องการด้านขวา ดังแสดงภาพที่ 4-27 
 
 
 
 
 
 
 
 
 
 

ภาพที ่4-27  แสดงตัวอย่างการลากหน้า Master Page B มาใช้งาน 
3) ขั้นตอนที่ 3  การจัดหน้าเนื้อหาและรูปภาพประกอบส าหรับหน้าแรกของจดหมาย

ข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
 ในขั้นตอนนี้เป็นการท างานร่วมกันของโปรแกรมคอมพิวเตอร์ส าเร็จ 2 
โปรแกรม ได้แก่ Microsoft Office Word และ โปรแกรม Adobe InDesign โดยท าการคัดลอกข้อความจาก 
Word ไปวางในโปรแกรมจัดหน้า ซึ่งมวีิธีการท างานดังต่อไปนี้ 
 3.1) เปิดโปรแกรม Microsoft Office Word  เปิดไฟล์ข้อมูลเนื้อหาที่
ใช้ในการจัดหน้าเนื้อหา เช่น ไฟล์หน้าที่ 1 ซึ่งทางหน่วยงานที่ขอความอนุเคราะห์ได้รวบรวมเตรียมไว้และส่งมา
ให้ ดังแสดงภาพที่ 4-28 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-28  โปรแกรม Microsoft Office Word ไฟล์มติการประชุมสภามหาวิทยาลัยฯ 

คลิกแล้วลากมาวาง

ไว้ที่หน้าที่ต้องการ 

พ้ืนที่การท างาน 
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3.2)  เตรียมหน้าที่ 1 ในโปรแกรม Adobe InDesign ไว้ ในหน้าที่ 1 
ให้ขยายภาพไปที่ใต้โลโก้         ใช้เครื่องมือ Type Tool สร้างกรอบส าหรับพิมพ์ข้อความ จากนั้นพิมพ์ฉบับ
เดือน... เมื่อพิมพ์เสร็จแล้ว ให้ดูที่แถบค าสั่งเสริมด้านบนตรงช่องชื่อรูปแบบตัวอักษร แล้วท าการเลือกฟอนต์
ชื่อ DB ChidlomX ซึ่งเป็นฟอนต์ประจ ามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ดังแสดงภาพที่ 4-29  
 
 
 
 
 
 

Type equation here. 
 
 
 
 
 
 

ภาพที่ 4-29  แสดงการใส่ตัวอักษรฉบับที่... 
 3.3)  กลับไปท่ีโปรแกรม Microsoft Office Word แล้วท าการคัดลอก 
โดยใช้คีย์ลัด Ctrl + C คัดลอกข้อความท่ีต้องการ  ดังแสดงภาพที่ 4-30 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-30  แสดงวิธีการคัดลอกในโปรแกรม Microsoft Office Word 

เลือกรูปแบบตัวอักษร ชื่อ DB ChidlomX 

ใช้เครื่องมือ Type Tool สร้าง
กล่องพิมพ์ข้อความ พิมพ์ฉบับที่... 

คัดลอกโดยใช้คีย์ลัด Ctrl + C 
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3.4)  กลับมาที่โปรแกรม Adobe InDesign ใช้เครื่องมือ         
Rectangle Tool สร้างรูปทรงสี่เหลี่ยมผืนผ้า ช่องเล็กใช้เป็นหัวข้อจากนั้นไปที่ Window >  Object & 
Layout > Pathfinder จะปรากฎหน้าต่างของ Pathfinder หัวข้อ Convert Shape เลือกรูปแบบสี่เหลี่ยม
ขอบมน และใช้เครื่องมือ         Type Tool  สร้างกล่องพิมพ์ข้อความ พิมพ์หัวข้อ “ประเด็นข่าว” ดังแสดง
ภาพที่ 4-31 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-31  แสดงการสร้างข้อความหัวข้อ “ประเด็นข่าว” 
 เมื่อได้พ้ืนที่ส าหรับเน้นข้อความส าหรับหัวข้อ “ประเด็นข่าว” 
แล้ว จึงน าข้อความที่คัดลอกไว้จากโปรแกรม Microsoft Office Word มาวางในโปรแกรม Adobe InDesign 
โดยการสร้างกล่องส าหรับพิมพ์ข้อความ ใช้คีย์ลัดเช่นเดียวกับใช้ในโปรแกรม Microsoft Office Word คือ 
Ctrl + V ซึ่งจะปรากฎข้อความที่ได้ท าการคัดลอกมาจากโปรแกรม Microsoft Office Word ดังแสดงภาพที่ 
4-32 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-32  แสดงการวางข้อความในโปรแกรม Adobe InDesign 

ใช้เครื่องมือสร้างรูปสี่เหลี่ยมผืนผ้า 

ใช้เครื่องมือ Type Tool 
สร้างกล่องพิมพ์ข้อความ 

ใช้คีย์ลัด Ctrl + V วางข้อความและ
เลือกฟอนต์และขนาดของฟอนต์ 
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 เมื่อวางข้อความที่คัดลอกมาเป็นที่เรียบร้อยแล้ว ต้องท าการ
เลือกรูปแบบของตัวอักษรและก าหนดขนาด ซึ่งในการจัดหน้าหนังสือโดยทั่วไป การก าหนดขนาดของตัวอักษร
จะต้องใช้ขนาดที่สามารถอ่านได้ชัดเจน ซึ่งขนาดที่เหมาะสม คือ ขนาด 16 pt ส าหรับเนื้อหา และขนาด 18-
20 pt ส าหรับหัวข้อหรือประเด็นส าคัญ ท าการจัดเรียงข้อความให้เหมาะสม โดยการตกแต่งกราฟิกตรงหัวข้อ
ส าคัญ ดังแสดงภาพที่ 4-33 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-33  แสดงการจัดรูปแบบข้อความในหัวข้อประเด็นข่าว 

 ต่อมาท าการคัดลอกหัวข้อประเด็นข่าว ทั้งกล่องพิมพ์ข้อความ
และภาพกราฟิก โดยคลิกลากครอบตรงหัวข้อประเด็นข่าวจนขึ้นขาของกล่องข้อความ พร้อมทั้งการใช้
แป้นพิมพ์ Shift + Alt แล้วลากลงมาวางในต าแหน่งที่ต้องการ ดังแสดงภาพที่ 4-34 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-34  แสดงการคัดลอกข้อความโดยใช้คคีย์ลัด 
  จากนั้นดับเบิ้ลคลิกที่ข้อความให้ขึ้นเคอร์เซอร์ส าหรับพิมพ์ ใช้
ค าสั่งคีย์ลัด Ctrl + A  จะเกิดแถบด าขึ้น ท าการพิมพ์ข้อความใหม่ “บทความพิเศษ” ดังแสดงภาพที่ 4-35
  

คลิกครอบส่วนที่ต้องการ พร้อมใช้คีย์ลัด Shift + Alt พร้อม
ทั้งลากส่วนที่ต้องการคัดลอกมาไว้ตรงที่ต้องการ 
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ภาพที่ 4-35  แสดงวิธีการเพ่ิมและเปลี่ยนข้อความบนหัวข้อ 

 3.5) สร้างข้อความส าหรับหัวข้อเรื่องบทความพิเศษ ซึ่งจะเปลี่ยนไป
ตามความเหมาะสม ซึ่งหน่วยงานที่ขอความอนุเคราะห์จะเป็นผู้ก าหนดหัวข้อของบทความพิเศษ โดยท าการ
คัดลอกข้อความจากโปรแกรม Microsoft Office Word น ามาวางในกล่องข้อความของโปรแกรม Adobe 
InDesign ท าการสร้างกล่องข้อความโดยแบ่งข้อความที่คัดลอกมา ใส่สีข้อความ ปรับขนาดจัดวางให้เหมาะสม 
และท าการจัดกลุ่มข้อความ โดยคลิกครอบกล่องข้อความให้ขึ้นขากล่องข้อความ และใช้ค าสั่ง Ctrl + G จะ
เป็นการจัดกลุ่มข้อความให้เป็นกลุ่มก้อนเดียวกัน  
 และท าการคัดลอกขึ้นมาอีกกลุ่มหนึ่ง ซึ่งกลุ่มข้อความแรกจะ
เป็นเลเยอร์หลัง และกลุ่มข้อความที่เพ่ิงท าการคัดลอกมาจะเป็นกลุ่มข้อความที่อยู่ เลเยอร์หน้าสุด คลิกเลือก
กลุ่มข้อความที่ 1 ท าการใส่สีพ้ืนและสีเส้นของกลุ่มข้อความส าหรับเป็นตัวรองพ้ืนหลัง และออกแบบใส่สีชุด
ข้อความที ่2 ที่ อยู่ เลเยอร์ด้านหน้าสุดให้สวยงาม ดังแสดงภาพที่ 4-36 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-36  แสดงการสร้างหัวข้อโดยการท าข้อความซ้อน 

ดับเบ้ิลคลิก กดCtrl + A ขึ้นแถบ
ด า พิมพ์ข้อความใหม่ลงไป 

1 

2 
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 จากนั้นคลิกที่ชุดกลุ่มข้อความทั้งสองกลุ่มโดยการคลิกที่กลุ่ม
ข้อความชุดที่ 1 และกด Shift ค้างไว้ และคลิกที่กลุ่มข้อความชุดที่ 2 จนขึ้นขากลุ่มทั้งคู่ ท าการคลิกที่แถบ
ค าสั่งเสริมด้านบน โดยคลิกที่ค าสั่งเสริม Align vertical centers            หนึ่งครั้ง และคลิกที่ค าสั่งเสริม 
Align horizontal centers          ซึ่งเป็นการจัดระเบียบข้อความที่ซ้อนทับกัน จากนั้นท าการจับกลุ่ม
ข้อความอีกครั้ง โดยใช้ค าสั่ง Ctrl + G ดังแสดงภาพที่ 4-37 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-37  แสดงการสร้างข้อความส าหรับหัวข้อของบทความพิเศษ 
 

 3.6)  เมื่อท าการออกแบบในส่วนแรกเรียบร้อยแล้ว ต่อมาเป็นการจัด
วางรูปภาพประกอบตามที่ได้เลือกเตรียมไว้ โดยการใช้ค าสั่งเมนู File > Place จะปรากฎหน้าต่างที่เก็บไฟล์
รูปภาพประกอบคอลัมน์บทความพิเศษ เลือกรูปภาพที่ต้องการ หลังจากคลิกเลือกภาพแล้ว ในหน้าโปรแกรม 
Adobe InDesign บนเม้าส์เคอร์เซอร์จะมีตัวอย่างรูปภาพขนาดเล็กติดอยู่ เมื่อคลิกวางที่พ้ืนที่ท างานบนหน้า
โปรแกรมรูปภาพนั้นก็จะขยายใหญ่ขึ้น ดังแสดงภาพที่ 4-38 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-38  แสดงการใช้ค าสั่งเรียกรูปภาพเพ่ือมาวางประกอบ 

ค าสั่งเมนFูile > Place 
เลือกเรียกรูปภาพที่ต้องการ 

ตัวอย่างรูปภาพที่ติดอยู่บนเคอร์เซอร์ 
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 คลิกวางรูปภาพบนพ้ืนที่งาน จากนั้นท าการขยายภาพโดยคลิกท่ี
มุมขอบภาพเพ่ือให้แสดงกรอบของรูปภาพขึ้น ในขณะเดียวกันก็ใช้ค าสั่งคีย์ลัด Ctrl + Shift และคลิกลากย่อ
ขยายภาพจนได้ขนาดตามต้องการ จากนั้นจัดวางตามต าแหน่ง ดังแสดงภาพที่ 4-39 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-39  แสดงการจัดวางรูปภาพในหน้าแรก 
 

หมายเหตุ :  ข้อควรระวังถ้าหากไม่ใช้ค าสั่งคีย์ลัดพร้อมกับการใช้เม้าส์ รูปภาพที่เลือกจะไม่ย่อขยาย แต่จะ  
ขยายเฉพาะกรอบนอกของรูปภาพ  

 
 และท าการเรียกรูปภาพซ้ าและจัดวางรูปภาพทั้งหมดที่ เตรียมไว้
ให้เป็นภาพประกอบส าหรับหน้าแรกตามต าแหน่งที่ได้รับการออกแบบไว้ในดัมมี่  ซึ่งจะได้หน้าแรกของ
จดหมายข่าวสภามหาวิทยาลัยฯ ดังแสดงภาพที่ 4-40 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-40  แสดงการจัดหน้าแรกส าหรับจดหมายข่าวสภามหาวิทยาลัยฯ 
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4)  ขั้นตอนที่ 4 การจัดหน้าเนื้อหาและรูปภาพประกอบ ส าหรับหน้าเนื้อหาด้านใน 
(หน้าที่ 2) 

หลังจากการด าเนินการจัดหน้าเนื้อหาและรูปภาพประกอบส าหรับหน้า
แรกเรียบร้อยแล้ว ขั้นต่อมาเป็นการด าเนินการจัดเนื้อหาส าหรับหน้าที่ 2 ,3 และ 4 ซึ่งมีการแบ่งเนื้อหาและ
รูปภาพเป็นคอลัมน์ โดยมีวิธีการและขั้นตอนการด าเนินงานดังต่อไปนี้ 

4.1) ในโปรแกรม Adobe InDesign ใช้เม้าส์คลิกเลือกหน้า Master 
Page B แล้วลากไปวางไว้ในหน้าที่ 2 และหน้าที่ 4 ที่หน้าต่าง Page ส าหรับแสดงจ านวนหน้าทั้งหมดจะแสดง
ให้การเรียกใช้ Master page เป็นสัญลักษณ์ ดังแสดงภาพที่ 4-41 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-41  แสดงการเลือกใช้หน้า Master page B ส าหรับหน้าที่ 2 และหน้าที่ 4 
 

4.2) ไปที่โปรแกรม Microsoft Office Word เปิดไฟล์ข้อมูลเนื้อหาที่
หน่วยงานขอความอนุเคราะห์ได้จัดพิมพ์มาให้แล้ว ท าการคัดลอกข้อความหัวข้อเรื่องมติที่ประชุม  ตัวอย่าง 
“การประชุมสภามหาวิทยาลัย ครั้งที่ 11/2563 เมื่อวันที่ 18 พฤศจิกายน 2563” โดยคลิกแล้วลากให้เกิดแถบ
ด าแล้วใช้ค าสั่งคัดลอก Ctrl + C ไว้บนคลิปบอร์ด จากนั้นกลับไปที่โปรแกรม Adobe InDesign 

4.3) ในโปรแกรม Adobe InDesign ให้ดับเบิ้ลคลิกที่หน้าที่ 2 ขยาย
พ้ืนที่การท างานไปที่หัวกระดาษด้านบน จากนั้นใช้เครื่องมือ Type Tool (T) คลิกลากเคอร์เซอร์ (Cursor) ให้
ขึ้นกล่องส าหรับพิมพ์ข้อความ วางข้อความที่คัดลอกมาจากโปรแกรม Microsoft Office Word ท าการเลือก
รูปแบบตัวอักษร ก าหนดเป็น DB ChidlomX และก าหนดขนาด 16 pt วางไว้ด้านบนหัวกระดาษ ดังแสดง
ภาพที่ 4-42  

 

คลิกลาก Master page B มาวางไว้
ที่หน้าที่ 2 และหน้าที่ 4 
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ภาพที่ 4-42  แสดงการวางข้อความการประชุมครั้งที่... 
 
 4.4)  การเพ่ิมคอลัมน์แนวตั้ง โดยไปที่เมนู Layout > Margins & 
Columns ดังแสดงภาพที่ 4-43 จะปรากฎหน้าต่างค าสั่งของ Margins & Columns ในช่อง Columns > 
Number ให้ท าการเพิ่มจ านวนคอลัมน์โดยการกรอกตัวเลข 2 แล้วคลิกปุ่ม OK  (อดิศักดิ์, 2553) ดังแสดงภาพ
ที่ 4-44 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-43  แสดงการใช้ค าสั่งเพิ่มจ านวนคอลัมน์ในหน้าพ้ืนที่ท างาน 

เลือกรูแบบตัวอักษรและก าหนดขนาด 

ใช้เครื่องมือ Type Tool ในการสร้างข้อความ 

คลิกค าสั่งเมนู Layout > Margins and Columns 
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ภาพที่ 4-44  แสดงการใช้ค าสั่ง Margins and Columns 
 4.5) สร้างกล่องข้อความส าหรับหัวข้อเรื่องเสนอพิจารณา โดยการ
คัดลอกข้อความและกรอบของข้อความหัวข้อมาจากหน้าแรก โดยใช้เม้าส์คลิกลากครอบข้อความและกรอบ
ข้อความ ใช้ค าสั่ง Ctrl+ C จากนั้นดับเบิ้ลคลิกที่หน้าที่ 2 และใช้ค าสั่ง Ctrl + V และจัดวางในต าแหน่งที่
เหมาะสม เพ่ือให้ได้รูปแบบเดียวกัน แล้วท าการเปลี่ยนข้อความและลดขนาดตัวอักษรให้อยู่ในกรอบให้เป็น
หัวข้อเรื่องเสนอเพ่ือพิจารณา ดังแสดงภาพที่ 4-45 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-45  แสดงการคัดลอกกรอบข้อความของหัวข้อ 

ช่องส าหรับก าหนดจ านวน
คอลัมน์ 

คลิกท่ีปุ่ม เพ่ือยืนยัน
ค าสั่ง 

เส้นแบ่งจ านวนคอลัมน์ 
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 4.6)  ท าการคัดลอกข้อความเนื้อหาจากโปรแกรม Microsoft Office 
Word เริ่มจากหัวข้อวาระการประชุม หัวข้อที่ 1 โดยใช้ค าสั่งคัดลอก Ctrl + C ไว้บนคลิปบอร์ด ดังแสดงภาพ
ที่ 4-46  
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-46  แสดงการคัดลอกข้อความหัวข้อของมติที่ประชุมสภามหาวิทยาลัยฯ 
 

 4.7)  น าข้อความที่คัดลอกมาวางในโปรแกรม Adobe InDesign โดย
ใช้เครื่องมือ Type Tool (T) คลิกแล้วลากให้เกิดกล่องส าหรับพิมพ์ข้อความ จนขึ้นเคอร์เซอร์ (Cursor) ค าสั่ง 
Ctrl + V  เพ่ือวางข้อความ จากนั้นใช้ค าสั่ง Ctrl + A เพ่ือเลือกข้อความทั้งหมดจนขึ้นแถบด า ดังแสดงภาพที่ 
4-47  
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-47  แสดงการสร้างหัวข้อวาระการประชุมสภาฯ 

ใช้ค าสั่งคัดลอก Ctrl + C 

ใช้ค าสั่ง Ctrl + V และใช้ค าสั่ง Ctrl 
+ A 



 
 

 

86 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 4.8)  ท าการเลือกรูปแบบตัวอักษร โดยเลือกใช้รูปแบบ DB ChidlomX 
ขนาด 16 pt เมื่อท าการเลือกรูปแบบตัวอักษรและขนาดเรียบร้อยแล้ว ให้ท าการบันทึกรูปแบบตัวอักษร
ส าหรับหัวข้อ เพ่ือให้สะดวกส าหรับการใช้งานในหัวข้อถัดไป โดยใช้เม้าส์คลิกที่กล่องข้อความ ไปที่ค าสั่งเมนู 
Window > Styles > Character Styles  หรือใช้ค าสั่ง Shift +  F11 ดังแสดงภาพที่ 4-48 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-48  แสดงการวิธีใช้ค าสั่งบันทึกรูปแบบตัวอักษรส าหรับหัวข้อการประชุม 

   

  จะปรากฎหน้าต่างค าสั่ง Character Styles คลิกที่ Option 
Character Styles เลือก New Character Styles จากนั้นจะขึ้นหน้าต่างค าสั่ง New Character Styles ใน
ช่อง Styles Name ให้ระบุชื่อว่า “หัวข้อวาระการประชุม” ในส่วนของช่อง Styles Setting จะระบุ
รายละเอียดรูปแบบตัวอักษร ขนาด และโค๊ดสีที่ใช้ และคลิกปุ่ม OK ดังแสดงภาพที่ 4-48 (ต่อ) 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-48 แสดงการวิธีใช้ค าสั่งบันทึกรูปแบบตัวอักษรส าหรับหัวข้อการประชุม (ต่อ) 

ใช้เม้าส์คลิกเลือกท่ี
กล่องข้อความ การเรียกใช้ค าสั่ง Window > Styles > 

Character Styles   

คลิกท่ี Option Character Styles 
ระบุชื่อในช่อง Styles Name 

Styles Setting ที่ระบุรายละเอียด 
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 ในหน้าต่าง Character Styles จะปรากฎรูปแบบตัวอักษรที่
บันทึกไว้ ดังแสดงภาพที่ 4-49 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-49  แสดงชื่อรูปแบบตัวอักษรที่บันทึกไว้ใน Character Styles 

 
 4.9)  กลับไปที่โปรแกรม Microsoft Office Word ท าการคัดลอกมติ
ที่ประชุมสภาและน าไปวางในโปรแกรมจัดหน้า Adobe InDesign โดยใช้วิธีการวางข้อความ เช่นเดียวกันใน
ข้อ 7 ของขั้นตอนที่ 4  
 ใช้ค าสั่ง Ctrl + A ให้เกิดแถบด า เลือกรูปแบบตัวอักษร โดย
ก าหนดให้เลือกใช้รูปแบบ PSLxText ก าหนดขนาด 16 pt  จากนั้นคลิกที่กล่องข้อความให้เกิดขา ไปที่เมนู 
Window > Type & Tables > Paragraph ดังแสดงภาพที่  4-50 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-50  แสดงการใช้ค าสั่งเรียกหน้าต่าง Paragraph 

ชื่อรูปแบบตัวอักษรที่บันทึกไว้ 

การเรียกหน้าต่าง Paragraph  
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 จะปรากฎหน้าต่าง Paragraph เลือกรูปแบบการจัดเรีย ง
ข้อความ Justify with last line aligned left ไปที่ Option Paragraph > เลือก Justification ดังแสดงภาพ
ที่ 4-51 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-51  แสดงการเรียกหน้าต่าง Justification 
  ท าการปรับระยะช่องไฟให้เหมาะสม ให้ท าการตั้งค่าใน
หน้าต่าง Justification หรือกดปุ่มลัด Shift + Option + Command + J ซึ่งจะช่วยให้ระยะช่องไฟและการ
ตัดค าประโยคในภาษาไทยสวยงาม (เกียรติประถม, 2552) ดังนี้ ดังแสดงภาพที่ 4-52 
     Minimum  Desired  Maximum 
   Word Spacing        70%  100%   120% 
 Letter Spacing -5%    0%   25% 
 Glyph Scaling 100%  100%  100% 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-52  แสดงภาพการตั้งค่าการปรับระยะช่องไฟ 

Option 

เลือกรูปแบบการจัดเรียง
ข้อความ

ส าหรับตั้งค่าการปรับระยะช่องไฟ 

คลิกปุ่ม OK 
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 รูปแบบข้อความที่ได้จะมีการเว้นระยะช่องไฟที่เหมาะสม 
สวยงาม กั้นหลังชิดเสมอกัน ดังแสดงภาพที่ 4-53 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-53  แสดงข้อความท่ีได้จัดหน้าเรียบร้อย 
 
 จากนั้นท าการบันทึ3กรูปแบบการใช้ตัวอักษร ตามข้อ 8 
ของขั้นตอนที่ 4 และบันทึกรูปแบบการจัด Paragraph โดยใช้ค าสั่งเมนู Window > Styles > Paragraph 
Styles ดังแสดงภาพที่ 4-54  
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-54  แสดงการใช้ค าสั่งเรียกหน้าต่าง Paragraph Styles 
 

การเรียกหน้าต่าง Paragraph Styles 
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 ปรากฎหน้ าต่ า ง  Paragraph Styles คลิกที่  Option 
Paragraph Styles > New Paragraph Styles ดังแสดงภาพที่  4-55 จากนั้นท าการบันทึก Paragraph 
Styles โดยในช่อง Styles Name ให้บันทึกชื่อ “เนื้อหามติที่ประชุม” ซึ่งในช่อง Styles Setting  จะระบุ
รายละเอียดของการจัด Paragraph Styles ที่ท าการบันทึกไว้ คลิกปุ่ม OK ดังแสดงภาพที่ 4-56  
 
 
 การใส่ภาพประกอบเนื้อหา 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 4-55  แสดงการใช้ค าสั่งเรียกหน้าต่าง New Paragraph Styles 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-56  แสดงการบันทึกการตั้งค่า Paragraph Styles 

Option Paragraph Styles 

Styles Name 

Styles Setting 

คลิกปุ่ม OK  
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 ดั งนั้น ในหน้าต่ าง  Paragraph Styles จะปรากฎชื่อ 
Styles ที่ได้ท าการบันทึกไว้ แสดงว่าการบันทึกส าเร็จ ดังแสดงภาพที่ 4-57 
 
 
 
 
 
 
 
ภาพที่ 4-71  แสดงการใช้ค าสั่งเรียกหน้าต่าง Paragraph Style 
 
 
 
 

 
ภาพที่ 4-57  แสดงการบันทึก Paragraph Styles ที่บันทึกส าเร็จแล้ว 

 
 ค าสั่งการท างานหน้าต่างที่เรียกเปิดขึ้นมาทั้งหมด จะถูก
รวบรวมมาเก็บไว้ที่ Panelsด้านข้าง เพ่ือให้สะดวกต่อการเรียกใช้งานโดยไม่ต้องย้อนกลับไปใช้ค าสั่งเปิด
หน้าต่างที่ต้องการใช้ใหม่ทุกครั้ง ดังแสดงภาพที่ 4-58 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-58  แสดงหน้าต่างค าสั่งที่เรียกเปิดใน Panels 

Paragraph Styles ที่ท าการบันทึกไว้ 

ค าสั่งที่เคยเรียกเปิดใน Panels 
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 4.10)  การแทรกรูปภาพประกอบเนื้อหา หลังจากที่ท าการจัดวาง
หัวข้อวาระการประชุม และเนื้อหามติที่ประชุมเรียบร้อยแล้ว ล าดับต่อไปเป็นการแทรกเพ่ิมรูปภาพประกอบ
ส าหรับเนื้อหาการประชุม ซึ่งรูปภาพที่ใช้ในการประกอบเนื้อหานี้จะต้องมีความสอดคล้องและเหมาะสมกับ
เนื้อหา โดยผู้ปฏิบัติงานจะต้องท าการตรวจสอบคุณภาพของภาพเตรียมให้พร้อมก่อนด าเนินการจัดหน้า เพ่ือ
ความรวดเร็วในการปฏิบัติงาน  
 ในการแทรกรูปภาพในโปรแกรม Adobe InDesign จ าเป็น
จะต้องใช้ค าสั่งที่ใช้ส าหรับการแทรกรูปภาพ เพ่ือให้โปรแกรมสามารถเปิดระบบลิงค์รูปภาพได้อย่างถูกต้อง ซึ่ง
ผู้ปฏิบัติงานสามารถท าไดโ้ดยใช้ค าสั่งไปที่เมนู File > Place หรือใช้คีย์ลัด Ctrl + D ดังแสดงภาพที่ 4-59  
 
 
 
 
 
 
 
 
 
 

 
 
 

ภาพที่ 4-59  แสดงการใช้ค าสั่งแทรกรูปภาพ 
   
 เมื่อท าการคลิกหรือใช้คีย์ลัดค าสั่งแทรกรูปภาพแล้ว โปรแกรม
จะปรากฎหน้าต่าง Place ซึ่งเป็นหน้าต่างที่ใช้ส าหรับเรียกแทรกรูปภาพประกอบ คล้ายกับโฟลเดอร์ที่ใช้เก็บ
ข้อมูลปกติที่ใช้บนเครื่องคอมพิวเตอร์ ซึ่งจะปรากฎหน้าแรกเป็นหน้าต่างที่รวมไดร์ฟต่างๆ ในเครื่อง
คอมพิวเตอร์ที่ใช้ท างาน หรือที่เรียกว่า This PC จากนั้นให้คลิกไปที่โฟล์เดอร์ที่ใช้เก็บไฟล์รูปภาพที่ได้เตรียมไว้ 
เช่น เก็บไฟล์รูปภาพไว้ที่โฟลเดอร์จดหมายข่าวสภาฯ ประจ าเดือน พ.ย.63 ให้คลิกเข้าไปที่เมนู File > 
Place > Drive D > จดหมายข่าวสภาฯ > พ.ย.63 > ชื่อของโฟล์เดอร์ภาพที่ต้องการใช้  ดังแสดงภาพที่ 4-60 
 
 
 
 

คลิกค าสั่ง File > Place 
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ภาพที่ 4-60  แสดงการใช้ค าสั่งแทรกรูปภาพประกอบเนื้อหา 

 
 จากนั้นคลิกเลือกรูปภาพประกอบที่ต้องการ และน ามาจัดวาง
ในหน้าเพจพ้ืนที่ท างาน ดังแสดงภาพที่ 4-61 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-61  แสดงการแทรกรูปภาพประกอบเนื้อหา 
 

 จากนั้นท าการจัดหน้าเนื้อหาในหน้าที่ 2 ให้ครบทุกข่าวตามที่
แบบร่างดัมมี่ที่ได้รับการออกแบบไว้ ดังแสดงภาพที่ 4-62 

เลือกที่อยู่ที่ใช้บันทึกไฟล์รูปภาพประกอบ 
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ภาพที่ 4-62  แสดงการจัดหน้าที่ 2 เสร็จเรียบร้อย 
 

 

5) ขั้นตอนที่ 5  การจัดหน้าเนื้อหาและรูปภาพประกอบ ส าหรับหน้าเนื้อหาด้านใน 
(หน้าที่ 3,4)  
 เมื่อด าเนินการจัดหน้าเนื้อหาและรูปภาพประกอบในหน้าที่  2 
เรียบร้อยแล้ว ในขั้นต่อไปเป็นการจัดหน้าส าหรับเนื้อหาหน้าที่ 3 และหน้าที่ 4  ซึ่งจะแตกต่างกันในส่วนของ
รูปแบบพื้นหลังทีไ่ด้ท าการออกแบบเตรียมไว้เรียบร้อยแล้วในหน้า Master Page โดยการเลือกใช้หน้า Master 
Page C จะใช้ส าหรับหน้าที่เป็นเลขคี่ และหน้า Master Page B ใช้ส าหรับหน้าคู่ ได้แก่หน้าที่ 2 และหน้าที่ 4 
ซึ่งมีข้ันตอนในการเปลี่ยนรูปแบบพื้นหลังให้เป็นหน้า Master ที่ต้องการได้ดังนี้   
 5.1) ในโปรแกรม Adobe InDesign ไปที่พาเนล Page ในช่องที่แสดง
หน้า Master  ให้คลิกที่ Master Page C แล้วท าการลากมาวางไว้ที่หน้าที่ 3 ซึ่งจะแสดงหน้า  Master ที่
เลือกใช้ตรงหัวมุม  ดังแสดงภาพที่ 4-63 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-63  แสดงการใช้หน้า Master Page C ในหน้าที่ 3 

คลิก Master Page C แล้วลากมาวางที่หน้า 3 



 
 

 

95 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 และที่พาเนล Page คลิกเลือกในส่วนของ Master Page B ให้
ท าการคลิกแล้วลากลงมาไว้ที่หน้าที่ 4 ก็จะแสดงสัญลักษณ์อักษร B บนหน้าที่ 4 แสดงว่าได้เลือกใช้หน้า 
Master Page ที่เลือกส าเร็จ ดังแสดงภาพที่ 4-64 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-64  แสดงการใช้หน้า Master Page B ในหน้าที่ 4 
 
 5.2)  ท าการจัดเรียบเรียงเนื้อหาและรูปภาพประกอบในหน้าที่ 3 
และหน้าที่ 4 ตามที่ได้รับการออกแบบไว้ โดยสามารถกลับไปดูวิธีการจัดหน้าได้ที่ข้ันตอนที่ 4 โดยจัดท าจบ
ครบทุกเนื้อหาทุกข่าวการประชุม ดังแสดงภาพที่ 4-65 และภาพที่ 4-66 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-65  แสดงตัวอย่างการจัดหน้าที่ 3 ที่ส าเร็จเรียบร้อยแล้ว 

คลิกแล้วลาก Master Page B มาไว้ที่หน้า4 
 



 
 

 

96 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 
 
 
 
 
 
 
 
 
 

 
ภาพที ่4-66  แสดงตัวอย่างการจัดหน้าที่ 4 ที่ส าเร็จเรียบร้อยแล้ว 

 

6) ขั้นตอนที่ 6  ท าการตรวจสอบความถูกต้องในการใช้โปรแกรม Adobe InDesign 
และการ Export File เป็น .pdf เพ่ือส่งให้หน่วยงานที่ขอความอนุเคราะห์ตรวจสอบ 
 โดยตรวจเช็คว่ามีตรงจุดไหนที่ผิดพลาด ทั้งในการใส่ข้อความเนื้อหา
และการเรียกลิงค์รูปภาพประกอบ โดยท าการตรวจเช็คง่าย ๆ ตรงด้านล่างหน้าต่างการท างาน ดังนี้ 
 6.1) ถ้ามีขั้นตอนใดในการจัดหน้าด้วยโปรแกรม Adobe InDesign ที่
ผิดพลาดจะปรากฎสัญลักษณ์สีแดง      และจ านวนตัวเลขจุดที่เกิดการ error ในแถบด้านล่างของหน้าต่าง
ท างาน และเมื่อคลิกเข้าไปตรงจุดสีแดง โปรแกรมจะแสดงรายละเอียดว่ามีความผิดปกติ ในส่วนใดบ้าง ดัง
แสดงภาพที่ 4-67 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-67  แสดงการตรวจเช็คจุดที่ผิดพลาด พร้อมทั้งรายละเอียดที่ผิดพลาด 

แสดงจุดที่ผิดพลาดในการ
จัดหน้า 

แสดงรายละเอียดว่าผิดพลาดส่วนไหน 



 
 

 

97 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 6.2) ถ้าในการจัดหน้าไม่มีขั้นตอนใดที่ผิดพลาด โปรแกรมจะปรากฎ
สัญลักษณ์สีเขียว        พร้อมข้อความ No error ในแถบด้านล่างของหน้าต่างการท างาน ดังแสดงภาพที่ 4-68 
 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 4-68  แสดงการตรวจเช็คจุดที่ไมผ่ิดพลาดในการใช้โปรแกรมจัดหน้า 
 
 6.3)  เมื่อท าการตรวจเช็คความถูกต้องเป็นที่ เรียบร้อยแล้ว 
ผู้ปฏิบัติงานจะท าการบันทึกไฟล์จัดหน้าจดหมายข่าวสภามหาวิทยาลัยฯ ให้อยู่ในรูปแบบไฟล์สกุล .pdf เพ่ือ
ส่งให้หน่วยงานที่ขอความอนุเคราะห์ท าการตรวจสอบความถูกต้องอีกครั้ง โดยวิธีการดังนี้ 
 หน้าการท างานในโปรแกรม Adobe InDesign ไปที่ เมนู  
File > Export  ดังแสดงภาพที่ 4-69 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-69  แสดงการบันทึกไฟล์งานเป็นสกุล .pdf 

แสดงจุดที่ไม่ผิดพลาดในการจัด
หน้า 



 
 

 

98 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 จะปรากฎหน้าต่างส าหรับการบันทึกชื่อไฟล์ ให้ใส่ชื่อไฟล์งาน
จดหมายข่าวโดยระบุฉบับประจ าเดือนของจดหมายข่าวด้วย จากนั้นกดปุ่ม OK เพ่ือท าการบันทึก ดังแสดง
ภาพที ่4-70 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-70  แสดงการบันทึกชื่อส าหรับไฟล์งานจดหมายข่าวประจ าเดือน 
 
 จากนั้นจะปรากฎหน้าต่าง Export Adobe PDF ซึ่งจะเป็น
การระบุรายละเอียดที่ต้องการให้โชว์ในหน้ากระดาษส าหรับงานสิ่งพิมพ์ โดยในช่องซ้ายมือ ไปที่ Marks and 
Bleeds ให้ท าการคลิกที่ช่อง All Printer’s Marks เพ่ือเอาเครื่องหมายถูกออก ไม่ต้องใส่รายละเอียดในไฟล์ที่
จะส่งให้หน่วยงานที่ขอความอนุเคราะห์ตรวจสอบ และคลิกปุ่ม Export  ดังแสดงภาพที่ 4-71 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-71  แสดงการ Export ไฟล์ PDF 

บันทึกชื่อไฟล์ระบุฉบับประจ าเดือน 

สกุลไฟล์งานที่ต้องการบันทึก.pdf 



 
 

 

99 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 4.2.5  การส่งไฟลตัวอย่างและไฟล์ต้นฉบับให้หน่วยงานที่ขอความอนุเคราะห์ 
 ขั้นตอนสุดท้ายของกระบวนการจัดหน้าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคล             
พระนคร ด้วยโปรแกรม เป็นการจัดส่งไฟล์ตัวอย่างให้หน่วยงานที่ขอความอนุเคราะห์ท าการตรวจสอบความ
ถูกต้องก่อนการเผยแพร่ ซึ่งมีข้ันตอนการด าเนินการดังนี้ 
 4.2.5.1. เข้าหน้าต่างเว็บไซด์ Google Drive ที่ใช้ในการส่งข้อมูลส าหรับการจัดหน้าในขั้นตอนที่ 
4.2.2 ไปที่แชร์กับฉัน ดับเบิ้ลคลิกเลือกโฟลเดอร์ ข่าวสภามหาวิทยาลัย ดับเบิ้ลคลิกที่โฟลเดอร์ข่าวสภา
มหาวิทยาลัย ไปที่โฟลเดอร์ที่ต้องการส่งไฟล์จดหมายข่าวประจ าฉบับที่ต้องการ ดังแสดงภาพที่ 4-72 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-72  แสดงการเข้าโฟลเดอร์ใน Google  Drive 
 

 4.2.5.2.  คลิกที่เครื่องหมายบวกทางซ้ายมือของหน้าต่างเว็บไซด์ Google Drive > Up Load 
File เลือกไฟล์ที่ต้องการอัพโหลด เพ่ือท าการเพ่ิมข้อมูลลงใน Drive เสร็จแล้วท าการแจ้งให้หน่วยงานที่ขอ
ความอนุเคราะห์รับทราบและท าการตรวจสอบ ดังแสดงภาพที่ 4-73  
 
 
 
 

 
 
 
 
 
 

ภาพที่ 4-73  แสดงวิธีการอัพโหลดไฟล์ใน  Google Drive 



 
 

 

100 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 ซึ่งเมื่อหน่วยงานที่ขอความอนุเคราะห์ได้ท าการตรวจสอบครบแล้ว หากมีข้อผิดพลาด
หน่วยงานที่ขอความอนุเคราะห์จะส่งกลับมาให้ผู้ปฏิบัติงานท าการปรับแก้ไขให้ถูกต้องเหมาะสมตามที่
หน่วยงานต้นทางต้องการ จากนั้นเมื่อท าการแก้ไขจนเป็นที่เรียบร้อยแล้ว ผู้ปฏิบัติงานจากท าการจัดส่งไฟล์
งานที่แก้ไขแล้วพร้อมแนบลิงก์การตอบแบบประเมินความพึงพอใจด้านการออกแบบสื่อ ซึ่งจัดท าโดยระบบ 
Google form ให้กับหน่วยงานที่ขอความอนุเคราะห์ เพ่ือให้หน่วยงานต้นทางท าการอัพโหลดและท าการ
เผยแพร่ตามช่องทางสื่อต่างๆ ที่ได้ก าหนดไว้ จึงจบขั้นตอนกระบวนการการจัดท าจดหมายข่าวสภา
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนครด้วยโปรแกรม Adobe InDesign 
 
4.3  การติดตามประเมินผลการปฏิบัติงาน 
 การประเมินคุณภาพของการจัดท าจดหมายข่าวสภามหาวิทยาลัยฯ มีวิธีการตรวจประเมินผลการ
ปฏิบัติงานด้วยกัน 2 วิธี ดังนี้ 
 4.3.1. วิธีการประเมินผลโดยผ่านการตรวจสอบจากรองผู้อ านวยการส านักวิทยบริการและเทคโนโลยี
สารสนเทศ กลุ่มงานพัฒนานวัตกรรมและเทคโนโลยีทางการศึกษา ท าการพิจารณาคุณภาพ และการติดตาม
งานจากหน่วยงานที่ขอความอนุเคราะห์ว่ามีการน าจดหมายข่าวที่ได้จัดท าขึ้นไปใช้ในเผยแพร่ยังสื่อช่องทางที่
ได้ก าหนดไว้หรือไม่ และท าการบันทึกเก็บไว้เป็นหลักฐาน ดังแสดงภาพที่ 4-74 
 
 
 
 
 
 
 
 
 
 

 
 
 

ภาพที่ 4-74  แสดงตัวอย่างจดหมายข่าวสภามหาวิทยาลัยฯ ที่ได้รับการเผยแพร่ผ่านเว็บไซต์ 
สภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 

 4.3.2  เพ่ิมวิธีการตรวจประเมินด้วยแบบสอบถามความพึงพอใจ โดยจัดท าระบบ Google form แนบ
พร้อมขั้นตอนการส่งไฟล์งานให้หน่วยงานต้นทางที่ขอความอนุเคราะห์ ท าการประเมินผลความพึงพอใจการ
ออกแบบสื่อ เพ่ือใช้ประกอบการปรับปรุงและพัฒนาการออกแบบของผู้ปฏิบัติงานต่อไป ดังแสดงภาพที่ 4-75 



 
 

 

101 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

  

 
 

ภาพที่ 4-75 แสดงผลการประเมินแบบสอบถามความพึงพอใจด้านการออกแบบสื่อ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-75 แสดงผลการประเมินแบบสอบถามความพึงพอใจด้านการออกแบบสื่อ (ต่อ) 



 
 

 

102 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-75 แสดงผลการประเมินแบบสอบถามความพึงพอใจด้านการออกแบบสื่อ (ต่อ) 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-75 แสดงผลการประเมินแบบสอบถามความพึงพอใจด้านการออกแบบสื่อ (ต่อ) 



บทท่ี 5 
ปัญหาอุปสรรค  และขอ้เสนอแนะ 

 
 ในการจัดท าคู่มือการปฏิบัติงานเรื่อง การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคล          
พระนคร ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe InDesign ในบทนี้ผู้ปฏิบัติงานได้น าเสนอปัญหา อุปสรรค 
และข้อเสนอแนะแนวทางในการแก้ไขการปฏิบัติงาน จากประสบการณ์ของผู้เขียนที่ปฏิบัติงานในด้านการใช้
โปรแกรมคอมพิวเตอร์ประยุกต์ Adobe InDesign เพ่ือเสนอแนวทางแก้ไขในการพัฒนาปรับปรุงงาน ให้งานที่
ท าอยู่มีประสิทธิภาพยิ่งขึ้นและเพ่ือให้การปฏิบัติงานเป็นไปในมาตรฐานเดียวกัน ซึ่งในการปฏิบัติงานมีปัญหา
อุปสรรค ในแต่ละข้ันตอนดังนี้  
 
5.1  ปัญหา อุปสรรคของผู้ปฏิบัติงานด้านการจัดท าจดหมายข่าวสภามหาวิทยาลัยฯ 
 

ขั้นตอนการด าเนินงาน ปัญหา/อุปสรรค แนวทางแก้ไข 

1. การจัดส่งข้อมูลทางออนไลน์ 
Google Drive 

- ในการแชร์ข้อมูลทางออนไลน์
ผ่านอีเมล์มหาวิทยาลัยฯ ในครั้ง
แรกผู้ที่ร่วมแชร์จะพบปัญหาการ
มองเห็น 

- ท าการแจ้งให้ผู้ที่ปฏิบัติงานที่
จัดส่งข้อมูลในหน่วยงานที่ขอ
ค ว า ม อ นุ เ ค ร า ะ ห์ ท า ก า ร
ตรวจ เช็ คขั้ น ต้ น ใน  Google 
Drive share ใ นก า ร เปิ ด ก า ร
เ ข้ า ถึ ง ข อ ง ข้ อ มู ล  แ ล ะ
ผู้ปฏิบัติงานท าการตรวจเช็คอีก
ครั้ง  

- หากท าการตรวจเช็คทุกขั้นตอน
แล้วยังไม่สามารถมองเห็นได้อีก
ให้ท าการส่งข้อมูลเนื้อหาและ
รูปภาพประกอบผ่านทางอีเมล์
ของมหาวิทยาลัยฯ 

2. ท าการก าหนดและวางแผนการ
ออก แ บ บ จ ด ห ม า ย ข่ า ว ส ภ า
มหาวิทยาลัยฯ (ดัมมี่) 

- หน่วยงานที่ขอความอนุเคราะห์
จัดส่งข้อมูลเนื้อหาและรูปภาพ
ประกอบไม่ครบ  

- ท าการตรวจสอบข้อมูลในกล่อง
Google Drive หากข้ อ มู ล ไ ม่
ครบท าการติดตามสอบถามกับ
หน่วยงานต้นทางที่ ขอความ
อนุเคราะห์  

 



 
 

 

104 การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ด้วยโปรแกรม Adobe InDesign  

ขั้นตอนการด าเนินงาน ปัญหา/อุปสรรค แนวทางแก้ไข 

  - หากหน่วยงานต้นทางที่ขอความ
อนุ เ ค ร าะห์  ไม่ ส ามา ร ถ ห า
รู ปภาพประกอบได้ ต ร ง กั บ
เนื้อหา ผู้ปฏิบัติงานสามารถหา
รูปภาพกราฟิกหรือลวดลายที่
เกี่ยวข้องมาประกอบข้อความ
แทนได้ ก่อนส่งให้ผู้ปฏิบัติหน้าที่
สูงกว่าท าการออกแบบดัมมี่ 

3.  ด า เนินการจัดหน้ารูป เล่ ม
จดหมายข่ า ว ด้ ว ย โป รแกรม 
Adobe InDesign 

- หากรูปแบบฟอนต์ตามรูปแบบ
ที่ก าหนดไม่มี 

 
 

- หลังจากที่จัดท าหน้าเล่มฉบับ
แ ร ก แ ส ร็ จ แ ล้ ว  ห า ก เ ปิ ด
โ ป ร แ ก ร ม ค รั้ ง ต่ อ ไ ป แ ล้ ว
โปรแกรมแจ้งว่าไม่สามารถหา
ฟอนต์ได้   
 

- หากเปิดไฟล์งานที่เคยท าไว้แล้ว
ขึ้นมาใหม่ ระบบท าการแจ้งว่ามี
ข้ อผิ ดพลาดที่ ด้ า นล่ า งของ
หน้าต่างการท างาน 

 
- หากแก้ไขลิงก์แล้วยังไม่แสดง

ภาพตามท่ีต้องการอีก 
 
 
 
- หากน าไฟล์สกุล .indd ไปเปิด
ใช้เครื่องคอมพิวเตอร์ อ่ืน แล้ว
ระบบแจ้งเตือนข้อผิดพลาด 

- ให้ท าการดาวน์โหลดฟอนต์ที่
ต้ อ งกา ร  และ อัพลง เ ค รื่ อ ง
คอมพิวเตอร์ 

 
- ให้ท าการรีสตาร์ทโปรแกรมใหม่
อีกรอบ ก็จะสามารถเรียกใช้
ฟอนต์เดิมได้ 

 
 
 
- ให้ท าการดับเบิ้ลคลิกตรงที่แจ้ง

ว่ามีข้อผิดพลาด เพ่ือตรวจดู
รายละเอียดที่ผิดพลาดแล้วท า
การแก้ไขลิงก์ให้ถูกต้อง 
 

- ให้ตรวจสอบที่เก็บไฟล์ภาพว่ายัง
อยู่ที่ เดิมที่ท าการเรียกลิง ก์ใน
ตอนแรกหรือไม่ ถ้าไม่ใช้ให้ท า
การเรียกลิงก์ภาพใหม่ 

 
- ให้ท าการตรวจสอบลิงก์รูปภาพ

หรือข้อความ 
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ขั้นตอนการด าเนินงาน ปัญหา/อุปสรรค แนวทางแก้ไข 

4. การส่งไฟล์ให้หน่วยงานที่ขอ
ความอนุเคราะห์ 

- คุณภาพของไฟล์ภาพที่ส่งไปไม่
ชัด 

-  ห าก ในขั้ น ตอนการ บั น ทึ ก 
Export ไฟล์งานแล้วไม่ชัด ให้
บันทึกเป็นไฟล์สกุล .pdf จากนั้น
เ ปิ ด โ ป ร แ ก ร ม  Adobe 
Photoshopเ ปิ ด ไ ฟ ล์ ง า น
สกุล .pdf  ในขั้นตอนเปิดไฟล์
งานที่บันทึกไว้  ระบบจะถาม
ความละเอียดให้ก าหนด ไม่ต่ า
กว่า 150 dpi แล้วบันทึกใหม่ที
ละหน้าโดยก าหนดสกุล . jpg 
หรือ png จากนั้นด าเนินการส่ง
ตามปกติ 

 
5.2  ข้อเสนอแนะเพื่อการพัฒนา 
 การจัดท าคู่มือการปฏิบัติงานเรื่อง การจัดท าจดหมายข่าวสภามหาวิทยาลัยเทคโนโลยีราชมงคล          
พระนคร ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe InDesign ปัจจุบันมีการน าเสนอผ่านเว็บไซต์ส านักงาน
สภามหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ซึ่งรูปแบบการน าเสนอเป็นการน าเสนอแบบภาพต่อภาพ ไม่
ดึงดูดความสนใจของผู้อ่าน ในอนาคตการจัดท าจดหมายข่าวสภามหาวิทยาลัยฯ ยังสามารถพัฒนารูปแบบการ
น าเสนอให้น่าสนใจมากยิ่งขึ้นได้ ด้วยการพัฒนารูปแบบการน าเสนอแบบ E-book เพ่ิมลูกเล่นให้ผู้อ่านมี
ความรู้สึกเหมือนได้อ่านหนังสือจริง ๆ ซึ่งโปรแกรมสามารถพัฒนาให้อยู่ในแพลตฟอร์มในรูปแบบต่างๆ ได้ โดย
ขึ้นอยู่กับความต้องการของหน่วยงานที่ขอความอนุเคราะห์ในการจัดท า  
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